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Foreword 

In this section the following information is included: 

• About this User Guide and Help 
• Terminology 
• Side Headings 
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About this User Guide and Help 
The InForm Designer user guide and Help provide detailed instruction 
about how to operate InForm Designer; from installation and 
configuration, to creating, saving and printing forms, they are designed as 
an everyday reference for both beginners and experts. 

The user guide and Help assume you have a working knowledge of the 
Windows® operating system and its conventions, including how to use a 
mouse and keyboard, and how to run applications from the desktop or 
Start menu. For help with any of these techniques, please refer to your 
Windows® documentation or Help.  

Printing 

The InForm Designer Help is primarily designed for on-screen reference. 
Even though its content can be printed, it is the InForm Designer user 
guide (InForm_Designer_User_Guide.pdf) that is better suited for this 
purpose. 

The layout of the user guide is designed for duplex (back to back) printing. 
If your printer has a duplex facility, please ensure it is set prior to printing. 
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Terminology 
The InForm Designer user guide and Help contain a glossary where 
common terms are described. 

Certain terms are also underlined throughout. By positioning your mouse 
pointer over one of these links and pressing your primary mouse button, 
one of the following actions occurs… 

• A pop-up description of the term appears alongside. 
• A page in the user guide or Help that describes the term or a topic 

relating to it appears. 
• A Fly Software web page relating to the term is opened in your 

Internet browser. 
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Side Headings 
For quick reference, the following side headings appear throughout the 
InForm Designer user guide and Help: 

EXAMPLE: 
Provides an example of the current topic. 

NOTE: 
Provides additional information or hints to assist in performing a task or 
understanding the current topic. 

MORE: 
Used to indicate where further details about the current or a related topic 
can be found. 

CAUTION: 
Used if the current action or omission may cause irretrievable results such 
as loss of data. 

HTML TIP: 
Provides information about the current topic that is specific to creating a 
HTML form. 
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Contents 

In this section the following information is included: 

• At a Glance 
• Concise 
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Introduction 

In this section the following information is included: 

• Why You Need InForm Designer 
• What InForm Designer can do for You 
• Plug-in Power! 
• InForm Documents 
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Why You Need InForm Designer 
If you have ever designed a form, you will already know how challenging 
and time-consuming the process can be.  

Complicated software controls and concepts, screen to print irregularities, 
limited or costly access to compatible form filling applications, or little or 
no knowledge of writing HTML code, all add to the problems encountered 
when designing a form. 

InForm Designer is a Windows® application, developed to eliminate these 
problems and help you create professional paper forms, e-forms and Web 
(HTML) forms in minutes. 
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What InForm Designer can do for You 
InForm Designer provides a quick, easy and cost effective way to design 
forms that can be filled in electronically (using InForm Filler), printed for 
filling in by hand, converted to another file format such as PDF (if a 
suitable PDF driver is available), or exported as a HTML form.  

The controls and functionality of InForm Designer are specifically aimed at 
form design, so, unlike many word processing or DTP applications, you are 
not overwhelmed by masses of tools, buttons and menu options; many of 
which you are unlikely to ever use. 

If you don’t already have InForm Designer installed, it can be downloaded 
for free from the Fly Software website: 

http://www.flysoftware.com 

http://www.flysoftware.com/
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Plug-in Power! 
InForm Designer’s form design functionality is provided by a range of 
components called InForm Plug-ins. These are the tools that enable you to 
integrate form elements such as text boxes, combo boxes, radio buttons, 
labels and images. 

The following sets of InForm Plug-ins are included with InForm Designer: 

InForm Plug-in Set Description 

Common 
Appear on the Common plug-in palette. Used for 
adding form elements to InForm documents that will 
be used as paper forms or e-forms. 

HTML 
Appear on the HTML plug-in palette. Used for adding 
form elements to InForm documents that will exported 
to HTML.  

 

When a form element is added to an InForm document a Fly Software 
watermark is applied to the page it appears on until a licence is purchased 
and applied for the associated common InForm Plug-in or a common 
InForm Plug-in a HTML InForm Plug-in is associated with. 

EXAMPLE: 
If you want to remove the watermark after adding a text box to a form, all 
you need to purchase and apply is a licence for the Text Box plug-in. 

MORE: 
For further details about InForm Plug-ins, refer to Common InForm Plug-
ins and HTML Inform Plug-ins. 

Associated InForm Plug-ins 

HTML InForm Plug-ins are associated with common InForm Plug-ins. This 
means you only need to purchase and apply a licence for common InForm 
Plug-ins and not the associated HTML InForm Plug-in(s). 

Below is a list of common InForm Plug-ins and the HTML InForm Plug-ins 
that are associated with them: 

Common InForm Plug-in Associated HTML Plug-in(s) 

Button HTML Button 

Checkbox HTML Checkbox 
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Common InForm Plug-in Associated HTML Plug-in(s) 

Combo Box HTML Combo Box 

Date Box HTML Date Box 

Image HTML Image 

Label HTML Label 

Radio Button HTML Radio Button 

Text Box 

HTML Email Text Box 
HTML Numeric Text Box 
HTML Password Text Box 
HTML Text Area 
HTML Text Box 

Time Box HTML Time Box 

EXAMPLE: 
If you license the Text Box plug-in, the following HTML InForm Plug-ins are 
also licensed: 

• HTML Email Text Box 
• HTML Numeric Text Box 
• HTML Password Text Box 
• HTML Text Area 
• HTML Text Box 

NOTE: 
The HTML Hidden Field plug-in becomes licensed when any common 
InForm Plug-in is licensed. 

MORE: 
For details about how to view the common and HTML InForm Plug-in 
association within InForm Designer, refer to Getting Started > Licensing > 
Online Licensing > Viewing Associated HTML InForm Plug-ins. 
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InForm Documents 
Forms that are created and saved using InForm Designer are called InForm 
documents, and are recognised by their ifd filename extension and 
distinctive icon (Fig. 1).  

 

Fig. 1 InForm document (ifd) icon 

Normally, InForm documents have a small footprint, making them ideal 
for distribution by email or downloading from a website. Alternatively 
they can be printed on plain or pre-printed paper, converted to another 
file format such as PDF (if a suitable PDF driver is available), or exported as 
a HTML form. 

Using Pre-designed Forms 

The following Fly Software Web page contains InForm documents that 
can be downloaded and modified to your own requirements using InForm 
Designer: 

http://www.flysoftware.com/products/inform_forms/inform_forms.asp 

Form Design Service 

Fly Software offer a fast and professional form design service. Visit the 
following Fly Software Web page to find out more: 

http://www.flysoftware.com/services/form_design.asp 

http://www.flysoftware.com/products/inform_forms/inform_forms.asp
http://www.flysoftware.com/services/form_design.asp
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Getting Started 

In this section the following information is included: 

• System Requirements 
• Installing 
• Launching 
• Welcome Screen 
• Workspace Overview 
• Application Menus and Toolbars 
• Context Menus 
• Property Inspector 
• Plug-in Palette 
• Licensing 
• Creating a New Form 
• Opening, Closing and Saving Forms 
• Resetting Forms 
• Validating Forms 
• Printing Forms 
• The Fly Software Watermark 
• Non-Visual Form Elements 
• Images and PDFs 
• Filling in and Testing Forms 
• Improving Performance 
• Viewing Developer and Application Information 
• Leaving Feedback 
• Updating 
• Shutting Down 
• Uninstalling 
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System Requirements 
InForm Designer has the following minimum computer system 
requirements: 

• Microsoft® Windows® 7, Vista, XP, 2008, 2003, 2000, NT 
• Intel® Pentium® or AMD® K6 processor 
• 128 MB of RAM (512 MB recommended) 
• 20 MB of available hard-disk space 
• 800x600 pixel screen resolution 
• Internet connection for licensing (recommended) 

NOTE: 
If certain system requirements are not satisfied you will be unable to 
install or use InForm Designer, and a warning dialog appears at the start of 
the installation process. Click the OK button to close the dialog and abort 
the installation. 

NOTE: 
If you use InForm Designer to create a HTML form, a Web server is 
required to host the HTML form file and other associated files. If you 
include an ASP or PHP submitted page with a HTML form, the Web server 
will need to be enabled for ASP or PHP scripts. 
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Installing 
To start the InForm Designer installation process, double-click the InForm 
Designer installation file. Following this, the Installation Wizard is opened 
which guides you through the entire InForm Designer installation. 

NOTE: 
InForm Designer can only be installed when you are logged on to 
Windows as an administrator. 

NOTE: 
Installation can be aborted at anytime by clicking the Cancel button. 

NOTE: 
All common InForm Plug-ins and HTML InForm Plug-ins are automatically 
installed with InForm Designer. 

Default Install Locations 

InForm Designer’s application files, application data, example forms and 
tutorials are stored in different locations. 

Application Files 

By default, InForm Designer’s application files, including all InForm Plug-
ins, are installed in the following location: 

C:\Program Files\Fly Software\InForm\ 

Application Data 

InForm Designer’s application data, including its configuration file 
(App.ini) are installed in the following location: 

Windows XP, 2000, 2003 

C:\Documents and Settings\All Users\Application Data\Fly 
Software\InForm\ 

Windows 7, Vista 

C:\ProgramData\Fly Software\InForm\ 

NOTE: 
The Application Data and ProgramData folders referenced above may be 
hidden from view in Windows Explorer or My Documents. 

MORE: 
To show Application Data and ProgramData folders, refer to your 
Windows documentation or Help. 
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Example Forms 

Example forms that can be opened in InForm Designer are installed in the 
following location: 

C:\Program Files\Fly Software\InForm\Example Forms\ 

Tutorials 

Tutorials that can be opened in InForm Designer are installed in the 
following location: 

C:\Program Files\Fly Software\InForm\Tutorials\ 

Unable to Install 

If your computer does not satisfy certain system requirements, you are not 
permitted to install InForm Designer, and a warning dialog appears at the 
start of the installation process. 

Click the OK button to close the dialog and abort the installation. 

Obtaining an Installation File 

The InForm Designer installation file (InForm_Designer_Setup.exe) can be 
downloaded from the following Fly Software Web page: 

http://www.flysoftware.com/downloads 

http://www.flysoftware.com/downloads
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Launching 
InForm Designer can be launched (run) in any of the following ways: 

• Click the InForm Designer icon (Fig. 2) in the Fly Software folder on 
the Windows® Start Menu. 

• Double-click the InForm Designer icon (if present) on the 
Windows® desktop. 

• Double-click an InForm document within the Windows® file system. 

 

Fig. 2 InForm Designer icon 

Following launch, the application workspace (Fig. 5) and Welcome screen 
(Fig. 4), or page one of an InForm document appears. 

Missing Files 

If certain files are missing from an InForm Designer installation, one or 
more Missing Files dialogs (Fig. 3) appear during launch. 

 

Fig. 3 Missing Files dialog 

Click the OK button to close the dialog and continue with the launch of 
InForm Designer. 

NOTE: 
If files are missing, associated functionality will be unavailable, and InForm 
documents that contain form elements derived from the missing files 
cannot be opened. 
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Welcome Screen 
A Welcome screen (Fig. 4) is normally opened whenever an InForm 
document is not open, and contains convenient buttons and links for 
performing a number of common tasks such as opening a recent InForm 
document, creating a new InForm document, and licensing InForm Plug-
ins. 

 

Fig. 4 Welcome screen 

Click a task button or link to perform that task. 

Click the Close button within the Welcome screen or the Close button on 
the title bar to close the Welcome screen. 

Disabling 

To disable the Welcome screen (Fig. 4) so it no longer opens whenever an 
InForm document is not open, perform one of the following actions: 

• Click the “Do not show this Welcome” checkbox on the Welcome 
screen to select it (add a tick). 

• Click View > Use Welcome Screen (remove the tick). This also 
immediately closes the Welcome screen if it is already open. 

Enabling 

To enable the Welcome screen (Fig. 4) so it opens whenever an InForm 
document is not open, click View > Use Welcome Screen (add a tick). This 
also immediately opens the Welcome screen if it and an InForm document 
are not open. 
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Workspace Overview 
When you launch InForm Designer, the application window opens to 
display the InForm Designer workspace (Fig. 5) where components typical 
to many Windows® applications are located.  

 

Fig. 5 InForm Designer workspace (Designer mode)  

If an InForm document is open, the content of a single page is displayed. 

InForm Designer has two modes – Designer mode and Filler mode The 
mode initially used when an InForm document is opened, is the mode the 
InForm document was last saved in. 

Designer Mode 

Designer mode allows you to design forms. 

The property inspector, plug-in palette and design-related menu options 
and toolbar buttons are available in Designer mode. In addition, the 
Designer (On/Off) menu option on the View menu has a tick next to it. 
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If InForm Designer is in Filler mode and you would like to enter Designer 
mode, click the Designer (On/Off) button, or click View > Designer 
(On/Off). 

Filler Mode 

Filler mode allows you to view and fill in forms exactly as you would when 
using InForm Filler. 

The property inspector, plug-in palette and design-related menu options 
and toolbar buttons are unavailable in Filler mode. In addition, the 
Designer (On/Off) menu option on the View menu does not have a tick 
next to it. 

If InForm Designer is in Designer mode and you would like to enter Filler 
mode, click the Designer (On/Off) button or click View >  Designer 
(On/Off). 

MORE: 
For instruction about using InForm Designer in Filler mode, refer to the 
InForm Filler user guide or Help. 

NOTE: 
The InForm Filler Help is opened when you are in Filler mode. 
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Application Menus and Toolbars 
To access much of the functionality within InForm Designer, the following 
application menus (Fig. 6) and toolbars (Fig. 7) are provided: 

• File 
• Edit 
• View 
• Page 
• Element 
• Help 

 

Fig. 6 Application menus and open File menu  

 

Fig. 7 File toolbar 

NOTE: 
Menu options and toolbar buttons displayed in grey indicate the 
associated functionality is currently unavailable. 

File 

The File menu contains options for performing the following actions: 

• Creating a new InForm document 
• Opening an InForm document 
• Closing an InForm document 
• Saving an InForm document 
• Adding, modifying and deleting printer offsets 
• Printing an InForm document 
• Creating a HTML form 
• Opening recent InForm documents 
• Shutting down InForm Designer 
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The File toolbar contains buttons for some but not all corresponding 
options. 

New 

Creates a new InForm document. Hovering over the menu option or the 
toolbar button displays the following options: 

• Paper form or e-form 
• 640x480 “safe” HTML form 
• 800x600 “safe” HTML form 
• 1024x768 “safe” HTML form 

Keyboard shortcut:  None 

Toolbar button:   

Open 

Opens the Open dialog (Fig. 18) where InForm documents can be selected 
and opened in InForm Designer. 

Keyboard shortcut:  Ctrl+O 

Toolbar button:   

Close 

Closes the open InForm document. If changes have been made since it 
was last saved, a Save confirmation dialog is opened prior to closing. 

Keyboard shortcut:  Ctrl+W 

Toolbar button:  None 

Save 

Saves the open InForm document. 

Keyboard shortcut:  Ctrl+S 

Toolbar button:   

Save As 

Opens the Save As dialog (Fig. 21) where a new filename and location for 
the open InForm document can be specified prior to saving. 
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Keyboard shortcut:  Shift+Ctrl+S 

Toolbar button:  None 

Export to HTML 

Opens the HTML Export dialog (Fig. 57) where HTML export options can 
be specified prior to creating a HTML form and an optional ASP or PHP 
submitted page. 

Keyboard shortcut:  None 

Toolbar button:   

Printer Offsets 

Printer Offsets 

Opens the Printer Offsets dialog (Fig. 26) where printer offsets can be 
added, modified and deleted. 

Keyboard shortcut:  None 

Toolbar button:  None 

Print 

Opens the Print dialog (Fig. 30) where action can be taken to select a 
printer and print all or parts of the open InForm document. 

Keyboard shortcut:  Ctrl+P 

Toolbar button:    

Recent Files  

Lists the last five InForm documents to be opened in InForm Designer. 
Click a name to open the associated InForm document. 

Keyboard shortcut:  None 

Toolbar button:  None 

Exit 

Shutdown (exit) InForm Designer. If changes have been made since it was 
last saved, a Save confirmation dialog is opened prior to shutting down. 

Keyboard shortcut:  Ctrl+Q 

Toolbar button:  None 
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NOTE: 
InForm Designer can also be exited using the application close (exit) 
button located on the title bar.  

Edit 

The Edit menu and toolbar contain options and buttons for performing 
the following actions: 

• Undoing the last action  
• Redoing the last undone action 
• Cutting a form element from a page 
• Copying a form element 
• Pasting a form element 
• Deleting a form element 
• Selecting all form elements on a page 
• Duplicating a form element 

Undo 

Undoes the last action to be performed for the open InForm document. 

Keyboard shortcut:  Ctrl+Z 

Toolbar button:   

Redo 

Redoes the last action to be undone for the open InForm document. 

Keyboard shortcut:  Shift+Ctrl+Z 

Toolbar button:   

Cut 

Cuts a selected form element or text and stores it on the Windows® 
clipboard. 

Keyboard shortcut:  Ctrl+X 

Toolbar button:   

Copy 

Copies a selected form element or text and stores it on the Windows® 
clipboard. 

Keyboard shortcut:  Ctrl+C 
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Toolbar button:   

Paste 

Pastes the last cut or copied form element or text onto the page or into a 
selected form element. 

Keyboard shortcut:  Ctrl+V 

Toolbar button:   

Delete 

Deletes a selected for element or text. 

Keyboard shortcut:  Delete/Del 

Toolbar button:   

Select All 

Selects all form elements on a page, or all text in a selected form element. 

Keyboard shortcut:  Ctrl+A 

Toolbar button:   

Duplicate 

Duplicates a selected form element. This is the same as performing actions 
to copy and paste a form element. 

Keyboard shortcut:  Ctrl+D 

Toolbar button:   

View 

The View menu contains options for performing the following actions: 

• Changing between Designer mode and Filler mode 
• Turning the property inspector on and off 
• Turning the plug-in palette on and off 
• Displaying the actual page size 
• Fitting the page width in the workspace 
• Fitting the entire page in the workspace 
• Resetting the form 
• Validating the form 
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• Turning PDF quick draw on and off 
• Turning flicker reduction on and off 
• Turning form element hints on and off 
• Turning application toolbars on and off 
• Use/open the Welcome screen 

The View toolbar contains buttons for some but not all corresponding 
options. It also contains additional components and buttons used for: 

• Displaying the current page zoom 
• Manually changing the page zoom 
• Selecting a predetermined page zoom 

Designer 

Changes between Designer mode and Filler mode. 

Keyboard shortcut:  F4 

Toolbar button:   

Properties 

Turns the property inspector on and off. 

Keyboard shortcut:  F5 

Toolbar button:   

Plug-ins 

Turns the plug-in palette on and off. 

Keyboard shortcut:  F6 

Toolbar button:   

Actual Size 

Resizes the view of the current page to actual size. 

Keyboard shortcut:  F7 

Toolbar button:   

Fit to Width 

Resizes the view of the current page to fit the width of the application 
window. 
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Keyboard shortcut:  F8 

Toolbar button:   

Fit to Page 

Resizes the view of the current page to fit entirely within the application 
window. 

Keyboard shortcut:  F9 

Toolbar button:   

Reset Form 

Resets applicable form elements to a default value or state. 

Keyboard shortcut:  None 

Toolbar button:   

Validate Form 

Checks validation conditions for applicable form elements. 

Keyboard shortcut:  None 

Toolbar button:   

PDF Quick Draw 

Determines whether PDF quick draw is turned on or off. When enabled, 
slow display of PDF backgrounds or form elements is less evident. 

Keyboard shortcut:  None 

Toolbar button:  None 

Hints 

Determines whether a hint appears when the mouse pointer is positioned 
over a form element. 

Keyboard shortcut:  None 

Toolbar button:  None 

Toolbars 

Determines which application toolbars are displayed. 
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Keyboard shortcut:  None 

Toolbar button:  None 

Use Welcome Screen 

Determines whether the Welcome screen (Fig. 4) is used/opened. 

Keyboard shortcut:  None 

Toolbar button:  None  

Current Zoom 

Displays the zoom level of the current page view in percent. 

Keyboard shortcut:  None 

Toolbar image:  

NOTE: 
Only found on the toolbar.  

Manual Zoom 

Magnifies or reduces the current page view between 1% and 800% in 1% 
increments. 

Keyboard shortcut:  None 

Toolbar button:   

NOTE: 
Only found on the toolbar.  

Zoom Presets 

Lists and allows you to select predetermined page views between 25% 
and 800%. 

Keyboard shortcut:  None 

Toolbar button:   

NOTE: 
Only found on the toolbar.  
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Page 

The Page menu and toolbar contain options and buttons for performing 
the following actions: 

• Displaying properties for the current page 
• Inserting a new page 
• Deleting a page 

Properties 

Displays the properties of the current page within the property inspector. 

Keyboard shortcut:  None 

Toolbar button:   

Insert Page 

Inserts a new (blank) page. 

Keyboard shortcut:  None 

Toolbar button:   

Delete Page 

Deletes the current page. 

Keyboard shortcut:  None 

Toolbar button:   

Element 

The Element menu and toolbar contain options and buttons for 
performing the following actions: 

• Bringing the selected form element to the front of all other form 
elements 

• Sending the selected form element to back of all other form 
elements 

• Specifying the tab order of form elements 
• Finding a form element 

To Front 

Brings the selected form element to the front of all other form elements 
on the same page. 



Getting Started 

24 InForm Designer User Guide 

Keyboard shortcut:  Shift+Page Up 

Toolbar button:   

To Back 

Sends the selected form element to the back of all other form elements on 
the same page. 

Keyboard shortcut:  Shift+Page Down 

Toolbar button:   

Tab Order 

Opens the Tab Order dialog (Fig. 54) where the tab order of form elements 
is displayed and can be specified. 

Keyboard shortcut:  F11 

Toolbar button:   

Find 

Opens the Find dialog (Fig. 53) where the name of a form element can be 
selected from a list of all form elements contained in the current InForm 
document. Following selection, the page where it is located appears and 
the form element is selected. 

Keyboard shortcut:  F12 

Toolbar button:   

Help 

The Help menu and toolbar contain options and buttons for performing 
the following actions: 

• Opening Help 
• Opening a support ticket 
• Providing feedback about InForm Designer 
• Updating InForm Designer 
• Visiting the Fly Software home page 
• Buying InForm Plug-in licenses 
• Licensing and un-licensing InForm Plug-ins 
• Displaying developer and application information 
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Help Topics 

Opens the InForm Designer Help. 

Keyboard shortcut:  F1* 

Toolbar button:   

*NOTE: 
Pressing the F1 key when property inspector properties and certain 
workspace objects and are focused, displays context help for that object 
or property. 

Support Ticket 

Opens an Internet browser window where the Support Ticket page on the 
Fly Software website is displayed (after logging in). Here support related 
issues about InForm Designer can be completed and submitted to Fly 
Software. 

Keyboard shortcut: None 

Toolbar button: Add button image 

Leave Feedback 

Opens an Internet browser window where the Feedback Form page on 
the Fly Software website is displayed. Here comments about InForm 
Designer can be completed and submitted to Fly Software. 

http://www.flysoftware.com/support/feedback.asp 

NOTE: 
Requires an Internet connection. 

Keyboard shortcut: None 

Toolbar button: Add button image 

Update InForm Designer 

Opens an Internet browser window where the Downloads page on the Fly 
Software website is displayed. Here the latest editions of InForm Designer 
and InForm Plug-ins can be downloaded. 

http://www.flysoftware.com/downloads 

NOTE: 
Requires an Internet connection. 

Keyboard shortcut:  None 

http://www.flysoftware.com/support/feedback.asp
http://www.flysoftware.com/downloads
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Toolbar button:   

Fly Software Online 

Opens an Internet browser window where the Home page on the Fly 
Software website is displayed.  

http://www.flysoftware.com 

NOTE: 
Requires an Internet connection 

Keyboard shortcut:  None 

Toolbar button:   

Buy Plug-ins 

Opens an Internet browser window where the InForm Plug-ins page on 
the Fly Software website is displayed. Here licenses for InForm Plug-ins 
can be purchased.  

http://www.flysoftware.com/products/inform_plug-ins.asp 

NOTE: 
Requires an Internet connection 

Keyboard shortcut:  None 

Toolbar button:   

Licensing 

Opens the Licensing dialog (Fig. 15) where InForm Plug-ins can be 
licensed or un-licensed.  

NOTE: 
Requires an Internet connection 

Keyboard shortcut:  None 

Toolbar button:   

About InForm Designer 

Opens the About dialog (Fig. 35) where developer information and the 
application version number appear. 

Keyboard shortcut:  None 

http://www.flysoftware.com/
http://www.flysoftware.com/products/inform_plug-ins.asp
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Toolbar button:   

Showing and Hiding Toolbars 

All application toolbars appear by default in InForm Designer. However, if 
you rarely use a particular toolbar, would like to make room for displaying 
more of your InForm document, or prefer to use the application menus, 
each toolbar can be turned off (and on again) if required. 

Click View >Toolbars to open a fly-out menu where available toolbars 
appear. Click an option to either remove the associated tick and hide the 
toolbar, or add a tick and show the toolbar. 
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Context Menus 
Context menus (Fig. 8) contain common commands for the form element 
or page located under the mouse pointer.  

 

Fig. 8 Context menu 

Right-click a form element or page to open its context menu beside the 
mouse pointer. 

NOTE: 
Options and buttons displayed in grey indicate the associated command 
is currently unavailable. 

NOTE: 
Context menus contain options found on the Edit menu such as cut, copy 
and paste, and the Element menu such as To Front and To Back. 
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Property Inspector 
The property inspector (Fig. 9) contains properties and associated values 
for the selected page, form element or non-visual form element.  Select a 
different page, form element or non-visual form element and the 
associated properties and /or values change in the property inspector.  

 

Fig. 9 Property inspector (displaying page properties)  

The value of each property partly determines how the associated page, 
form element or non-visual form element appears or functions. 

The drop down list at the top of the property inspector contains the name 
of the selected form element or non-visual form element, together with 
the names of all form elements on the current page and all non-visual 
form elements within the entire InForm document. Click a name to select 
that form element or non-visual form element. 

MORE: 
For details about each property, refer to Appendix A: Properties. 

Showing and Hiding 

If you wish to make more room within the workspace to display your 
InForm document, or you no longer need to configure form element or 
page properties, the property inspector can be hidden (and shown again) 
as required. Use any one of the following methods to do this: 

• Click View > Properties to remove the menu option tick and hide 
the property inspector, or add a menu option tick and show it. 

• Click the Properties toolbar button. 
• Click the x button to the right of the property inspector grab 

handle to hide it. 

Docking and Undocking 

By default, the property inspector is docked at the left-hand edge of the 
workspace. It can also be docked at the right-hand edge, or displayed as a 
movable floating window. 
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Click and hold the mouse button over the property inspector’s grab 
handle and move the mouse. An outline of the property inspector now 
appears alongside the mouse pointer. When you release the mouse 
button the property inspector appears in that position as a floating 
window. 

To dock the property inspector at the edge of the workspace, move it to 
the side you require until its outline becomes a single grey line that runs 
down the entire edge of the workspace.  Release the mouse button to 
dock it. 

NOTE: 
If the plug-in palette is docked at the edge of the workspace, the property 
inspector cannot be docked on the same edge. 

Property Groups 

Certain properties that affect similar parts or functionality of a form 
element or page appear together within their own property groups (Fig. 
10). 

 

Fig. 10 Property group (Paper)  

Each property group has a title which is prefixed with either a plus sign (+) 
to indicate the group is closed or a minus sign (-) to indicate the group is 
open. 

Click + next to a property group title to display all properties for that 
group.  

Click – next to a property group to hide all properties for that group. 

NOTE: 
It is common for property groups to contain other property groups (sub-
groups). 

When an InForm document is saved, the open and close state of all 
property groups is also saved. This means property groups remain open or 
closed when the InForm document is opened again. 
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Changing Property Values 

To change how a page or form element looks or operates the value of any 
of its associated properties can be changed. How this is achieved depends 
on whether the value is presented within an edit box or list box. 

Using an Edit Box 

Position the mouse pointer over the property value then click. If it is an 
edit box, a flashing text cursor appears prompting you to change the 
current value using the keyboard. 

Using a List Box 

Position the mouse pointer over the property value then click. If it is a list 
box, a button appears, which, when clicked, displays the available 
property options below. Click the required option in the list to select it. 

If the number of options exceeds the length of a drop-down list, a vertical 
scroll bar appears which can be used to display the hidden options. 

MORE: 
For instruction about using scroll bars, refer to Working with Pages > 
Moving About > Using Scroll Bars. 
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Plug-in Palette 
The plug-in palette (Fig. 11) contains a Common tab and a HTML tab. Each 
tab contains InForm Plug-in buttons.  

 

Fig. 11 Plug-in palette (showing the Common tab) 

Click the name of a tab to display the InForm Plug-in buttons it contains. 

Click a button to add the associated form element to the current page or 
the non-visual form element bar (Fig. 33). 

MORE: 
For further details about adding form elements, refer to Working with 
Form Elements > Adding. 

Unlicensed Plug-ins 

If an InForm Plug-in is unlicensed, its button on the plug-in palette 
together with all associated HTML InForm Plug-in buttons, contain a 
yellow triangle with an exclamation mark (Fig. 12). 

 

Fig. 12 Unlicensed InForm Plug-in button (Text Box) 

EXAMPLE: 
If the Text Box plug-in is unlicensed, the Text Box button on the Common 
tab and its associated HTML InForm Plug-in buttons contain a yellow 
triangle with an exclamation mark. 
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License the InForm Plug-in to remove the warning and prevent the Fly 
Software watermark appearing on pages where an associated form 
element is used. 

Element Selector 

The button at the top of each plug-in palette tab is the form element 
selector (Fig. 13) which allows you to select form elements that already 
appear in an InForm document. 

 

Fig. 13 Element selector (selected)  

Click the element selector button to select it. 

Showing and Hiding the Palette 

If you wish to make more room within the workspace to display your 
InForm document, or you no longer need to add form elements, the plug-
in palette can be hidden (and shown again) as required. Use any one of 
the following methods to do this:  

• Click View > Plug-ins to remove the menu option tick and hide the 
plug-in palette, or add a menu option tick and show it. 

• Click the Plug-ins toolbar button. 
• Click the x button to the right of the plug-in palette grab handle to 

hide it. 

Docking and Undocking 

By default, the plug-in palette is docked at the right-hand edge of the 
workspace. It can also be docked at the left-hand edge, or displayed as a 
movable floating window. 

To move the plug-in palette, position the mouse pointer over the plug-in 
palette’s grab handle, click and hold the mouse button then move the 
mouse.  

To dock the plug-in palette at the edge of the workspace, move it to the 
side you require until its outline becomes a single grey line that runs down 
the entire edge of the workspace then release the mouse button. 

To create a floating window, move the plug-in palette anywhere within 
the workspace (but not the edge) then release the mouse button. 
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NOTE: 
If the property inspector is docked at the edge of the workspace, the plug-
in palette cannot be docked on the same edge. 

Showing and Hiding Tabs and Buttons  

In order to keep your design interface as clutter-free as possible you can 
determine what tabs and InForm Plug-in buttons are shown and hidden 
on the plug-in palette. 

Right-click anywhere within the plug-in palette then click the Hide/Show 
Plug-ins option. Following this, a Hide/Show Plug-ins dialog (Fig. 14) is 
opened where a list of tab names and their associated InForm Plug-ins are 
displayed. 

 

Fig. 14 Show/Hide Plug-ins dialog 

Click a checkbox with a tick to remove the tick and hide the associated tab 
or InForm Plug-in button. 

Click a checkbox without a tick to add a tick and show the associated tab 
or InForm Plug-in button. 
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Licensing 
It is not InForm Designer itself that must licensed, but the InForm Plug-ins 
used during the design process.  

If an unlicensed InForm Plug-in is used, a Fly Software watermark appears 
on each page of the InForm document where the associated form 
element is used. 

HTML InForm Plug-ins do not require licensing. Instead the corresponding 
common InForm Plug-in must instead be licensed. 

EXAMPLE: 
If the HTML Text Box plug-in is used, the Text Box plug-in must be licensed 
in order to remove the watermark. 

NOTE: 
The HTML Hidden Field plug-in becomes licensed when any common 
InForm Plug-in is licensed. 

Licensing InForm Plug-ins is performed using an online or manual process.  

Purchasing Licences 

Prior to licensing an InForm Plug-in, a corresponding licence must be 
purchased from the following Fly Software web page: 

http://www.flysoftware.com/products/inform_plug-ins.asp 

If no InForm Plug-ins are licensed, an InForm Plug-ins page on the Fly 
Software website is opened in your Internet browser when InForm 
Designer is shutdown. Here InForm Plug-ins can be purchased. 

Online Licensing 

Online licensing is the recommended and most convenient method of 
licensing InForm Plug-ins. However, an Internet connection is required on 
the computer where InForm Designer is installed. 

Click the Licensing button, or click Help > Licensing. Following this, the 
Licensing dialog Online tab (Fig. 15) appears where InForm Plug-ins can 
be licensed or un-licensed using the online method. 

http://www.flysoftware.com/products/inform_plug-ins.asp
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Fig. 15 Licensing dialog Online tab 

Connecting to Your Fly Software User Account 

Prior to licensing an InForm Plug-in, you must connect to your Fly 
Software user account.  

In the Licensing dialog Online tab (Fig. 15) specify your user name and 
password then click the OK button. Following this, InForm Designer will 
attempt to connect to your user account on the Fly Software Web server. If 
successful, a list of InForm Plug-ins appears together with their licence 
status (Yes and No), and the Available and Pending licences contained in 
your user account. 

NOTE: 
You are prompted to create a user account when you purchase one or 
more InForm Plug-in licences for the first time. However, if you would like 
to create a user account prior to this, visit the following Fly Software web 
page: 

http://www.flysoftware.com/user_access/register.asp 

NOTE: 
Pending licences indicate the quantity of InForm Plug-in licences 
purchased through the associated Fly Software user account but not yet 

http://www.flysoftware.com/user_access/register.asp
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paid for. When payment is received by Fly Software, applicable Pending 
licences become Available licences which can be used to license 
corresponding InForm Plug-ins. 

Licensing an InForm Plug-in 

To license an InForm Plug-in, it must have at least one Available licence 
associated with it.  

In the Licensing dialog Online tab (Fig. 15), click the name of the InForm 
Plug-in you wish to license then click the License button. If successful, Yes 
appears in the Licensed column, and an Available licence for the 
associated InForm plug-in is removed from your user account. 

NOTE: 
If an InForm Plug-in was previously licensed (but had not been un-
licensed) for an InForm Designer installation on the same computer, an 
associated Available licence is not removed from your account. 

NOTE: 
If an InForm Plug-in you wish to license does not have an Available 
licence, you need to purchase an associated licence.  

Un-licensing an InForm Plug-in 

If you no longer wish to use an InForm Plug-in, or would like to use its 
associated licence with an InForm Designer installation on another 
computer, it can be un-licensed. 

In the Licensing dialog Online tab (Fig. 15), click the name of the InForm 
Plug-in you wish to un-license then click the Un-license button. If 
successful, No appears in the Licensed column, and an Available licence 
for the associated InForm plug-in is added to your user account. 

Viewing Associated HTML InForm Plug-ins 

HTML InForm Plug-ins are associated with common InForm Plug-ins. As a 
result, when a common InForm Plug-in is licensed, all HTML InForm Plug-
ins that are associated with it are also licensed. 

To view HTML InForm Plug-ins associated with a common InForm Plug-in, 
click the plus (+) button to the left of the common InForm Plug-in name.  
Following this, the names of HTML InForm Plug-ins that are associated 
with the common InForm Plug-in appear below. 

To hide HTML InForm Plug-ins associated with a common InForm Plug-in, 
click the minus (–) button to the left of the common InForm Plug-in name. 

MORE: 
For further details about HTML InForm Plug-ins, refer to Introduction > 
Plug-in Power! > Associated HTML InForm Plug-ins. 
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Manual Licensing 

If the computer where InForm Designer is installed does not have an 
Internet connection, InForm Plug-ins must be manually licensed. 

Manual licensing involves two processes: 

1. Request one or more InForm Plug-in licences from Fly Software. 

2. Activate the requested InForm Plug-in licence(s). 

Request Licence(s)  

The first part of the manual licensing process involves saving a licence 
request file then emailing it to Fly Software. 

The licence request file has the following filename: 

InForm Licence (user name – yyyymmddhhmmss).req 

This file contains information about the InForm Plug-in(s) you wish to 
license, together with your user name and password. 

Click the Licensing button, or click Help > Licensing then click the Manual 
(Request) tab in the Licensing dialog. Following this, the Licensing dialog 
Manual (Request) tab (Fig. 16) is opened. 
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Fig. 16 Licensing dialog Manual (Request) tab 

To save the licence request file, perform the following: 

1. Specify your user name and password. 

2. Click (tick) the checkbox of each InForm Plug-in you wish to license. 

3. Select where you would like to save the licence request file. 

4. Click the Save button. 

5. In the Confirmation dialog, click the OK button to close it. 

Email the licence request file to license@flysoftware.com. This process is 
likely to involve moving the file to a computer with an Internet 
connection. 

After receiving the licence request file, Fly Software use it to create a 
corresponding licence activation file.  

Activate Licence(s)  

The second part of the manual licensing process involves activating the 
requested InForm Plug-in licences. This is achieved using the licence 
activation file which is normally emailed to you by Fly Software within 24 
hours of receiving your licence request file. 

mailto:license@flysoftware.com
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The licence activation file has the following filename: 

InForm Licence (user name – yyyymmddhhmmss).req 

NOTE: 
If you do not have a licence in your Fly Software user account for a 
requested InForm plug-in licence, you will be notified by email. A licence 
will need to be purchased and the associated licence requested again. 

NOTE: 
When you receive your licence activation file, save it, and if necessary, 
make it accessible from the computer where InForm Designer is installed. 

Click the Licensing button, or click Help > Licensing then click the Manual 
(Activate) tab in the Licensing dialog. Following this, the Licensing dialog 
Manual (Activate) tab (Fig. 17) is opened. 

 

Fig. 17 Licensing dialog Manual (Activate) tab 

To activate the requested InForm Plug-in licences, perform the following: 

1. Click the Browse button. 

2. In the Open dialog, locate and select your licence activation file 
then click the Open button to close the Open dialog. 
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3. Click the Open button. 

4. Click the Activate button to activate all InForm Plug-in licences 
marked as Awaiting Activation. 

Un-license 

Please email license@flysoftware.com requesting instruction about how to 
manually un-license InForm Plug-ins. 

mailto:license@flysoftware.com
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Creating a New Form 
Unless you use a pre-designed InForm document, you will need to create 
a new one. This can be achieved in one of the following ways after 
launching InForm Designer: 

• Click one of the “Create a” task buttons or links on the Welcome 
screen (Fig. 4). 

• Hover over the New button to open a flyout menu then click one of 
the options. 

• Click File then hover over the New option to open a flyout menu 
then click one of the options.  

Following this, a new InForm document is created and a single blank page 
appears within the workspace. If enabled, application components such as 
the property inspector and plug-in palette also appear. 

NOTE: 
If an InForm document is already open and it has changed since it was last 
saved, a confirmation dialog is opened asking if you wish to save it before 
creating a new InForm document. If the InForm document has not 
changed since the last save then it is automatically closed. 

MORE: 
For details about the recommend method for creating a new InForm 
document that will be exported to HTML, refer to Creating HTML Forms > 
Getting Started > Recommended Method for Creating an InForm 
Document. 
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Opening, Closing and Saving Forms 
InForm Designer opens and can subsequently save and close InForm 
documents. 

Open 

An InForm document can be opened in one of the following ways after 
launching InForm Designer: 

• Click the Open Other button on the Welcome screen (Fig. 4). 
• Click the Open button. 
• Click File > Open. 
• Click a recent file link on the Welcome screen.  
• Click a recent files link on the File menu. 

Following this an Open dialog (Fig. 18) appears. 

 

Fig. 18 Open dialog 

Locate the InForm document you require within your file system, click it 
then click the Open button to close the Open dialog and open the InForm 
document. 

After opening an InForm document, page 1 appears by default. 
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NOTE: 
Only one InForm document can be opened per instance of InForm 
Designer.  If more than one needs to be opened, another instance of 
InForm Designer must be launched. 

Outside InForm Designer 

You can open an InForm document outside of InForm Designer by 
double-clicking its filename or file icon (Fig. 1) in your file management 
application (e.g. Windows® Explorer), email application (e.g. Outlook) or 
from a page displayed in your Web browser (e.g. Internet Explorer). 

Unavailable InForm Plug-ins 

If an InForm document contains a form element created using an InForm 
Plug-in that is not installed, it cannot be opened and an InForm Plug-in(s) 
Not Found dialog (Fig. 19) is opened.  

 

Fig. 19 InForm Plug-in(s) Not Found dialog (Text Box not found)  

To open a problematic InForm document, shutdown InForm Designer 
then download and install the latest InForm Designer and try again. 

Unrecognised Properties 

If an InForm document uses properties that are no longer available within 
InForm Designer, it cannot be opened and a Properties Not Recognised 
dialog (Fig. 20) is opened. 
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Fig. 20 Properties Not Recognised dialog 

To open the problematic InForm document, shutdown, download and 
install the latest InForm Designer and try again. 

Close 

To close an open InForm document click File > Close.  After closing, the 
application window remains and the Welcome screen (Fig. 4) appears. 

NOTE: 
If the InForm document you are closing has been changed since it was last 
saved, a confirmation dialog is opened asking if you wish to save it before 
closing. 

Save 

To retain additions and changes made to an InForm document you must 
save it.  

Click the Save button or click File > Save. 

CAUTION: 
If the InForm document has been saved before, the current content 
overwrites the previously saved content. 

NOTE: 
If the InForm document has not been saved before, a Save As dialog (Fig. 
21) is opened where a file name and folder location can be specified. 

HTML TIP: 
To create a HTML form, refer to Creating HTML Forms. 
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Save As 

To give an open InForm document a new filename (and as a result retain 
the previous save state), click File > Save As. This opens a Save As dialog 
(Fig. 21) where a new filename and folder location can be specified. 

 

Fig. 21 Save As dialog 

NOTE: 
Following a Save As, the InForm document that remains open is the newly 
saved one. 
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Resetting Forms 
Certain form elements can be reset to a default value or state by resetting 
the associated InForm document. 

Click the Reset Form button or click View > Reset Form. Following this, a 
Reset Form Confirmation dialog is opened asking you to confirm the reset. 

 

Fig. 22 Reset Form Confirmation dialog 

Click the Yes button to confirm the form reset or the No button to cancel 
and close the dialog. 

MORE: 
For details about indicating whether a form element can be reset, and the 
value or state it has following a reset, refer to Working with Form Elements 
> Applying Reset Conditions. 
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Validating Forms 
Many form elements can have validation applied to them to help ensure 
users complete or select them and/or fill in appropriate content. 

Validation of form elements is only performed in Filler mode or InForm 
Filler, and can occur under the following circumstances: 

Circumstance Description 

While a form element is 
being used 

Certain form elements only accept certain 
characters. Attempting to type an invalid character 
results in nothing appearing within the form 
element. 

When focus is removed 
from a form element 

Remove focus from the form element (i.e. deselect 
the form element or attempt to select another form 
element). If the form element fails validation the 
Validation Error dialog (Fig. 23) appears. 

When printing, 
emailing or posting to a 
URL is performed 

Start the print process, or click a print, email or post 
to URL button in an InForm document. If any form 
element fails validation the Validation Failed dialog 
(Fig. 24) appears. 

When requested 

Click the Validate Form button or View > Validate 
Form, or click a validate form button within an 
InForm document. If any form element fails 
validation the Validation Failed dialog appears. 

HTML TIP: 
For details about HTML form validation, refer to Creating HTML forms > 
Validating. 

 

Fig. 23 Validation Error dialog 
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Fig. 24 Validation Failed dialog 

Click the OK button to close the Validation Failed dialog or Validation Error 
dialog and return to the InForm document. 

MORE: 
For details about applying validation to form elements, refer to Working 
with Form Elements > Applying Validation. 
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Managing Printer Offsets 
It is common for different makes and models of printer to position printed 
content slightly differently. This is not normally a problem when printing 
InForm documents on plain paper, but if filled in content is printed on pre-
printed forms the differences in positioning can be unacceptable. 

 

Fig. 25 Example of misaligned form content on a pre-printed form 

To overcome the problem of printers positioning printed content 
differently, printer offsets can be defined so the entire printed content is 
moved horizontally and/or vertically on a page. 

EXAMPLE: 
If printed form content is misaligned by 3mm to the left and 2mm up for a 
particular printer, a printer offset that moves the printed content 3mm to 
the right and 2mm down is required for that printer. 

To add, modify and delete printer offsets select File > Printer Offsets. 
Following this, a Printer Offsets dialog (Fig. 26) is opened. 

 

Fig. 26 Printer Offsets dialog 
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Click the Close button to close the Printer Offsets dialog. 

MORE: 
For details about how to select a printer offset or specify one manually 
prior to printing, refer to Printing Forms > Using a Printer Offset. 

Adding 

To add a printer offset click the New button in the Printer Offsets dialog 
(Fig. 26). Following this, an Add Printer Offset dialog (Fig. 27) is opened.  

 

Fig. 27 Add Printer Offset dialog 

To configure a printer offset, perform the following actions: 

1. Click the Printer drop-down list then click the name of the printer 
the printer offset is required for. 

2. In the Offset Name edit box, type a name for the printer offset. This 
will be used to identify the printer offset within InForm Designer 
and InForm Filler. 

3. In the X Offset edit box type the number of millimetres (mm) 
printed content will be moved along the horizontal (x) axis of a 
page. A negative value moves printed content to the left, a positive 
value moves printed content to the right. 

4. In the Y Offset edit box type the number of millimetres (mm) 
printed content will be moved along the vertical (y) axis of a page. 
A negative value moves printed content up, a positive value moves 
printed content down. 

5. Click the OK button to add the printer offset and close the Add 
Printer dialog. 

Modifying 

To modify a printer offset click the name of the printer offset then the Edit 
button in the Printer Offsets dialog (Fig. 26). Following this, a Modify 
Printer Offset dialog (Fig. 28) is opened. 
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Fig. 28 Modify Printer Offset dialog 

Modify necessary settings in the same way as you add a printer offset then 
click the OK button. 

Deleting 

To delete a printer offset click the name of the printer offset then click the 
Delete button in the Printer Offsets dialog (Fig. 26). Following this, a 
Confirmation dialog (Fig. 29) is opened asking you to confirm the delete. 

 

Fig. 29 Delete Printer Offset Confirmation dialog 

Click the Yes button to confirm the delete or the No button to cancel. 
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Printing Forms 
Like most Windows applications, InForm Designer has a print facility. This 
enables InForm documents to be output on a printer, transmitted by fax, 
or converted to another file format such as XPS or PDF (if suitable drivers 
are installed). 

To begin printing, open the InForm document you wish to print then click 
the Print button, or click File > Print. Following this, the Print dialog (Fig. 
30) is opened. 

 

Fig. 30 Print dialog 

Click a printer in the Name drop down list, and if necessary configure it by 
clicking the Properties button. Specify the number of copies and the 
page(s) to print then click the OK button. 

Click the Cancel button to cancel printing and return to your InForm 
document.  

NOTE: 
When transmitting by fax or converting to another file format, further 
dialogs are likely to appear that require additional input. Follow the 
instructions provided within these dialogs to complete the associated 
process. 

NOTE: 
If printing is performed in Filler mode and validation fails for one or more 
form elements, the Validation Failed dialog (Fig. 23) appears prior to 
opening the Print dialog. 
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Using a Printer Offset 

If one or more printer offsets have been added for an InForm Designer 
installation, a Select Printer Offset dialog (Fig. 31) is opened after clicking 
the OK button in the Print dialog (Fig. 30). 

 

Fig. 31 Select Printer Offset dialog 

The Select Printer Offset dialog enables you to use a saved printer offset, 
specify a manual printer offset or ignore printer offsets completely. 

Click the Cancel button to close the Select Printer offset dialog, cancel 
printing and return to your InForm document. 

MORE: 
For further details about printer offsets and how to add, modify and 
delete them, refer to Getting Started > Managing Printer Offsets. 

Using a Saved Printer Offset 

If the printer selected in the Print dialog (Fig. 30) has an associated printer 
offset, the name of the printer offset is highlighted (in bold) in the Saved 
Offsets list of the Select Printer Offset dialog (Fig. 31). It is preferable that a 
highlighted printer offset is used but any one can be selected and used 
instead. 

Click the name of the printer offset you wish to use, confirm the X and Y 
offsets displayed below the Saved Offsets list are suitable then click the OK 
button. Following this the Select Printer Offset dialog is closed and the 
InForm document is printed using the selected printer offset. 
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Specifying a Manual Printer Offset 

If you prefer to configure and use a manual (bespoke) printer offset 
instead of a saved one, specify the X and Y offset values in millimetres 
(mm) in the Select Printer Offset dialog (Fig. 31). Following this, click the 
Use Manual Offsets checkbox to enable the manual settings and disable 
the printer offsets in the Saved Offsets list. 

Click the OK button to close the Select Printer Offset dialog and print the 
InForm document using the specified manual printer offset. 

Ignoring Printer Offsets 

To print an InForm document without applying a printer offset, click the 
Ignore offsets checkbox in the Select Printer Offset dialog (Fig. 31). 

Click the OK button to close the Select Printer Offset dialog and print the 
InForm document. 

Print Results 

In Designer mode, the outline of form element placeholders together with 
visible page margins, are printed. If you do not want these to be printed 
enter Filler mode or use InForm Filler.  

Form elements and associated components, together with pages and 
associated background effects not configured for publishing are not 
printed. 

MORE: 
For further details about configuring form elements and associated 
components for publishing, refer to Working with Form Elements > 
Publishing. 

MORE: 
For details about configuring pages for publishing, refer to Working with 
Pages > Publishing. 

MORE: 
For details about configuring page background effects for publishing, 
refer to Working with Pages > Adding Background Effects > Publishing. 

Printer Properties that are Ignored 

If an InForm document is not printed as expected, it may be due to certain 
page/paper properties for the selected printer being ignored. This is 
because the paper size and orientation properties of each page take 
precedence over corresponding printer properties. 
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EXAMPLE: 
If the orientation of a page is landscape, and the orientation of the printer 
is portrait, the page is output in landscape. 
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The Fly Software Watermark  
InForm documents that have been created using one or more unlicensed 
InForm Plug-ins, have a Fly Software watermark (Fig. 32) displayed on 
each page where an associated form element has been used. 

 

Fig. 32 Fly Software watermark 

To remove the watermark, all InForm Plug-ins that have been used within 
the InForm document must be licensed. 

HTML TIP: 
A HTML InForm Plug-in does not need to be licensed. Instead, the 
common InForm Plug-in it is associated with must be licensed instead. 
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Non-Visual Form Elements 
Non-visual form elements are elements included in an InForm document 
that are either invisible or normally used by multiple form elements 
and/or pages. 

EXAMPLE: 
HTML hidden fields are invisible within the HTML forms they appear in. 
They therefore appear within an InForm document as a non-visual form 
element. 

EXAMPLE: 
If a PDF is used as a page background for two pages and as the content of 
an image placeholder, instead of three instances within an InForm 
document, only a single non-visual instance is included. 

For each non-visual form element included in an InForm document, an 
icon appears on the non-visual form element bar (Fig. 33). 

 

Fig. 33 Non-visual form element bar 

Clicking an icon on the non-visual form element bar displays associated 
properties in the property inspector. 

Changing the Name 

To change the name of a non-visual form element, click the associated 
icon on the non-visual form element bar (Fig. 33) then overwrite the Name 
property value. 

If the name of a non-visual form element is changed, all references to it 
within an InForm document are also changed. 

Deleting 

Non-visual form elements can be removed from an InForm document by 
clicking the associated icon on the non-visual form element bar (Fig. 33) 
then pressing the Delete key or clicking the Delete button on the toolbar. 
Alternatively, right-click the icon then click the Delete option on the pop-
up menu. 

CAUTION: 
If a non-visual form element is deleted, it is also removed from all form 
elements and pages where it is used. 
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PDF 

An icon appears on the non-visual form element bar (Fig. 33) when a PDF 
is used as a page background or as the content of an image placeholder. 

MORE: 
For further details about using PDFs within your InForm documents, refer 
to Working with Pages > Adding Background Effects > Image and PDF and 
Common InForm Plug-ins > Image. 

Each non-visual PDF is automatically given a unique name to help you 
identify it. The format of this name is as follows: 

PDFView1 

Each non-visual PDF added to an InForm document has its name 
incremented by one. 

Changing the Source File 

To change the source file of a non-visual PDF, click the associated icon on 
the non-visual form element bar (Fig. 33) and double-click the PDF File 
Name property edit box. Following this, a PDF File dialog (Fig. 34) is 
opened where you can select a PDF from your file system. 

 

Fig. 34 PDF File dialog 

Following selection of a PDF, click the Open button to change the source 
file to the selected PDF. 
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CAUTION: 
The content of all form elements and page backgrounds that used the 
previous non-visual PDF change to reflect the new PDF. 
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Images and PDFs 
Images and PDFs used as page backgrounds and as the content of image 
placeholders are embedded in InForm documents and do not link to the 
original external source file. This means you do not have to include 
separate images or PDFs with your InForm documents. 

NOTE: 
If you change the content of an image or PDF source file, the changes are 
not reflected in an InForm document unless you import the file again. 

MORE: 
For further details about using images and PDFs, refer to Working with 
Pages > Adding Background Effects > Image and PDF and Common 
InForm Plug-ins > Image. 

Due to the possibility of a PDF having a large file size (due to multiple 
complex pages), a single non-visual instance of it is included within an 
InForm document. As a result, the file size of your forms is kept to a 
minimum. 

MORE: 
For further details about non-visual PDFs, refer to Getting Started > Non-
visual Form Elements > PDF. 

An image such as a BMP or JPG has a separate instance of it included 
within an InForm document each time it is used. 

EXAMPLE: 
If a BMP is used as a background for five pages, five instances of the BMP 
are included in the InForm document. 
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Filling in and Testing Forms 
InForm Designer has a Filler mode that replicates how InForm Filler looks 
and operates. This allows you to conveniently test your InForm 
documents for use with InForm Filler, or fill in an InForm document 
without the need for InForm Filler. 

MORE: 
For further details about Filler mode, refer to Getting Started > Workspace 
Overview > Filler Mode. 

HTML TIP: 
HTML forms can be tested locally on almost any computer. However, if an 
associated ASP or PHP submitted page requires testing all files must be 
uploaded to an ASP or PHP compatible Web server. 
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Improving Performance 
If InForm Designer is installed on a computer with minimum system 
requirements or similar, you may notice the speed at which pages that 
contain PDF backgrounds or PDF form elements are unacceptably slow. 

To increase the speed at which pages containing PDFs are displayed, a 
PDF Quick Draw option is provided. By default, this option is turned off 
but can be turned on if required. 

Click View > PDF Quick Draw to add a tick and turn the option on, or 
remove the tick and turn the option off. 

NOTE: 
If PDF quick draw is on, the quality of PDF page backgrounds and form 
elements is reduced. This reduction in quality is not evident when an 
InForm document is printed. 
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Undo and Redo 
While you are designing InForm documents you may make mistakes. To 
overcome these and return your InForm document to a suitable condition, 
an undo and redo facility is provided. 

Click the Undo button or click Edit > Undo to undo the last operation 
performed. 

Click the Redo button or click Edit > Redo to redo the last operation that 
was undone. 

NOTE: 
Multiple undo and redo actions can be performed up until the very first or 
last operation to be carried out during the current session. However, the 
number of undo and redo levels is determined by the Windows® resources 
available on the computer where InForm Designer is installed. 



Getting Started 

InForm Designer User Guide 65 

Viewing Developer and Application Information 
Information about Fly Software, copyright notices and InForm Designer’s 
version number, can be viewed when the application is launched or at any 
time in the About dialog (Fig. 35). 

 

Fig. 35 About dialog 

To open the About dialog, click the About InForm Designer button, or 
click Help > About InForm Designer. 

Click the OK button to close the About dialog. 
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Leaving Feedback 
To help Fly Software improve InForm Designer, feedback is welcomed. 

Your comments about InForm Designer can be conveniently emailed to 
Fly Software using the Feedback form on the Fly Software website. This is 
opened by clicking Help > Leave Feedback within InForm Designer or 
specifying the following URL in your Internet browser:  

http://www.flysoftware.com/support/feedback.asp 

NOTE: 
Prior to shutting down, BETA versions of InForm Designer automatically 
open the Feedback form within your Internet browser. 

http://www.flysoftware.com/support/feedback.asp
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Updating 
InForm Designer and InForm Plug-ins are continually being developed. As 
a result, new versions will become available that introduce new features 
or improve existing ones. 

To avoid technical difficulties and to benefit from the latest enhancements 
and fixes, it is advised you update your InForm Designer installation and 
all InForm Plug-ins regularly.  

For convenience, you can open the download page on the Fly Software 
website by clicking Help > Updates, or by specifying the following URL in 
your Internet browser: 

http://www.flysoftware.com/downloads/downloads.asp 

Updating InForm Designer is performed in the same way as installing it. 

http://www.flysoftware.com/downloads/downloads.asp
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Shutting Down 
Shutdown (Exit) InForm Designer by clicking File > Exit.  Alternatively, use 
the application close (exit) button on the title bar. 

NOTE: 
If an InForm document is open and has not been saved since changes 
were last made, a Save Changes confirmation dialog is opened prior to 
shutting down. 

NOTE: 
After shutting down, installations of InForm Designer that do not have any 
licensed InForm Plug-ins automatically open your Internet browser to 
display the Buy InForm Plug-ins page on the Fly Software website. 



Getting Started 

InForm Designer User Guide 69 

Uninstalling 
If you no longer wish to use InForm Designer and would like to remove it 
from your computer, it can be uninstalled. 

CAUTION: 
Prior to uninstalling, all licensed InForm Plug-ins must be unlicensed so 
Available licenses are credited to your Fly Software user account. InForm 
Designer must also be shutdown. 

InForm Designer is uninstalled using the Windows® Add or Remove 
Programs facility. 

MORE: 
For details about the Windows® Add or Remove Programs facility, refer to 
your Windows® documentation or Help.  

NOTE: 
After InForm Designer is uninstalled, the Fly Software folder and a license 
file remain. 
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Working with Pages 

In this section the following information is included: 

• Changing Pages 
• Inserting 
• Removing 
• Magnifying or Reducing the View 
• Moving About 
• Selecting 
• Changing the Size and Orientation 
• Adding Background Effects 
• Margins 
• Publishing 
• Properties 



Working with Pages 

72 InForm Designer User Guide 

Changing Pages 
After opening or creating an InForm document, page1 is displayed by 
default. It is likely, however, the InForm documents you design will require 
multiple pages and for this reason a facility is provided to allow you to 
view any one of them. 

The page bar (Fig. 36) displays buttons for all pages in an open InForm 
document.  A button that is “pressed” indicates the current page. 

 

Fig. 36 Page bar 

Click a page button to display that page. 

NOTE: 
If the page buttons exceed the length of the page bar, navigation arrows 
appear to allow you to display the page buttons that are not shown. Click 
the right arrow to move one page button to the right, and click the left 
arrow to move one page button to the left. 
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Inserting 
InForm documents can contain any number of pages, and new ones can 
be inserted at anytime. 

To insert a new page, click the Insert Page button or click Page > Insert 
Page. Following this, a page is inserted at the end of the InForm document 
and an associated page button is added to the page bar. The new page 
also becomes the current page. 

NOTE: 
A new page adopts the properties of the page that was current when the 
new page was inserted. 

EXAMPLE: 
If the current page is A5 landscape, the inserted page is also A5 landscape. 
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Reordering 
The position of pages within an InForm document can be moved using 
the page buttons found on the page bar. 

Click and hold the mouse button on a page button associated with a page 
you would like to move. Move the mouse until the pointer is over the 
page button you would like your page to become, and release the button. 

EXAMPLE: 
If you moved page 5 onto page 2, page 5 would become page 2, and the 
original page 2 and subsequent pages are incremented by one. 
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Removing 
To remove a page, make it the current page then click the Delete Page 
button or click Page > Delete Page. Following this, a confirmation dialog is 
opened asking you to confirm the delete. 

Click the Yes button to remove the page or the No button to cancel the 
delete. 
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Magnifying or Reducing the View 
Depending upon your personal preference, the resolution of your monitor 
or the monitor of the intended recipients of your InForm document, you 
may want to magnify or reduce the current page view. This can be 
achieved during the design process using predetermined page views and 
the mouse and keyboard, or by specifying default page views for when an 
InForm document is opened. 

NOTE: 
Changing the page view only changes how it appears on screen, and does 
not affect the “physical” or printed size of the page. 

Predetermined Page Views 

The following predetermined page views are provided to allow you to 
quickly change the current page view: 

• Actual Size 
• Fit to Width 
• Fit to Page 
• Zoom Presets 

Using the Mouse and Keyboard 

If your mouse has a wheel button, you can quickly and conveniently resize 
the page view.  

Make sure no form elements are selected (by clicking the page or pressing 
the Esc key), hold the Ctrl key and roll the wheel button up to zoom in, 
and down to zoom out. 

Specifying a Default 

By default, the page view specified for each page when an InForm 
document is saved is the page view used when the InForm document is 
opened. 

EXAMPLE: 
If page 1 of an InForm document has its page view set to 75% when the 
InForm document is saved, the page view for page 1 is 75% when the 
InForm document is opened. 

This mechanism is likely to be suitable during the design process because 
the page view you specify for each page is governed by your 
requirements and the resolution of your monitor. However, if your InForm 
document will be used by others who are likely to have different monitor 
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resolutions, the page view you specified prior to saving may be 
unsuitable. 

To determine how each page is viewed when an InForm document is 
opened, a default view can be specified. 

Select a page followed by the required option from the Default View 
property value list box. 

The Actual Size, Fit to Width and Fit to Page options replicate the actions 
associated with the corresponding predetermined page views found on 
the View menu and toolbar. 

The Current option (default) uses the page view in use when the InForm 
document was last saved. 
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Moving About  
Certain magnification levels may prevent parts of a page being visible 
within the workspace. When this occurs, you may need to move the page 
to display the hidden areas. This can be achieved using scroll bars (Fig. 37), 
the mouse or the keyboard. 

Using Scroll Bars 

When the size of a page exceeds the size of the workspace, vertical and/or 
horizontal scroll bars (Fig. 37) appear. 

Scroll bars allow you to move the viewable area of a page, up, down, left 
and right. Each scroll bar consists of a number of components that move 
the page in a particular way. 

 

Fig. 37 Scroll bar (horizontal)  

Arrows 

Click an arrow to move the page (and scroll bar slider) in the direction of 
the arrow. 

Slider 

Click the slider, hold the primary mouse button then move the mouse to 
move the page (and scroll bar slider).  

Slide Bar 

Click anywhere on the slide bar to move the page (and the scroll bar 
slider).  

Using the Mouse 

If your mouse has a wheel button, roll it up to move the page up, and 
down to move the page down. 

Using the Keyboard 

Press the Page Up button to move the page up, and the Page Down 
button to move the page down. 
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Selecting 
Before a page can be configured to your requirements, it must be 
selected. This can be achieved in any of the following ways: 

• Click a blank area of the page. 
• Click the Page Properties button. 
• Click Page > Properties. 
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Changing the Size and Orientation 
When you create a new InForm document, the size and orientation of the 
initial page is determined by the corresponding settings of the default 
printer.  

EXAMPLE: 
If your default printer has its paper size set to A5 landscape, the initial 
page will be A5 landscape. 

Any page that makes up the InForm document can have its size and 
orientation changed to suit your design requirements or match the 
output size and orientation of the intended printer. 

NOTE: 
Each page has its own size and orientation. As a result, changing the size 
and orientation of one page does not affect other pages. 

NOTE: 
When printing an InForm document, changes to the paper size and 
orientation of the selected printer are ignored. 

HTML TIP: 
For Web “safe” page sizes, refer to Creating HTML Forms > Considerations 
> Page Size > Web “Safe” Page Sizes. 

Standard Paper Sizes 

To apply a standard paper size, select a page, open the Paper property 
group then click the required paper size in the Size property value list box.  

Bespoke Paper Sizes 

To apply a bespoke paper size, select a page, open the Paper property 
group then type the width (in mm) within the Width property value edit 
box, and the height (in mm) within the Height property value edit box. 

Orientation 

To change the orientation, select a page, open the Paper property group 
then click either Portrait or Landscape in the Orientation property value 
list box. 

Resizing and Moving Form Elements 

When a change to the paper size or orientation is initiated, a Resize and 
Reposition Confirmation dialog (Fig. 38) appears asking if you would like 
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to change the size and position of all form elements on the page to reflect 
the change. 

 

Fig. 38 Resize and Reposition Confirmation dialog 

Click the Yes button to change the size and position of form elements. 

Click the No button to keep the existing size and position of form 
elements. 

Click the Cancel button to cancel the change to paper size or orientation. 

Allowing the size and position of form elements to change is particularly 
useful when they are positioned in relation to specific areas on an image 
or PDF page background. 

MORE: 
For details about manually changing the size and position of form 
elements, refer to Working with Form Elements. 
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Adding Background Effects 
If you require anything different from the default white page background, 
you can add a fill, image and a PDF to any page in an InForm document. 

Fill 

To add a fill to a page, select a page, open the Fill property group and click 
a color in the Color property value list box.  Alternatively, double-click the 
Color property value list box to open the Windows® Color palette where a 
color can be selected or defined. Following this, the entire page is 
displayed in the chosen color. 

Image and PDF 

The following file formats can be used as page backgrounds: 

• BMP 
• EMF 
• GIF 
• ICO 
• JPG/JPEG 
• PDF 
• PNG  
• WMF 

To add an image or PDF to a page, select a page, open the Background 
property group and double-click the Filename property value edit box. 
Alternatively, double-click the page. A Background Image File dialog (Fig. 
39) is opened where an image file or PDF can be selected. 
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Fig. 39 Background Image File dialog 

Following selection of an image file or PDF, click the Open button to close 
the dialog and display the page background. 

If a PDF was selected, page 1 of the PDF is displayed by default and an 
associated icon appears on the non-visual form element bar if the PDF has 
not previously been included in your InForm document. 

NOTE: 
If a PDF you wish to use as a page background has already been included, 
it can be used as a page background by opening the PDF property group 
then clicking the required PDF name in the Link property list box.  

To remove an image or PDF from a page, delete the filename from the 
Filename property value edit box. 

Resizing to the Page or Margins 

By default, any image or PDF used as a page background is resized to fit 
the entire page.  If preferred, it can instead be resized to fit within the 
margins. 

To resize an image to the margins, select a page, open the Background 
property group then click the Page Margins option in the Fit To property 
list box. 

To resize an image to the page, click the Full Page option in the Fit To 
property list box. 
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Hiding in Filler Mode and InForm Filler 

An image or PDF added as a page background can be hidden from view 
when an associated InForm document is opened in Filler mode or InForm 
Filler. This is useful, when you have used an image or PDF as a design 
template. 

Select the page, open the Background property group then click the No 
option in the Display property value list box. 

To display an image or PDF page background, click the YES option in the 
Display property value list box. 

Selecting a PDF Page 

By default, page one of a PDF is displayed as a page background. To 
change the page, open the PDF property group and type the required 
page number in the Page property value edit box. If the page is available, 
it appears as the background for the current page. 

Publishing 

By default, page fills, images and PDF pages are published when an 
InForm document is printed or exported to HTML. However, if they are 
only intended for display within InForm Designer and InForm Filler, you 
can prevent them from being published*. 

To prevent a fill being published, select the page, open the Fill property 
group then click the No option in the Publish property value list box. 

To prevent an image or PDF page being published, select the page, open 
the Background property group then click the No option in the Publish 
property value list box. 

To publish a fill, image or PDF page, click the Yes option in the Publish 
property value list box within the appropriate property group. 

MORE: 
For details about configuring publishing options for an entire page, refer 
to Working with Pages > Publishing. 
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Margins 
Margins (Fig. 40) are a useful visual reference for aligning form elements 
on a page or keeping them within the physical constraints of a printer. The 
top, right, bottom and left sides of a page each have a configurable 
margin represented by a green dotted line. 

 

Fig. 40 Margins (bottom left of page)  

To change the margins, select a page, open the Margins property group 
and type the amount (in mm) a margin should appear from the edge of 
the page into the Top, Right, Bottom and Left margin property value edit 
boxes.  

NOTE: 
Margins are not displayed on pages viewed in Filler mode or InForm Filler. 

Showing and Hiding 

To hide page margins, select a page, open the Margins property group 
then click the No option in the Display property value list box. 

To display page margins, click the Yes option in the Display property value 
list box. 
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Publishing 
By default, pages are published when an InForm document is printed or 
exported to HTML. However, if a page is only intended for display within 
InForm Designer and InForm Filler, you can prevent it from being 
published. 

EXAMPLE: 
Page 2 of an InForm document could be an instruction or notes page that 
does not require printing. 

To prevent a page being published, select the page then the No option in 
the Publish property value list box. 

To publish a page, click the Yes option in the Publish property value list 
box. 
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Properties 
Pages within an InForm document have the following properties: 

+Paper 
Size 
Width (mm) 
Height (mm) 
Orientation 

+Background 
File Name 
+PDF 

Link 
Page 

Drawing 
Publish 
Display 

+Fill 
Color 
Publish 

+Margins 
Top 
Right 
Bottom 
Left 
Display 

Default View 
Publish 
Default Focus 

NOTE: 
Each page has its own set of properties and associated values. As a result, 
changing a property value of one page does not affect the same property 
of another page. 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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Working with Form 
Elements 

In this section the following information is included: 

• Adding 
• Selecting 
• Moving 
• Resizing 
• Naming 
• Copying, Cutting, Pasting and Duplicating 
• Manipulating Text 
• Manipulating Numbers 
• Adding a Border 
• Adding a Fill 
• Adding a Pad 
• Adding a Hint 
• Making Read Only 
• Publishing 
• Locking 
• Applying Validation 
• Finding 
• Tabbing 
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Adding 
Any number of form elements can be added to any page within an InForm 
document in the following way: 

1. Click the associated InForm Plug-in button in the plug-in palette. 
The mouse cursor now changes to a + to indicate a form element is 
ready to be added. 

2. Move the cursor within the page then left-click and hold the 
button. 

3. Move the mouse to “draw” the outline of the form element’s 
placeholder (Fig. 41). 

4. When the placeholder is at the size you require, release the mouse 
button. 

 

Fig. 41 Form element placeholder 

HTML TIP: 
When certain HTML Plug-ins are used, the associated form element 
placeholder does not appear and instead the form element appears in its 
default HTML state. 

MORE: 
For details about each InForm Plug-in, refer to Common InForm Plug-ins 
and HTML InForm Plug-ins. 
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Selecting 
One, multiple or all form elements on a page can be selected. Doing so 
allows you to move, resize or change corresponding property values. 
When selected, resize handles appear on the placeholder(s) (Fig. 42). 

 

Fig. 42 Selected form element placeholder 

NOTE: 
When multiple form elements are selected, resize handles only appear in 
the corners of each placeholder. 

NOTE: 
Instructions within the user guide and Help for performing actions on 
form elements are described for when a single form element is selected. 
Despite this, certain instructions also apply when multiple form elements 
are selected. 

HTML TIP: 
When certain form elements that have been created using HTML InForm 
Plug-ins are selected, the associated form element placeholder does not 
appear. Instead, the form element appears in its default HTML state (Fig. 
43) but the resize handles remain. 

 

Fig. 43 Selected HTML text box 

One Form Element 

To select a single form element, move the mouse pointer over the top of it 
then click. 

Alternatively, click the name of the form element in the list box displayed 
at the top of the property inspector. 

Multiple Form Elements 

To select multiple form elements, position the mouse pointer anywhere 
on a blank area of a page then click and hold the mouse button. Now 
move the mouse to “draw” a selection box around or over the form 
elements that require selection. Release the mouse button to select the 
form elements the selection box encompasses. 
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Alternatively, hold the Shift key then click each form element you would 
like to select in turn. Each form element is selected and previously 
selected ones remain selected. 

All Form Elements 

To select all form elements on a page, click the Select All button, or click 
Edit > Select All. Alternatively, use the technique for selecting multiple 
form elements, remembering to encompass all form elements with the 
selection box. 

Deselecting 

Form elements can be deselected in any of the following ways: 

• Selecting another form element. 
• Holding the Shift key and clicking individual selected form 

elements in a group. 
• Selecting a page. 
• Clicking a selected form element and pressing the Esc key. 



Working with Form Elements 

InForm Designer User Guide 93 

Moving 
Form elements can be moved anywhere on a page using the mouse, 
keyboard, or by changing its properties. 

Using the Mouse 

Click and hold the mouse button anywhere within the placeholder of a 
form element you would like to move. Move the mouse cursor until the 
form element is in the required position then release the button. 

NOTE: 
If a form element is locked it cannot be moved using the mouse. 

Using the Keyboard 

Select a form element, hold the Ctrl key then press the Arrow keys to 
nudge the form element up, down, left and right by one pixel. 

Hold the Ctrl and Shift keys then press the Arrow keys to nudge the form 
element by eight pixels. 

NOTE: 
If a form element is locked it cannot be moved using the keyboard. 

By Changing Properties 

Select a form element, open the Position & Size (mm) property group then 
change the Left and/or Top property values as required. 

The Left property value is the number of millimetres the top left edge of a 
form element’s placeholder is offset from the left-hand edge of the page. 

The Top property value is the number of millimetres the top left edge of a 
form element’s placeholder is offset from the top of the page. 
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Stacking 
By default, the last form element added to a page appears above all other 
form elements on that page (Fig. 44). As a result, form elements can 
overlap others or hide them completely. To resolve this, the stacking order 
of form elements can be changed by sending them to the front or back of 
other form elements on the same page. 

 

Fig. 44 Stack order 

To Front 

To send a form element to the front of the stacking order, select the form 
element then perform one of the following actions: 

• Click the To Front button. 
• Click Element > To Front. 
• Click the To Front option on the form element’s context menu. 

To Back 

To send a form element to the back of the stacking order, select the form 
element then perform one of the following actions: 

• Click the To Back button. 
• Click Element > To Back. 
• Click the To Back option on the form element’s context menu. 
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Resizing 
Form elements can be made larger or smaller using the mouse and 
keyboard or by changing properties. 

Using the Mouse 

Select a form element, decide which direction (top, right, bottom, left or 
diagonal) you wish to resize it then click and hold the mouse button over 
the resize handle corresponding to that direction.  

EXAMPLE: 
If you want to resize the width of a form element by increasing or 
decreasing its left edge, use the middle-left resize handle. 

NOTE: 
When multiple form elements are selected, resize handles only appear in 
the corners of each placeholder. 

Move the mouse to resize the placeholder and the form element it 
contains then release the button to apply the change. 

NOTE: 
If a form element is locked it cannot be resized using the mouse. 

Using the Keyboard 

The right and bottom edges of a form element can be moved using the 
keyboard in order to change the size. 

Select a form element, hold the Shift key then press the Left and Right 
Arrow keys to move the right edge left and right, and the Up and Down 
Arrow keys to move the bottom edge up and down by one pixel. 

NOTE: 
If a form element is locked it cannot be resized using the keyboard. 

By Changing Properties 

Select a form element, open the Position & Size (mm) property group then 
change the Width and/or Height property values as required. 

A change to the Width property value either increases or decreases the 
right-hand edge of the placeholder and form element it contains. 

A change to the Height property value either increases or decreases the 
bottom edge of the placeholder and form element it contains. 
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Naming 
To identify form elements, each is automatically given a unique name 
when it is added to a page. 

The default naming format comprises an alpha name that relates to the 
type of form element, followed by a sequential number. 

EXAMPLE: 
The first text box added is called TextBox1. The second text box is called 
TextBox2, and so on. 

If the default naming convention is not to your liking or you would like to 
be more descriptive, you can apply your own name to any form element. 

Select a form element then overwrite or edit the existing name in the 
Name property value edit box. 

HTML TIP: 
The Name property value of a form element is used to define the Name 
attribute value of an associated HTML tag. 

Conventions 

The name of a form element must adhere to the following conventions: 

• Alphanumeric characters only. 
• No spaces. 
• Unique (i.e. another form element within the same InForm 

document must not have the same name). 
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Copying, Cutting, Pasting and Duplicating 
A form element or text selection can be cut or copied, then pasted on any 
page in the current InForm document or an InForm document within 
another instance of InForm Designer. Alternatively, a form element can be 
duplicated on the same page. 

Select a form element then click the cut, copy, paste and duplicate toolbar 
buttons or Edit menu options. Alternatively, use the context menu. 

NOTE: 
A form element that is pasted or duplicated retains the same property 
values as the original form element. 
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Manipulating Text 
Text manipulation facilities common to many DTP and word processing 
applications are also available in InForm Designer. These allow you to 
determine the font, size, style and color of text, and specify paragraph 
settings such as alignment and the position of text within a form 
element’s placeholder. 

NOTE: 
Changing the text of a form element affects all the text within that form 
element. As a result, you cannot have one word displayed in bold and 
another displayed in italic, within the same form element. 

Changing the Font, Size, Style and Color 

To change the appearance of text within a form element, the font, size, 
style and color can be changed. 

Select a form element then open the Character property group. Here you 
can select any font installed in Windows®, change the size, and specify a 
color. 

Open the Style property group within the Character property group to 
make text bold, italic, underlined, strikethrough and uppercase. 

Font Considerations 

When an InForm document is opened in InForm Designer or InForm Filler, 
or a HTML form is opened in an Internet browser, any font that has been 
used but is not installed on the computer is substituted with another font. 
As a result, text may not align properly, or parts may become unreadable 
or disappear completely. 

To overcome this, it is important you use fonts common to the computer 
where the form will be filled in or modified. It is therefore advised you use 
the following Windows® default fonts when designing forms: 

• Arial 
• Arial Black  
• Comic Sans MS  
• Courier New  
• Georgia  
• Impact 
• Times New Roman  
• Trebuchet MS  
• Verdana  
• Webdings 
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MORE: 
For further details about using fonts when creating HTML forms, refer to 
Creating HTML Forms > Considerations > Fonts. 

MORE: 
For further details about Windows® fonts, refer to the following Microsoft® 
web page: 

http://www.microsoft.com/typography/ 

Changing the Justification 

The justification of text within a form element can be changed to achieve 
the following effects: 

• Variable  Text has flush-left and ragged-right edges. 
• Justified  Text has flush-left and right edges. 
• Fixed  Individual characters appear in fixed pitch boxes.* 

Select a form element, open the Paragraph property group then click the 
required option in the Style property value list box. 

Changing Horizontal and Vertical Alignment 

Text in a placeholder can be aligned horizontally left, right or center, and 
vertically up, down or center.  

Select a form element, open the Paragraph property group then click the 
required option in the Horizontal Alignment and/or Vertical Alignment 
property value list boxes. 

MORE: 
Padding can also be used for even greater control of where text is 
positioned within a placeholder. For details, refer to Working with Form 
Elements > Adding a Pad. 

http://www.microsoft.com/typography/
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Manipulating Numbers 
It is common for forms to request numerical information such as monetary 
values from users. To help ensure this information is valid and formatted 
to your requirements, certain form elements such as text boxes, combo 
boxes and calculation boxes can be configured to allow only numbers 
and/or display them in a particular format. 

Allowing Only Numbers 

Text boxes and combo boxes can be configured to only accept numbers, 
and calculation boxes always assume numbers. 

MORE: 
For details about configuring text boxes so they only allow numbers, refer 
to Common InForm Plug-ins > Text Box > Specifying the Input Type. 

MORE: 
For details about configuring text boxes so they only allow numbers, refer 
to Common InForm Plug-ins > Combo Box > Specifying the Input Type. 

NOTE: 
If a text box or combo box is configured to only accept numbers and it 
already contains non-numeric data, NAN (not a number) appears in the 
text box or combo box. 

Specifying Minimum and Maximum Values 

If a form element has been configured to allow only numbers, minimum 
and maximum values can be specified to prevent users from typing values 
that are too low or too high. 

Select a form element, open the Validation property group then type a 
value in the Minimum Value and/or Maximum Value property value edit 
boxes. 

MORE: 
To restrict the numbers users can type within a text box (i.e. allow only 0 
to 9 for a telephone number form field), refer to Common InForm Plug-ins 
> Text Box > Restricting Content. 

Decimal Places 

By default, form elements configured to allow only numbers display 
values with two decimal places. 

EXAMPLE: 
If the number 2 is typed, 2.00 is displayed. 
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To increase or decrease the number of decimal places, select a form 
element, open the Numerics (Display) property group then type a value 
into the Decimal Places property value edit box.  

Specify 0 to prevent decimal places being displayed. 

Hiding Zero(s)   

By default, incomplete form elements configured to allow only numbers, 
display zero, together with additional zeros to indicate the number of 
decimal places. However, if an InForm document is printed and filled in by 
hand, these zeros are also printed and may prevent users from writing 
within the designated area. 

To hide the zero(s), select a form element, open the Numerics (Display) 
property group then click the No option in the Display Zero property 
value list box. 

To show the zero(s), click the Yes option in the Display Zero property value 
list box. 

NOTE: 
Leading and post-number zeros applied using the Zero Pad property are 
not hidden. 

Padding With Zeros 

Form elements configured to allow only numbers can have padding zeros 
applied from either the left or right of a number they contain.  

EXAMPLE: 
A form element containing 99 could be configured to display 099 or 990. 

To apply zeros from the left or right of a number, open the Numerics 
(Display) property group then the Zero Pad property group then click the 
Left or Right option in the Pad property value list box. 

To determine the number of zeros to display, type a value that represents 
the number you require into the Width property value edit box. This 
number takes into account numbers specified in the associated form 
element and any decimal place. 

EXAMPLE: 
If the Pad property value = Left and the Width property = 4 then 5 is 
displayed as 0005. 

EXAMPLE: 
If the Pad property value = Left and the Width property = 6 then 5.00 is 
displayed as 005.00 
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EXAMPLE: 
If the Pad property value = Right and the Width property = 8 then -58 is 
displayed as -58000000. 

EXAMPLE: 
If the Pad property value = Right and the Width property = 8 then -58.00 is 
displayed as -58.00000 

To disable zero padding, click the None option in the Pad property value 
list box. 

Separating Thousands 

By default, form elements configured to allow only numbers do not 
separate thousand values. 

EXAMPLE: 
Twenty two thousand is displayed as 22000. 

If you prefer your thousand values to be separated by a comma (,), open 
the Numerics (Display) property group then click the Yes option in the 
Separate Thousands property value list box. 

EXAMPLE: 
Twenty two thousand is displayed as 22,000. 
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Adding a Border  
All form elements can have a border (Fig. 45) applied to them that follows 
the outline of the placeholder.  The line width and the color of the border 
can both be changed. 

 

Fig. 45 Text box border examples 

HTML TIP: 
Omit borders if you prefer form elements to appear in their default HTML 
state within a HTML form. 

MORE: 
For details about preventing a border being published when an InForm 
document is printed or exported to HTML, refer to Working with Form 
Elements > Publishing. 

Changing the Line Width 

By default, borders normally have a line width (weight) of 0 pixels 
meaning no border is displayed. This value can be changed to obtain the 
line width you require. 

Select a form element, open the Border property group then change the 
Width property value to a number that corresponds to the width in pixels 
you would like the border to be. 

Changing the Color 

By default, the color of a border is black, but this can be changed to suit 
your requirements. 

Select a form element, open the Border property group then click a color 
in the Color property value list box. Alternatively, double-click the Color 
property value list box to open the Windows® Color palette where a color 
can be selected or defined. 
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Adding a Fill 
Form elements have a fill (Fig. 46) that determines the color and 
transparency inside the placeholder. 

 

Fig. 46 Text box fill examples 

HTML TIP: 
Omit fills if you prefer form elements to appear in their default HTML state 
within a HTML form. 

MORE: 
For details about preventing a fill being published when an InForm 
document is printed or exported to HTML, refer to Working with Form 
Elements > Publishing. 

Changing the Color 

Most form elements use None as a default color. This can be changed as 
required.  

Select a form element, open the Fill property group then click a color in 
the Color property value list box. Alternatively, double-click the Color 
property value list box to open the Windows® Color palette where a color 
can be selected or defined. 

Changing the Transparency 

By default, the transparency of form element fills is turned on, but can be 
turned off if required. 

While transparency is on, anything displayed underneath a form element 
(like the page background or another form element) is visible through the 
fill. 

To turn transparency off, select a form element, open the Fill property 
group then click the No option in the Transparent property list box.  

To turn transparency on, click the Yes option in the Transparent property 
list box.  

NOTE: 
Shapes do not have a Transparency property, but instead have a Mode 
property where special fill effects can be selected.  
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Adding a Pad 
A pad (Fig. 47) is the amount of space between the edge of a form 
element’s placeholder and the content it contains or will contain. By 
default, all form elements have a pad of 0 pixels, meaning the content 
appears next to the outside edge of the placeholder. 

 

Fig. 47 Text box examples without (default) and with a pad. 

The top, right, bottom and left edges of a form element can each have a 
pad applied. 

To add padding, select a form element, open the Pad (Pixels) property 
group then change the values in the Top, Right, Bottom and/or Left 
property value edit boxes, to the amount in pixels you want the contents 
within the placeholder to be indented by. 

To remove padding, type 0 within the Top, Right, Bottom and/or Left 
property value edit boxes. 
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Adding a Hint 
To help users of your forms identify and complete form elements, hints 
(Fig. 48) can be added that appear when the mouse pointer is positioned 
over them. 

 

Fig. 48 Text box example displaying its hint 

HTML TIP: 
Adding a hint to a form element applies a title and an alt attribute to the 
associated HTML tag within a HTML form. The title causes a tooltip 
containing the hint text to appear when the mouse pointer is positioned 
over the form element in an Internet browser. The alt attribute is used for 
accessibility. 

To add a hint, select a form element, open the General property group 
then type the hint text within the Hint property value edit box. 
Alternatively, double-click the Hint property value edit box to open the 
Hint dialog (Fig. 49) where hint text can be typed. 

 

Fig. 49 Hint dialog 

To remove a hint, delete all text within the Hint property value edit box or 
Hint dialog. 

NOTE: 
Certain form elements such as text boxes and shapes can be double-
clicked to open the Hint dialog. 
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Adding Fixed Pitch Boxes 
Many forms request information such as serial numbers, sort codes, bank 
account numbers and dates. To display this information more clearly it is 
often preferable to present each character in its own box. This is achieved 
by adding fixed pitch boxes (Fig. 50) to certain form elements. 

 

Fig. 50 Text box example with fixed pitch boxes applied 

Supported InForm Plug-ins 

Fixed pitch boxes can be used with the following InForm Plug-ins: 

• Calculation Box 
• Combo Box 
• Date Box 
• Label 
• Text Box 
• Time Box 

HTML TIP: 
When an InForm document is exported to HTML, fixed pitch boxes are 
ignored and the default functionality of associated form elements is 
applied.  

MORE: 
For details about adding, selecting, moving, resizing and styling fixed 
pitch form elements, refer to Working with Form Elements. 

Applying to a Form Element 

Select a form element that supports fixed pitch, open the Paragraph 
property group then click the Fixed option in the Style property value list 
box. Following this, the outline of fixed pitch boxes completely fills the 
inside of the form element’s placeholder. 

At this stage the fixed pitch boxes can be configured to meet your design 
requirements. 

Configuring Boxes 

The size of fixed pitch boxes and the gap between them can be changed, 
and a border and fill applied. 
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Select a form element that has its paragraph Style property set to Fixed 
then open the Fixed property group to display the properties for changing 
the width and height, and the vertical and horizontal gaps of all the fixed 
pitch boxes simultaneously. 

By changing the size of a form element’s placeholder, and manipulating 
the Width and Height property values, you can obtain the required 
number of fixed pitch boxes. 

MORE: 
For details about adding a border and fill to all fixed pitch boxes, refer to 
Working with Form Elements > Adding a Border, and Working with Form 
Elements > Adding A Fill. 
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Making Read Only 
By default, form elements can be interacted with within Filler mode and 
InForm Filler. However, if a form element is required for display purposes 
only, it can be set to read only. 

To set a form element to read only, select the form element, open the 
General property group then click the Yes option in the Read Only 
property value list box. 

To set a form element so it can be interacted with, click the Yes option in 
the Read Only property value list box. 

HTML TIP: 
When an InForm document is exported to HTML, read only form elements 
become interactive. 
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Publishing 
By default, form elements including their border and fill  are published 
when an InForm document is printed or exported to HTML. However, if a 
form element and/or its border and fill are only intended for display within 
InForm Designer and InForm Filler, you can prevent them from being 
published. 

To prevent a form element being published, select the form element, 
open the General property group then click the No option in the Publish 
property value list box. 

To prevent a fill or border being published, select the form element, open 
the Fill or Border property group then click the No option in the Publish 
property value list box. 

To publish a form element, or associated border or fill, click the Yes option 
in the Publish property value list box within the appropriate property 
group. 
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Locking 
When a form element has been moved and resized to your requirements, 
it can be locked so it cannot be accidentally moved or resized using the 
mouse or keyboard until the lock is removed. 

To add a lock, select a form element, open the General property group 
then click the Yes option in the Lock property value list box. Following 
this, the form element’s placeholder (Fig. 51) changes from green to red to 
indicate it is locked. 

 

Fig. 51 Locked form element placeholder 

To remove a lock, click the No option in the Lock property value list box. 

NOTE: 
A locked form element can be moved and resized without removing the 
lock, by changing its Position & Size properties. 
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Applying Reset Conditions 
Certain form elements can be reset when a user resets a form in InForm 
Filler or Filler mode. 

MORE: 
For details about how to reset a form, refer to Getting Started > Resetting 
Forms. 

HTML TIP: 
HTML form elements cannot have reset conditions applied. Instead, when 
a HTML form is reset all form elements are reset to their default value or 
state. 

Specifying Whether a Form Element can be Reset 

Form elements that can be reset are configured to reset by default. 

To prevent a form element being reset, select the form element, open the 
On Reset Form property group, click the Can Be Reset property value list 
box then click the No option. 

Click the Yes option to allow a form element to be reset. 

Specifying the Value or State 

The value or state of a form element after a form is reset can be specified. 

EXAMPLE: 
A check box could be configured so it appears unchecked after a form is 
reset.  

Select a form element, open the On Reset Form property group, then 
perform one of the following actions: 

• For form elements that can contain text (e.g. a text box), click the 
Text On Reset property value edit box then type the text that 
should appear when the form is reset. 

• For form elements that have a state (e.g. a check box), click the 
State On Reset property list box then click the required option. 
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Applying Validation 
To help ensure InForm documents are filled in correctly, validation such as 
forcing completion or only allowing certain characters to be typed can be 
applied to certain form elements.  

Select a form element then open the Validation property group to view 
and configure associated validation properties. 

NOTE: 
Validation of form elements that only accept specific data such as a date 
box or a text box configured for numbers or email addresses, do not 
require data specific validation to be applied because it is automatically 
assumed. 

HTML TIP: 
For details about HTML form validation, refer to Creating HTML Forms > 
Validating. 

MORE: 
For details about how to validate a form, refer to Getting Started > 
Validating Forms. 

MORE: 
For details about validation properties, refer to Appendix A – Properties. 

Specifying Error Messages 

Error messages that appear in the Validation Failed dialog (Fig. 23) or the 
Validation Error dialog (Fig. 23) can be specified for form elements that 
support validation. 

To specify one or more error messages: 

1. Select a form element. 
2. Open the Validation property group. 
3. Double-click the Error Message property value to open the 

Validation Error Messages dialog (Fig. 52). 
4. Click a failed validation option in the Failed Validation box to select 

it. 
5. Click inside the Error Message edit box then type an error message 

for the selected failed validation option or keep the default error 
message. Name lookups can also be specified. 

6. Repeat 4 and 5 for each failed validation you want to specify an 
error message for. 

7. Click the OK button to close the Validation Error Messages dialog 
and apply the error message(s). 
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Fig. 52 Validation Error Messages dialog 

Name Lookups 

Error messages that appear in the Error Message edit box of the Validation 
Error Messages dialog (Fig. 52) can contain name lookups in the following 
format: 

<name lookup> 

NOTE: 
Most default validation error messages contain a name lookup. 

Name lookups are placements for the Name property value of the form 
element a validation error message is being defined for or other form 
elements that must be checked, filled in or matched. As a result, when an 
error message appears, the Name property value of a form element 
appears instead of the name lookup. 

The following name lookups can be specified: 

Name Lookup Description 

<checkname> 
Refers to the form element that must also be 
checked. 

<fillname> 
Refers to the form element that must also be filled 
in. 

<matchname> 
Refers to the form element that must match the 
form element the validation error is being defined 
for. 

<name> 
Refers to the form element the validation error 
message is being defined for. 

EXAMPLE: 
When defining a validation error message for a text box with a Name 
property value of FirstName, the <name> name lookup is replaced by 
FirstName when the associated validation error is displayed. 
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Finding 
It can be difficult and time consuming trying to locate a form element if 
the InForm document it is contained in has a large number of form 
elements and pages. To help with this process, a mechanism is provided 
to quickly find a form element located anywhere in the current InForm 
document. 

Click the Find button or click Element > Find to open the Find dialog (Fig. 
53). 

 

Fig. 53 Find dialog 

In the list, locate the name of the form element you require then click it to 
highlight it. Now click the Select button to display the page where the 
form element appears and select it. 

Click the Close button to close the Find dialog. 
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Tabbing 
Tabbing is the mechanism that allows anyone filling in an InForm 
document in Filler mode or InForm Filler, to move from one form element 
to another using the keyboard.  

The tab order, the default focus and the tab keys used to perform tabbing 
can be defined during the design process. 

NOTE: 
Only form elements that users can interact with have tabbing capability. 

Defining the Tab Order 

The tab order determines the order in which form elements are selected 
when a tabbing key is pressed. This order normally starts with the upper-
left interactive form element and ends with the lower-right. 

Select the page you would like to define the tab order of then click the 
Tab Order button, or click Element > Tab Order. Following this, a Tab 
Order dialog (Fig. 54) is opened where all interactive form elements for 
the current page are listed. 

 

Fig. 54 Tab Order dialog 

The order in which form elements appear in the list determines the tab 
order. This order is initially determined by the order in which the form 
elements were added to the page. 

EXAMPLE: 
If TextBox1 is added to a page, followed by RadioButton1, the default tab 
order is: 

1. TextBox1 

2. RadioButton1 
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Ordering Manually 

In the Tab Order dialog (Fig. 54), click a form element name to select it, 
then click the Up and Down buttons to move it up and down within the 
list. Repeat the process until all form elements are in the required order. 

Ordering Automatically 

In the Tab Order dialog (Fig. 54), click the Auto button to apply a tab order 
determined by InForm Designer. 

The automated tab order starts with form elements top left of the page, 
then right, then down, until the bottom right of the page is reached. 

Defining the Default Focus 

The default focus determines which form element is initially selected 
when an InForm document is opened or when a page is changed in Filler 
mode or InForm Filler.  

Select a page where you would like to apply a default focus then click the 
required form element name in the Default Focus property list box. 

Defining Tabbing Keys  

As the name suggests, tabbing is normally performed using the Tab key. 
When an InForm document is filled in using Filler mode or InForm Filler, 
each interactive form element responds to the Tab key as well as the Enter 
key and Up and Down arrow keys by default. 

If an InForm document contains text boxes that allow multiple lines of text 
to be typed, it may be preferable to turn off the ability to use the Enter key 
and Up and Down arrow keys for tabbing. This is because these keys are 
likely to be required when using this type of text box. 

To disable the Enter key and/or Up and Down arrow keys, Select a form 
element, open the Tab On property group then click the No option in the 
Enter Key and/or Up & Down Keys property value list boxes. 

To enable the Enter key and/or Up & Down arrow keys for tabbing, click 
the Yes option in the Enter Key and/or Up & Down Keys property value list 
boxes. 

NOTE: 
The Tab key is always used for tabbing and cannot be configured 
otherwise. 
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Defining Automated Tabbing Rules 

Normally, tabbing is invoked using the keyboard but when configured, 
the following actions also perform tabbing: 

• When the maximum characters have been typed in a form element. 
• When the decimal point is typed in a form element.  

To enable automated tabbing, select a form element, open the Tab On 
property group then click the Yes option in the Maximum Characters 
and/or Decimal Point property value list boxes. 

To disable automated tabbing, click the No option in the Maximum 
Characters and/or Decimal Point property value list boxes. 
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Creating HTML Forms 

In this section the following information is included: 

• Getting Started 
• HTML Form Elements 
• Validating 
• Specifying HTML File and Form Settings 
• Using a Submitted Page 
• Required Settings 
• Specifying a Save Location and Saving 
• Uploading  
• Using HTML Forms 
• Considerations 
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Getting Started 
InForm Designer can reproduce the content of an InForm document as a 
HTML form. The file the form is contained within can be placed on a Web 
server to enable users to view and fill it in using an Internet browser. 

An optional ASP or PHP submitted page can also be created to typically 
notify the user that the form has been successfully submitted, and email 
completed form content to one or more recipients. 

 

Fig. 55 Example InForm document and a corresponding HTML form 

To begin the process of creating a HTML form: 

• Create a new InForm document or open an existing one.* 
• Add and configure HTML form elements. 
• Add a page to the InForm document that will be used as the 

content of an ASP or PHP submitted page (optional) and add form 
elements such as labels and images. 

• Click the Export to HTML button, or click File > Export to HTML. 

Following this, the HTML Export dialog (Fig. 57) is opened where HTML 
form and file settings, and optional submit email settings are specified. 

*MORE: 
For details about the recommend method for creating a new InForm 
document that will be used to create a HTML form, refer to Creating HTML 
Forms > Getting Started > Recommended Method for Creating an InForm 
Document. 

Recommended Method for Creating an InForm Document 

When you create a new InForm document that will be used to create a 
HTML form, it is recommended you use one of the “safe” HTML form 
options available to the New option on the File menu, or a Create a “safe” 
HTML form task on the Welcome screen (Fig. 4). 

Selecting one of these options or tasks does the following: 
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• Creates a new InForm document that has a Web “safe” page size for 
the selected screen resolution (e.g. 800x600 pixels). 

• Displays the HTML plug-in palette to help ensure only HTML 
InForm Plug-ins are used for creating form elements. 

• Hides page margins. 

MORE: 
For further details about creating a new InForm document, refer to 
Getting Started > Creating a New Form. 
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HTML Form Elements 
HTML form elements are added to InForm documents using HTML InForm 
Plug-ins that appear on the HTML tab of the Plug-in palette. Furthermore, 
certain common InForm Plug-ins can also be used to create HTML form 
elements but certain properties are unsupported by HTML and are 
ignored. 

MORE: 
To find out if a property is supported by HTML, refer to the associated 
property within Appendix A: Properties. 

The following HTML form elements and associated HTML tags are 
supported, and the following InForm Plug-ins are used to create them: 

HTML Form Element HTML Tag InForm Plug-in(s) 

Button <button></button> 
Button 
HTML Button 

Check Box <input type=”checkbox”> 
Check Box 
HTML Check Box 

Date Field* <input type=”text”> 
Date Box 
HTML Date Box 

Email Field* <input type=”text”> 
Text Box 
HTML Email Text Box 

Hidden Field <input type=”hidden”>  HTML Hidden Field 

Image <img /> 
Image 
HTML Image 

Image Button <input type=”image”> HTML Image 

Label <label></label> 
Label 
HTML Label 

Numeric Field* <input type=”text”> 
Text Box 
HTML Numeric Text Box 

Password Field <input type=”password”> 
Text Box 
HTML Password Text 
Box 

Radio Button <input type=”radio”> 
Radio Button 
HTML Radio Button 

Select List <select></select> 
Combo Box 
HTML Combo Box 
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HTML Form Element HTML Tag InForm Plug-in(s) 

Text Area <textarea></textarea> 
Text Box 
HTML Text Area 

Text Field <input type=”text”>  
Text Box 
HTML Text Box 

Time Field* <input type=”text”> 
Time Box 
HTML Time Text Box 

*NOTE: 
The date field, email field, numeric field and time field are not true HTML 
form elements and therefore do not have a corresponding HTML tag. 
Instead they use the text field HTML tag and have validation automatically 
applied to them that reflects their use. 

NOTE: 
Due to HTML and Internet browser constraints, HTML form elements may 
not appear exactly as they do in a corresponding InForm document. 

MORE: 
For details about common InForm Plug-ins that are unsupported by 
HTML, refer to Creating HTML Forms > Considerations When Creating 
HTML Forms > Unsupported InForm Plug-ins. 

MORE: 
For details about properties that are unsupported by HTML, refer to 
Creating HTML Forms > Considerations When Creating HTML Forms > 
Unsupported Properties. 

MORE: 
For further details about HTML form tags and associated attributes, refer 
to the following Web page: 

http://www.w3schools.com/tags/default.asp 

http://www.w3schools.com/tags/default.asp
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Validating 
HTML form elements normally have validation properties to help ensure 
their content is valid prior to submission. Each of these properties is 
contained in a Validation property group within the Property Inspector. 

Alternatively, certain HTML form elements such as the date field, email 
field, numeric field and time field, have validation automatically applied to 
them that reflects their use. 

EXAMPLE: 
The email field is checked to see if it contains an email address. 

MORE: 
For details about applying validation and associated error messages to 
HTML form elements, refer to Working with Form Elements > Applying 
Validation. 

Notifying Users 

If validation for one or more HTML form elements is not satisfied, a 
Validation Failed dialog (Fig. 56) is presented to the user immediately after 
clicking the submit button, and the form content is not submitted until 
corrections are made.  

 

Fig. 56 Validation Failed dialog (HTML)  

When a user clicks the OK button, the Validation Failed dialog closes so 
corrections to the specified HTML form elements can be made. 
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Specifying HTML File and Form Settings 
The HTML Export dialog Form tab (Fig. 57) enables you to configure HTML 
file and form options. 

 

Fig. 57 HTML Export dialog Form tab 

The following HTML file and form settings are provided: 

Setting Option(s) / Value(s) Description Required 
HTML Tag / 
Attribute 

File Name 
filename.htm or 
filename.html 
(No path) 

Determines the file name of the 
HTML form file. 

Yes n/a 

Title Title 
Determines the Title of the HTML 
form file.  

No <title></title> 

Form Name 
Name 
(No spaces) 

Determines the name of the HTML 
form within a HTML form file. 

No name=”” 

Method 
Get 
Post (default) 

Determines how form data is 
submitted.* 

Yes method=”” 
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Setting Option(s) / Value(s) Description Required HTML Tag / 
Attribute 

Action 

File name of ASP/PHP 
submitted page 
URL of ASP/PHP submitted 
page 
mailto 
JavaScript function call 

Determines where form data is 
submitted.* 
If the ASP Email option or the PHP 
Email option is selected for the 
Submit Action setting, the value 
must be the file name or URL of 
the ASP or PHP submitted page. 

Yes action=”” 

Target 

_blank 
_self 
_parent (default) 
_top 

Determines where the ASP or PHP 
submitted page specified in the 
Action property is opened. 

Yes target=”” 

Encryption 

application/x-www-form-
urlencoded (default) 
multipart/form-data 
text/plain 

Determines how form data is 
encoded before submitting it to 
the Web server. 

Yes enctype="" 

Submit 
Button 

Form element name 
Determines what button or image 
is used to submit the HTML form. 

Yes 
<input 
type=”submit”> 

Reset Button Form element name 
Determines what button or image 
is used to reset a HTML form. 

No 
<input 
type=”reset”> 

Submit 
Action 

None (default) 
ASP Email* 
PHP Email* 

Determines what happens 
following submission of the HTML 
form.* 
*Selecting the ASP Email or PHP 
Email option causes remaining 
Submit Action settings to become 
accessible. 

Yes n/a 

Title Title 
Determines the Title of the ASP or 
PHP submitted page.  

No <title></title> 

After Submit  
Display Text (default) 
Display Project Page 

Determines whether the content 
of the Display Text setting or an 
InForm document page is used as 
content for the ASP or PHP 
submitted page. 

No n/a 

Display Text 
Text 
Thank you for your 
submission.(default) 

Determines the text that will be 
used as content for the ASP or 
PHP submitted page if the Display 
Text option is selected for the 
After Submit setting. 

No n/a 
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Setting Option(s) / Value(s) Description Required HTML Tag / 
Attribute 

Project Page Page number 

Determines the page in the 
InForm document that will be 
used as content for the ASP or 
PHP submitted page if the Display 
Project Page option is selected for 
the After Submit setting. 

No n/a 

MORE: 
For further details about HTML tags and associated attributes, refer to the 
following Web page: 

http://www.w3schools.com/tags/default.asp 

*NOTE: 
When a user clicks the submit button of a HTML form, form data is not 
submitted until validation is satisfied for applicable HTML form elements. 

http://www.w3schools.com/tags/default.asp
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Using a Submitted Page 
It is common to open a Web page after a HTML form is successfully 
submitted. This page normally thanks the user and/or confirms 
submission of the form, and performs an action such as emailing 
completed form content. InForm Designer provides an option to create an 
ASP or PHP submitted page which serves this purpose. 

Click the ASP Email or the PHP Email option for the Submit Action setting 
in the HTML Export dialog Form tab (Fig. 57) to access the settings 
required to configure an ASP or PHP submitted page. The option you 
choose is dependent upon the Web server the HTML form will be stored 
on.  

NOTE: 
When a user clicks the submit button of a HTML form, the ASP or PHP 
submitted page is not opened, and emails are not sent to recipients until 
validation is satisfied for applicable form elements. 

Specifying Content 

The content of an ASP or PHP submitted page is determined in one of the 
following ways: 

• From content derived from a page in the InForm document. 
• From content defined for the Display Text setting in the HTML 

Export dialog Form tab (Fig. 57). 

Using a Page in the InForm Document 

Any page within an InForm document can be used to determine the 
content of an ASP or PHP submitted page. 

EXAMPLE: 
Page 1 of an InForm document could be used to define the HTML form, 
and page 2 could be used to define the page content of an ASP or PHP 
submitted page.  

Click the Submitted Page drop-down list in the HTML Export Form tab 
(Fig. 57) then select the required page number. 

NOTE: 
Unlike other pages within an InForm document, the selected page is not 
included in the creation of the HTML form file. 

NOTE: 
Actions associated with interactive HTML form elements such as text fields 
are ignored if they are included within an InForm document page that will 
be used to define the content of an ASP or PHP submitted page. 
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MORE: 
For details about using the submitted content of certain HTML form 
elements as the Default Text property value of labels, refer to Creating 
HTML Forms > Using a Submitted Page > Including the Content of HTML 
Form Elements. 

Specifying Display Text 

If you prefer not to use a page within an InForm document to create the 
content of an ASP or PHP submitted page, text can instead be defined. 
This text is used as the Body tag content of the ASP or PHP submitted 
page. 

Ensure that the ASP Email or PHP Email options are selected in HTML 
Export Form tab (Fig. 57) then click the Display Text radio button to select 
it (add a dot). Now specify the text you would like to appear on the ASP or 
PHP submitted page within the Display Text edit box, or leave the default 
“Thank you for your submission” text.  

MORE: 
For details about including the submitted content of certain HTML form 
elements as display text, refer to Creating HTML Forms > Using a 
Submitted Page > Including the Content of HTML Form Elements. 

Specifying Email Settings 

The ASP or PHP submitted page can be configured to email an optional 
message and the content of certain submitted form elements to one or 
more recipients. 

The HTML Export dialog Submit Email(s) tab (Fig. 58) is where the 
recipient(s) and content of one or more emails are specified. 



Creating HTML Forms 

130 InForm Designer User Guide 

 

Fig. 58 HTML Export dialog Submit Email(s) tab 

The following email settings are provided: 

Settings Option(s) / Value(s) Description Required 

From 
Email address(es) 
Form element Name 
property value(s) 

Determines the email address(es) where 
email 1 and email 2 are sent from. 

Yes  
(email 1 and/or 

email 2) 

To 
Email address(es) 
Form element Name 
property value(s) 

Determines the email address(es) where 
email 1 and email 2 are sent. 

Yes 
(email 1 and/or 

email 2) 

CC 
Email address(es) 
Form element Name 
property value(s) 

Determines the email address(es) where 
email 1 and email 2 are copied. 

No 

BCC 
Email address(es) 
Form element Name 
property value(s) 

Determines the email address(es) where 
email 1 and email 2 are blind copied. 

No 

Subject 
Subject 
Form element Name 
property value(s) 

Determines the subject of email 1 and 
email 2. 

No 
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Settings Option(s) / Value(s) Description Required 

Body 
Body 
Form element Name 
property value(s) 

Determines the body of email 1 and email 
2. 
Note: Body content is plain text. 

No 

Use custom SMTP 
settings 

Yes (Tick) 
No (Blank) (Default) 

Determines whether custom SMTP server 
settings are used. Selecting Yes causes the 
settings below to become accessible. 

n/a 

Name or IP Address* 
Name or IP address 
(Default = LocalHost) 

Determines the name or IP address of the 
SMTP server that processes the email(s). 

Yes  
(If the Use Custom 

SMTP Settings 
property is set to 

Yes) 

Port* 
Port number 
(Default = 25) 

Determines the port number of the SMTP 
server that processes the email(s). 

Yes 
(If the Use Custom 

SMTP Settings 
property is set to 

Yes) 

Send Using* 
Number 
(Default = 2) 

Determines the send using parameter 
required by the SMTP server that processes 
the email(s).  

Yes 
(If the Use Custom 

SMTP Settings 
property is set to 

Yes) 

*MORE: 
For further details about SMTP server settings, contact your Web server 
hosting company. 

MORE: 
For details about including the submitted content of certain HTML form 
elements within certain email settings, refer to Creating HTML Forms > 
Using a Submitted Page > Including the Submitted Content of HTML Form 
Elements. 

Specifying Multiple Email Addresses 

More than one email address can be defined for the From, To, CC and BCC 
email settings by separating each email address with a semicolon (;). 

EXAMPLE: 
info@flysoftware.com;support@flysoftware.com 

Including the Submitted Content of HTML Form Elements 

The submitted content (i.e. what the user has filled in) of compatible 
HTML form elements can be displayed on the ASP or PHP submitted page, 
or used to populate certain components of an email. This is achieved by 
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prefixing the Name property value of a compatible HTML form element 
with #! then applying it to the following: 

• The Default Text property value of a label on the InForm document 
page that will be used as an ASP or PHP submitted page. 

• The Display Text edit box on the HTML Export Form tab (Fig. 57). 
• A From, To, CC, BCC, Subject or Body email setting on the HTML 

Export dialog Submit Email(s) tab (Fig. 58). 

EXAMPLE: 
#!FormElementName 

EXAMPLE: 
If a label on the submitted page needed to display the submitted content 
of a text field with a Name property value of FullName, then the Default 
Text property value of the label would be #!FullName. 

Multiple Name property values together with normal text can be added to 
labels, display text and email settings. 

EXAMPLE: 
If the content of a text field with a Name property value of NameTextBox, 
and a text field with a Name property value of AgeTextBox need to be 
included in the body of an email, the following is defined in the Body 
setting: 

Full Name: #!NameTextBox 
Age: #!AgeTextBox 

This would produce text similar to the following in the body of the email: 

Full Name: John Smith 
Age: 48 

Dealing with Radio Buttons 

Radio buttons are normally part of a radio button group (i.e. their Group 
ID property value is set to the same number). As a result only a single radio 
button from the same group is selectable at any one time. For this reason, 
the Group ID property value is appended to #!GroupID as follows: 

#!GroupIDn 

EXAMPLE: 
Three radio buttons have a Group ID property value of 1. The following 
would therefore be specified as content for an email component or as 
content on a submitted page: 

#!GroupID1 
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The submitted content is the Submit Value property value of the selected 
radio button in a group. 

EXAMPLE: 
The following radio buttons all have a Group ID property value of 2 and 
have the following Submit Value property values: 

DogRadio Dog 
CatRadio Cat 
PigRadio Pig 

The following is specified as content for the Body setting of an email: 

#!GroupID2 

If the CatRadio radio button was selected, the following would appear in 
the body of the email: 

Cat  

Compatible HTML Form Elements 

The content of the following HTML form elements can be displayed on the 
ASP or PHP submitted page, or used to populate certain components of 
an email: 

• Check Box 
• Date Field 
• Email Field 
• Hidden Field 
• Numeric Field 
• Password Field 
• Radio Button* 
• Select List 
• Text Area 
• Text Field 
• Time Field 

*MORE: 
For details about how radio buttons are handled, refer to Creating HTML 
Forms > Using a Submitted Page > Including the Submitted Content of 
HTML Form Elements > Dealing with Radio Buttons. 

Selecting HTML Form Elements 

A quick and easy way to add a compatible HTML form element to an email 
setting or display text within the HTML Export dialog (Fig. 57) is to use the 
Specify Content dialog (Fig. 59) which is opened by double-clicking an 
email setting edit box or the Display Text edit box. 



Creating HTML Forms 

134 InForm Designer User Guide 

 

Fig. 59 Specify Content dialog (Body (Email 1))  

The memo box on the left of the Specify Content dialog is the area where 
the content of the associated email setting or display text is defined. 

The list box to the right of the Specify Content dialog contains the Name 
property values of compatible HTML form elements, or a group identifier* 
for radio button groups.  

Click a HTML form element or the group identifier of a radio button group 
in the list to add it to the memo box where the text cursor is currently 
positioned. 

Alternatively, hold the Alt button then move the mouse pointer over a 
compatible HTML form element in the InForm document. When the cursor 
changes to a hand, click the form element to add it to the memo box. 

When the content of an email setting or display text is defined, click the 
OK button to close the Specify Content dialog and return to the HTML 
Export dialog. 

Click the Cancel button to cancel all additions and changes, close the 
Specify Content dialog then return to the HTML Export dialog. 

*NOTE: 
A group identifier for a radio button group is displayed as follows: 

#!GroupIDn (RadioButton1, RadioButton2, etc) 

*MORE: 
For further details about how radio buttons are handled, refer to Creating 
HTML Forms > Using a Submitted Page > Including the Submitted 
Content of HTML Form Elements > Dealing with Radio Buttons. 
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Required Settings 
Prior to specifying a save location for a HTML form and its associated files, 
required settings must be specified in the HTML Export Form tab (Fig. 57) 
and (if applicable) the HTML Export Submit Email(s) tab (Fig. 58). If not, an 
Incomplete Settings dialog (Fig. 60) is opened prompting you to do this. 

 

Fig. 60 Incomplete Settings dialog 

Click the OK button to close the dialog and return to the HTML Export 
dialog. 
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Applying Settings 
If, while configuring file, form and submit email settings, you wish to 
return to the InForm document (i.e. close the HTML Export dialog (Fig. 57)) 
but retain the settings already made, click the Apply button. Following 
this you can safely click the Close button to close the HTML Export dialog 
and the settings will be present when it is opened again. 
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Specifying a Save Location and Saving 
When file, form and optional submit email settings have been specified, 
the HTML form file, any image files used within it, and the ASP or PHP 
submitted page (if configured) must be saved. 

Click the Continue button in the HTML Export dialog (Fig. 57) to open a 
Browse for Folder dialog (Fig. 61) where the save location of the file(s) is 
specified. 

 

Fig. 61 Browse for Folder dialog (HTML)  

Click the OK button to save the file(s) or click the Cancel button to cancel 
the save. 

If one or more files with the same name already exist, a Confirm Overwrite 
dialog (Fig. 62) is opened asking whether you wish to overwrite the file. 

 

Fig. 62 Confirm Overwrite dialog (HTML)  

Click the Yes button to overwrite the existing file or the No button to 
cancel the save. 

When the file(s) are successfully saved, an Export Successful dialog (Fig. 
63) is opened notifying you of this. 
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Fig. 63 Export Successful dialog 

Click the OK button to close the dialog and return to the InForm 
document. 

Files that are Created 

When exporting an InForm document to HTML, the following files are 
created: 

• HTML form file, e.g. contact_us.html. 
• ASP or PHP submitted page (if configured), e.g. 

contact_us_submitted.php. 
• Images used in the HTML form file and the ASP or PHP submitted 

page. 
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Uploading Files 
Before a HTML form can be opened in an Internet browser and filled in, 
the associated HTML form file, along with the optional ASP or PHP 
submitted page and all associated image files must be uploaded to a Web 
server. 

NOTE: 
If an ASP or PHP submitted page is used, the Web server must have ASP or 
PHP scripts enabled. 

MORE: 
For details about uploading to a Web server, refer to the documentation 
or Help provided by your Web server hosting company. 
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Using HTML Forms 
When a HTML form and its associated files are uploaded to a Web server, 
the HTML form can be accessed by specifying the name of the domain 
followed by the name of the associated HTML form file in the address bar 
of an Internet browser. 

EXAMPLE: 
If a HTML form file called contact_form.html was located within the root 
folder of a domain called flysoftware.com, it would be opened by 
specifying the following: 

http://www.flysoftware.com/contact_form.html 
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Considerations 
When designing InForm documents that will be used to create HTML 
forms, it is important to consider the following: 

• Fonts 
• Images 
• Number of Pages 
• Page Size 
• Unsupported InForm Plug-ins 
• Unsupported Properties 
• Validation 

Fonts 

If a HTML form contains a font that the user of the form does not have 
installed on their computer, any text that uses the font is displayed in a 
default font and may not appear as intended. It is therefore advised the 
following fonts that are supported as standard by PC and MAC computers 
are used when designing HTML forms:  

• Arial 
• Arial Black 
• Comic Sans 
• Courier 
• Courier New 
• Georgia 
• Helvetica 
• Impact 
• Palatino 
• Times New Roman 
• Trebuchet 
• Verdana 

Images 

The file size of HTML files and associated assets should be kept to an 
absolute minimum so the page opens as quickly as possible in an Internet 
browser. One of the most effective ways to accomplish this is to condition 
images that will appear in the HTML file and optional ASP or PHP 
submitted page prior to including them in your InForm document. It is 
therefore advised you perform the following in an image editing 
application such as Paint or Photoshop: 

• Set the resolution of the image to 96dpi (ppi). This is the display 
resolution used by most computer screens (although Apple Mac 
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uses 72dpi (ppi)), and setting an image resolution any higher than 
this causes the file size to be bigger than necessary. 

• Set the pixel width and height of the image to the exact size you 
want it to appear within the HTML file or ASP or PHP submitted 
page. Subsequently, when the image is used within an InForm 
document, the Width and Height property values should be set to 
the same size. Doing this means the image file size is kept to a 
minimum. 

• Set the color mode of the image to RGB. Normally this reduces the 
file size compared to other color modes such as CMYK. 

• Save the image as a GIF, PNG or JPG. These image formats are best 
suited for inclusion within a HTML file or ASP or PHP submitted 
page because they normally have smaller file sizes compared to 
other image formats such as BMP and TIF. 

Number of Pages 

If an InForm document contains multiple pages, all pages are combined 
when an associated HTML form is created, and appear as one page (that 
contains a single form) when viewed in an Internet browser. 

NOTE: 
A page that has been indicated for use as the ASP or PHP submitted page, 
is not included as part of the HTML form. 

To help you ascertain how HTML forms appear in an Internet browser, it is 
advised associated InForm documents are designed on a single page that 
adheres to documented page size constraints. 

Page Size 

It is considered good practice that horizontal scroll bars do not appear on 
Web pages when they are viewed in a maximized Internet browser. 
Therefore, when designing InForm documents that will be used to create 
HTML forms, it is important to consider the page width. 

These days it is common for computer screen resolutions to be 800x600 
pixels or above. Therefore, in order to prevent horizontal scroll bars from 
appearing on HTML forms, it is advised the width of an InForm document 
page does not exceed the recommended Web “safe” page size width. As 
long as form elements appear within the boundary of the page, horizontal 
scroll bars will not appear all the while the Internet browser is maximized. 

Specifying a specific height for an InForm document page is not so critical 
because vertical scroll bars within Web pages are acceptable and common 
place.  
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Web “Safe” Page Sizes 

Below are Web “safe” page sizes for various screen resolutions: 

Screen Resolution 
(Width x Height) 

Safe Pixels (px) 
(Width x Height) 

Safe Millimeters (mm) 
(Width x Height) 

640x480 600 x 300 158 x 79 

800x600 760 x 410 200 x 108 

1024x768 955 x 600 252 x158 

 

The easiest way to create an InForm document with a Web “safe” page 
size, is to select one of the Web “safe” options associated with the New 
option on the File menu, or a Web “safe” task on the Welcome screen (Fig. 
4). Doing this creates a new InForm document with the selected “safe” 
page size already specified. 

Unsupported InForm Plug-ins 

The following common InForm plug-ins are unsupported by HTML: 

• Calculation Box 
• Shape 

NOTE: 
When designing a HTML form, it is advised you use the HTML InForm Plug-
ins available on the HTML tab of the plug-in palette. This helps to ensure 
only form elements supported by HTML are used. 

Calculation Box 

Functionality associated with the Calculation Box plug-in is unsupported 
by HTML. As such, if a calculation box appears within an InForm 
document, the form element behaves like a text box (<input type=”text”>) 
within the associated HTML form. 

Shape 

Shapes added to InForm documents using the Shape plug-in do not 
appear on HTML forms. Instead, images (added using the Image plug-in or 
HTML Image plug-in) should be used within an InForm document to 
replicate the shapes required. 
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Unsupported Properties 

Certain InForm Plug-in properties that do not have an equivalent HTML 
tag or attribute are unsupported and are ignored when a HTML form is 
created. 

NOTE: 
When designing a HTML form, it is advised you use the HTML InForm Plug-
ins available on the HTML tab of the plug-in palette. This ensures only 
HTML supported properties are available and used. 

MORE: 
To find out if a property is supported by HTML, refer to the associated 
property within Appendix A: Properties. 

Validation 

To help prevent users submitting inaccurate or incomplete HTML forms, it 
is important to apply validation. 

Applying validation can also help to prevent automated processes that 
visit your websites from submitting a HTML form that contains no data, or 
data of no importance. 

MORE: 
For further details about validation, refer to Creating HTML forms > 
Validating, and Working with Form Elements > Applying Validation. 
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Common InForm Plug-ins 

In this section the following common InForm Plug-ins are described: 

• Button 
• Calculation Box 
• Check Box 
• Combo Box 
• Date Box 
• Image 
• Label 
• Radio Button 
• Shape 
• Text Box 
• Time Box 

MORE: 
For details about HTML InForm Plug-ins, refer to HTML InForm Plug-ins. 
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Button 
To improve accessibility and allow certain application functionality to be 
performed within an InForm document, buttons (Fig. 65) can be added 
using the Button plug-in (Fig. 64). 

 

Fig. 64 Button plug-in button/icon 

   

Fig. 65 Example buttons 

A single button can be used to perform one or multiple actions such as 
page navigation, emailing and URL access when in Filler mode or InForm 
Filler. 

HTML TIP: 
Use the HTML Button plug-in to add form submit and reset buttons to an 
InForm document that will be exported to HTML. The HTML Image plug-in 
can also be used to create form submit buttons. 

MORE: 
For details about adding, selecting, moving, resizing and styling a button, 
refer to Working with Form Elements. 

Actions 

The following actions can be applied to a button: 

Action Description 

Open 

Opens a specified InForm document or opens the 
Open dialog (Fig. 18) where InForm documents can 
be selected and opened. 
Prior to opening, the Save dialog is opened if 
changes have been made since it was last saved. 

Close 
Closes the InForm document. 
Prior to closing, the Save dialog is opened if 
changes have been made since it was last saved. 

Save Saves the InForm document. 

Save As 
Saves the InForm document using a specified file 
name, or opens a Save As dialog where a file name 
and location can be specified before saving. 
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Action Description 

Print 
Prints the InForm document using the default 
printer, or opens the Print dialog. 

Exit 
Exits InForm Designer or InForm Filler. 
Prior to exiting, the Save dialog is opened if changes 
have been made since it was last saved. 

(View) Actual Size Resizes the view of the current page to actual size. 

(View) Fit to Width 
Resizes the view of the current page to fit the width 
of the application window. 

(View) Fit to Page 
Resizes the view of the current page to fit entirely 
within the application window. 

Reset Form 
Resets the content of applicable form elements 
within the InForm document to a default value or 
state. 

Validate Form 

Validates the content of applicable form elements 
within the InForm document, and if one or more 
fail, opens the Validation Failed dialog (Fig. 23). 
For further information about validating forms, refer 
to Getting Started > Validating Forms and Working 
with Form Elements > Applying Validation. 

First Page Displays the first page of the InForm document. 

Next Page Displays the next page of the InForm document. 

Previous Page 
Displays the previous page of the InForm 
document. 

Last Page Displays the last page of the InForm document. 

Goto Page 
Displays a specified page in the InForm document, 
or opens a dialog prompting for a page number. 

Hyperlink To URL 
Opens the default Internet browser and displays the 
content of a specified URL, or opens a dialog where 
a URL can be specified then opened. 

Post To URL 

Posts information contained in one or more 
specified form elements to a URL, and if necessary 
returns and display response data in a dialog or 
form element. 
For further information, refer to Common InForm 
Plug-ins > Button > Post To URL. 
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Action Description 

Email 

Emails a message and optional attachments 
(including the current InForm document) to a pre-
determined email account. Alternatively it opens an 
Email dialog or the default email client where email 
details such as To, Subject and Body can be 
specified.  
For further information, refer to Common InForm 
Plug-ins > Button > Email. 

Execute Application 
Launches a specified application or opens a dialog 
where an application can be specified then 
launched. 

HTML TIP: 
All actions applied to a button are ignored. Instead, any button that 
appears in an InForm document can be selected within the HTML Export 
dialog (Fig. 57) for use as a submit or reset button. 

Applying Actions 

To apply one or more actions to a button, double-click its placeholder. 
Following this, an Actions dialog (Fig. 66) is opened where actions can be 
selected, configured, added, prioritized, deleted and modified.  

 

Fig. 66 Actions dialog (default state)  

Click the OK button to close the Actions dialog and apply the action(s) 
displayed in the Perform panel. 

Click the Cancel button to close the Actions dialog and cancel any actions 
recently configured. 

Selecting 

All available actions are contained in the Action drop-down list. 
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To select an action, click the Action drop-down list then click the required 
action. 

Configuring 

Certain actions must have one or more options configured so they 
operate in the way they were intended. 

EXAMPLE: 
If you required a button to open a Web page in an Internet browser, you 
would need to specify the URL of the web page for the Hyperlink to URL 
action. 

If an action has configuration options, each appears at the bottom of the 
Actions dialog (Fig. 66) following selection of the action. 

Adding 

Any action you wish to apply to a button must be added to the Perform 
panel. 

Click the Add button to add the name of the selected action to the 
Perform panel. 

NOTE: 
If an action is added that would negate another action (i.e. First Page and 
Next Page), the action that appears first in the Perform panel is only used 
when the button is clicked. 

Prioritizing 

Multiple actions that appear in the Perform panel can be prioritized. 

The action at the top is performed first and the action at the bottom last. 

Click the action you wish to prioritize then click the Up button to move it 
up, or the down button to move it down within the Perform panel.  

NOTE: 
Actions are not performed if they follow an Open, Close or Exit action, or if 
they negate another action, i.e. First Page and Next Page. 

Deleting 

To delete an action contained in the Perform panel, click its name then 
click the Delete button. 

Modifying 

To modify an action contained in the Perform panel, click its name, make 
the necessary changes to the configuration options that appear at the 
bottom of the Actions dialog (Fig. 66) then click the Modify button. 
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Including a Post-click Dialog 

Prior to performing one or more actions associated with a button, it may 
be useful to open a dialog to allow the user to confirm they wish to 
proceed, or display additional information or a warning.   

To include a dialog that appears immediately after a button is clicked, 
select a button, open the Confirmation property group, then click the Yes 
option in the Confirmation Dialog property value list. 

NOTE: 
The dialog appears before other dialogs associated with actions defined 
for a button. 

MORE: 
For details about the dialogs that can appear after clicking a submit 
button or a validate form button on a form that contains validation errors, 
refer to Getting Started > Validating Forms. 

Specifying Content 

To specify the text contained in a post-click dialog and its title bar, 
together with its icon and buttons, use the Text, Title, Icon and Buttons 
properties contained in the Confirmation property group. 

MORE: 
For details about specifying the content of the Validation Failed dialog 
(Fig. 24) that appears after clicking the submit button on a HTML form that 
contains validation errors, refer to Creating HTML Forms > Validation > 
Notifying the Form Filler > Specifying Error Messages. 

Action Dialogs 

Certain actions you can apply to a button have an optional default dialog 
associated with them that can appear when the button is clicked in Filler 
mode or InForm Filler. 

EXAMPLE: 
If the Print action is applied to a button, the default Print dialog is opened 
by default when the button is clicked. 

Each action with an associated dialog has a Use Dialog checkbox within 
the Actions dialog (Fig. 66). Removing the tick from this checkbox 
prevents the dialog being opened and causes configuration options 
displayed in the Actions dialog to be used. 

EXAMPLE: 
If the tick is removed from the Print action’s Use Print Dialog checkbox, 
the Print dialog is not opened and the page range and the number of 
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copies defined in the Actions dialog are used when printing the InForm 
document. 

Adding an Image 

It is common for buttons within applications or on websites to be 
represented by an image of the action they perform. 

EXAMPLE: 
A print button is sometimes represented by an image of a printer. 

To apply an image to a button, select a button, open the Image property 
group then double-click the File Name property value edit box. Following 
this, an Image File dialog (Fig. 81) is opened where you can select a 
supported image from your file system. 

Following selection of an image, click the Open button to add the image 
to the button placeholder. 

Supported Image Formats 

The following image formats can be added to a button: 

• BMP 
• EMF 
• GIF 
• ICO 
• JPEG/JPG 
• PNG 
• WMF 

Positioning and Resizing 

By default, an image is positioned to the left of the button placeholder 
and is 16 x 16 pixels in size. 

To position and resize an image, use the Position, Width and Height 
properties contained in the Image property group. 

Using as a Background 

Perform the following actions to add an image as a button background 
(meaning text applied using the Default Text property appears on top): 

• Select a button. 
• Open the Image property group. 
• Click the Background option in the Position property value list.  
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Applying a 3D Effect 

It is common for buttons within web pages and applications to appear 
raised. 

To “raise” a button by adding a bevel around its edge, select a button, 
open the General property group then click the Yes option in the 3D 
property value list.  

HTML TIP: 
The 3D effect is ignored. However, adding a button without a border or fill 
causes the button to appear as a standard browser button that normally 
contains a 3D effect when it appears within a HTML form. 

Button Animation 

By default, when a button is clicked in Filler mode or InForm Filler, a “push 
down” animation is performed to simulate the action of pressing a real 
button. 

To remove the “push down” animation, select a button, open the General 
property group then click the No option in the Allow Down property value 
list. 

HTML TIP: 
The “push down” animation for buttons is always performed when they 
appear within a HTML form. 

Post To URL 

The Post To URL action posts information contained in one or more 
specified form elements to a URL, and if necessary returns and displays 
response data in a dialog or form element. 

Post To URL configuration options are detailed below. 

Configuration Option Description 

URL 
Determines the URL where specified form 
elements are posted. For example: 
http://www.flysoftware.com/test.asp 
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Configuration Option Description 

Available Fields 

Lists all form elements within the InForm 
document that could be posted to the specified 
URL. 
A form element can be removed from the 
Available Fields panel and moved to the Fields 
To Send panel by clicking its name then clicking 
the Add (>) button. 

Fields To Send 

Lists all form elements in the InForm document 
that will be posted to the specified URL. 
A form element can be removed from the Fields 
To Send panel and moved to the Available Fields 
panel by clicking its name then clicking the 
Remove (<) button. 
Variable names that can be referenced and used 
in the post URL match the names of form 
elements specified in the Fields To Send panel. 

Response Field 
Determines the name of the form element in the 
InForm document that displays post response 
data (if any). 

Respond With Dialog 
Determines whether a dialog is opened that 
contains post response data (if any). 

Strip HTML Tags 
Determines whether HTML tags normally 
contained in post response data are removed. 

HTML TIP: 
The button that will be used to submit (post) the content of a HTML form 
is determined in the HTML Export dialog (Fig. 57) and the above options 
are ignored. 

Email 

The Email action emails a message and optional attachments (including 
the current InForm document) to a pre-determined email account. 
Alternatively, it opens an Email dialog or the default email client where 
email details such as To, Subject and Body can be specified.  

Email configuration options are detailed below. 

Configuration Option Description 

Host* 

Determines the host of the email account that is 
used to send an email. 
If unspecified and the Use Dialog option is not 
selected, the default email client is launched. 
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Configuration Option Description 

User ID* 
Determines the user ID of the email account that 
is used to send an email.  

Password* 
Determines the password of the email account 
that is used to send an email.  

Hide 
Determines whether the Host, User ID and 
Password fields appear in the Email dialog. 

From 
Determines the email address that an email is 
sent from. For example: 
info@flysoftware.com 

Subject Determines the subject of an email. 

To 
Determines the email address(es)^ an email is 
sent to. For example: 
j.smith@flysoftware.com  

CC 
Determines the carbon copy email address(es)^ 
an email is sent to. For example: 
j.smith@flysoftware.com 

BCC 
Determines the blind carbon copy email 
address(es)^ an email is sent to. For example: 
j.smith@flysoftware.com 

Attach 

Determines the file or files that are attached to 
an email. 
Click the plus (+) button to open an Attach 
dialog where a file can be selected. Click the 
Open button in the Attach dialog to add the 
associated file to the Attach drop-down list.  
Files can be removed from the Attach drop-
down list by clicking them then clicking the cross 
(X) button. 

Attach current InForm 
document 

Determines whether the current InForm 
document is attached to the email. 

Body 
Determines the message body of an email. 
NOTE: Message body content is plain text when 
emailed using InForm. 

Use Dialog 
Determines whether the Email dialog is opened, 
or if the default email client is launched (if Host is 
unspecified). 

*CAUTION: 
It is strongly advised you do not specify the Host, User ID and Password 
settings if your form will be used by anyone other than yourself or will be 
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made available to anyone outside your organisation. This is because the 
information supplied is not secure and may become accessible by 
unauthorised users. 

^NOTE: 
Multiple email addresses can be specified by separating them with a semi-
colon. 

EXAMPLE: 
john.smith@flysoftware.com;emily.jones@flysoftware.com 

HTML TIP: 
Options to email HTML form content to one or more recipients are 
provided in the HTML Export dialog (Fig. 57), and the above options are 
ignored. 

Using the Default Email Client 

To launch the default email client instead of emailing directly from 
InForm, leave the Host configuration option blank then click the Use 
Dialog checkbox until its tick is removed. 

NOTE: 
The content of To, CC, BCC, Subject and Body configuration options is 
used to pre-populate corresponding fields within the default email client. 

Properties 

The Button plug-in has the following properties: 

Name 
Actions 
+Confirmation 

Confirmation Dialog 
Title 
Icon 
Text 
Buttons 

+Image 
File Name 
Position 
Width (Pixels) 
Height (Pixels) 

+General 
Lock 
Hint 
Default Text 
3D 
Allow Down 
Publish 

+Position & Size 

mailto:john.smith@flysoftware.com;emily.jones@flysoftware.com


Common InForm Plug-ins  

156 InForm Designer User Guide 

Left 
Top 
Width 
Height 

+Border 
Width 
Color 
Publish 

+Fill 
Color 
Transparent 
Publish 

+Pad 
Top 
Right 
Bottom 
Left 

+Character 
Font 
Size 
+Style 

Bold 
Italic 
Underlined 
Strikethrough 
Upper Case 

Color 
+Paragraph 

Horizontal Alignment 
Vertical Alignment 

+Tab On 
Enter Key 
Up & Down Keys 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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Calculation Box 
If numerical form data needs to be calculated, you can help users save 
time and prevent errors by automatically performing the calculations for 
them. This is achieved by applying math expressions to a calculation box 
(Fig. 68) using the Calculation Box plug-in (Fig. 67).  

 

Fig. 67 Calculation Box plug-in button/icon 

 

Fig. 68 Example calculation box 

A common use is to define an expression to add the contents of two or 
more text boxes to determine a total displayed in your InForm document.  

HTML TIP: 
When calculation boxes appear within a HTML form they behave like text 
boxes and any expressions applied are ignored. 

MORE: 
For details about adding, selecting, moving, resizing and styling a 
calculation box, refer to Working with Form Elements. 

Defining Expressions 

To define an expression, add a calculation box to a page then double-click 
its placeholder. Following this, an Expression dialog (Fig. 69) is opened 
where form elements, math symbols, math functions, and numerical 
values can be added. 
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Fig. 69 Expression dialog 

The Fields Box 

By default, the Fields box at the top of the Expression dialog (Fig. 69) lists 
(in alphanumerical order) all form elements that have been configured to 
allow only numbers. This includes the calculation box being configured 
and all others found in the InForm document. 

MORE: 
For details about configuring form elements to allow only numbers, refer 
to Working with Form Elements > Manipulating Numbers > Allowing Only 
Numbers. 

NOTE: 
The appearance of all form elements is indicated by the All button above 
the Fields box being selected. 

 If you wish to display only form elements from a particular page within 
the Fields box, click the required page number button within the dialog. 

The Expression Box 

The Expression box at the bottom of the Expression dialog is where 
expressions for the associated calculation box are defined.  

EXAMPLE: 
If the values of TextBox1 and TextBox2 need to be added together and 
then have 50 subtracted, the following expression would be defined 
within the expression box: 

TextBox1 + TextBox2 - 50 
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Adding Form Elements 

After positioning the text cursor in the Expression box where you would 
like a form element name to appear, a form element can be added in any 
of the following ways: 

• Type the name directly into the Expression box. 
• Double-click* the required name in the Fields box. 
• Press and hold the CTRL and ALT keys and double-click* the 

required form element on the page. 

*NOTE: 
A single-click also adds a form element name to the Expression box. 
However, the name is highlighted (selected) in the Expression box, 
meaning it is overwritten if another form element is selected or something 
is typed. 

Adding Math Symbols and Functions 

Common math symbols and functions can be used to make up an 
expression. 

Position the text cursor within the expression box where you would like a 
math symbol to appear then click the associated symbol on the calculator. 
Alternatively, symbols can be typed directly into the expression box.  

Functions are added by typing directly into the expression box. 

Adding Numerical Values 

In addition to performing calculations on values contained with certain 
form elements, numerical values can also be included. 

Position the text cursor within the expression box where you would like 
the numerical value to appear then click the associated number(s) on the 
calculator. Alternatively, values can be typed directly into the expression 
box. 

Supported Math Functions 

The following math functions can be used in calculation box expressions: 

Abs 

Arccosh 

Arcos 

Arcsin 

Arcsinh 

Arctan 

Arctan2 

Arctanh 

Ceil 

Cosh 

Cotan 

Exp 

Floor 

Frac 

Hypot 

Int 

Lnxp1 

Log10 

Log2 

Logn 

Max 

Min 

Pi 

Round 
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Sinh 

Sqr 

Sqrt 

Tan 

Tanh 

Joining Whole and Decimal Values 

If your forms require separate form elements for whole and decimal values 
(Fig. 70), they can be treated as one value in a Calculation box expression 
by “joining” the two text boxes together.  

 

Fig. 70 Separate text boxes for whole and decimal currency values 

In the Expression box, type a full stop (period) (.) between the whole and 
decimal values you would like to “join”. 

EXAMPLE: 
If TextBox1 contained a whole currency value (i.e. dollars, Euros or 
pounds), and TextBox2 contained the decimal part of that value (i.e. cents, 
or pence), the following expression is used: 

TextBox1.TextBox2 

Using the above example, if you wanted to add the value of TextBox3 to 
TextBox1 and TextBox2, the following expression is used: 

TextBox1.TextBox2 + TextBox3 

Properties 

The Calculation Box plug-in has the following properties: 

Name 
Expression 
+General 

Lock 
Hint 
Maximum Characters 
Publish 
Display 

+Position & Size  
Left 
Top 
Width 
Height 

+Border 
Width 
Color 
Publish 

+Fill 
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Color 
Transparent 
Publish 

+Pad 
Top 
Right 
Bottom 
Left 

+Character 
Font 
Size 
+Style 

Bold 
Italic 
Underlined 
Strikethrough 

Color 
+Paragraph 

Style 
Horizontal Alignment 
Vertical Alignment 
+Fixed 

Width 
Height 
Horizontal Gap 
Vertical Gap 
+Border 

Width 
Color 
Publish 

+Fill 
Color 
Transparent 
Publish 

+Number 
Decimal Places 
Display Zero 
Separate Thousands 
+Zero Pad 

Pad 
Width 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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Check Box 
If your forms require users to select options or indicate multiple choices, 
check boxes (Fig. 72) can be added using the Check Box plug-in (Fig. 71). 
Users then simply click a check box to either check it (for selected/yes) or 
uncheck it (for unselected/no).  

 

Fig. 71 Check Box plug-in button/icon 

 

Fig. 72 Example check box 

NOTE:  
By default, check boxes are mutually exclusive; i.e. users can select check 
boxes without deselecting others. This is determined by the -1 Group ID 
property value.  It is normal to use radio buttons when an option or 
question requires a mutually exclusive yes/no or on/off answer; i.e. users 
can select only one option from a related group. 

HTML TIP: 
Use the HTML Check Box plug-in to add check boxes to an InForm 
document that will be exported to HTML. 

MORE: 
For details about adding, selecting, moving, resizing and styling a check 
box, refer to Working with Form Elements. 

Defining Checked, Unchecked and No Selection States 

Check boxes have three states – checked, unchecked and no selection (if it 
is not disabled). Each of these can be configured to match your 
requirements. 

HTML TIP: 
Check boxes that appear within a HTML form only have a checked and an 
unchecked state, and character configurations and custom characters are 
ignored. 

Character Configuration 

The character that appears in a check box for any selection state is 
configured in the same way as you configure the text that appears in a 
form element such as a label. 
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Select a check box, open the Character property group and the property 
group of the selection state you would like to configure. Here you find 
properties for changing the character that appears when the state is 
active, together with its size, style and color. 

MORE: 
For further details about configuring selection state characters, refer to 
Working with Form Elements > Manipulating Text. 

Custom Characters 

Traditionally, check boxes use ticks, crosses and other similar characters 
for their selection states. In InForm Designer you can also define your own 
characters or combination of characters – even entire words. 

EXAMPLE: 
Yes/No, True/False, Male/Female 

Select a check box, open the Character property group and the property 
group of the selection state you would like to configure then click the 
Custom option in the Item value list box. Now type your required 
character or sequence of characters within the Custom Text property 
value edit box. 

Disabling No Selection 

By default, check boxes have a no selection state. However, when a check 
box is required to specify only yes/no or on/off answers, the no selection 
state can be disabled. 

Select a check box, open the General property group then click the No 
option in the Allow No Selection property value list. 

To enable the no selection state, click the Yes option in the Allow No 
Selection property value list. 

Properties 

The Check Box plug-in has the following properties: 

Name 
Group ID 
+General 

Lock 
Hint 
Default State 
Allow No Selection 
Submit Value 
Publish 

+Position & Size 
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Left 
Top 
Width 
Height 

+Border 
Width 
Color 
Publish 

+Fill 
Color Checked 
Color Unchecked 
Color No Selection 
Transparent 
Publish 

+Pad 
Top 
Right 
Bottom 
Left 

+Character 
+Checked 

Item 
Size 
+Style 

Bold 
Italic 
Underlined 
Strikethrough 

Color 
Custom Text 

+Unchecked 
Item 
Size 
+Style 

Bold 
Italic 
Underlined 
Strikethrough 

Color 
Custom Text 

+No Selection 
Item 
Size 
+Style 

Bold 
Italic 
Underlined 
Strikethrough 

Color 
Custom Text 

+Tab On 
Enter Key 
Up & Down Keys 
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+On Reset Form 
Can Be Reset 
State On Reset 

+Validation 
Required  
Must Also Fill 
Error Messages 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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Combo Box  
To reduce the time it takes for users to complete your forms and 
predetermine what information they can provide, combo boxes (Fig. 74) 
can be added using the Combo Box plug-in (Fig. 73). 

 

Fig. 73 Combo Box plug-in button/icon 

 

Fig. 74 Example combo bo (with list options displayed)  

Users can pick from a list of pre-defined options, or type something in (if 
the combo box is configured for it). As a result, the information you extract 
from your completed forms is concise and consistent, and quick to 
complete by the user. 

HTML TIP: 
Use the HTML Combo Box plug-in to add combo boxes (select lists) to an 
InForm document that will be exported to HTML. 

MORE: 
For details about adding, selecting, moving, resizing and styling a combo 
box, refer to Working with Form Elements. 

Adding and Modifying Drop-down List Options 

To add or modify existing drop-down list options, double-click a combo 
box placeholder. Following this, a Drop-down List Items dialog (Fig. 75) is 
opened where combo box options can be added or existing options 
modified. 
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Fig. 75 Drop-down List Items dialog (with example options)  

Text for each combo box option must be typed on its own line. 

When the required options have been added or modified, click the OK 
button to close the Drop-down List Items dialog and apply the options to 
the combo box. 

Click the Cancel button to ignore any additions or changes made within 
the Drop-down List Items dialog. 

HTML TIP: 
Each option in a combo box (select list) that appears within a HTML form 
has a numerical value applied to it. This starts at 1 for the first option then 
increments by 1 for all other options. 

Sorting 

By default, combo box options are displayed in the order they appear in 
the Drop-down List Items dialog (Fig. 75). To sort them in alphanumerical 
order, select a combo box, open the List property group then click the Yes 
option in the Sorted property value list box. 

To display options in the order they appear in the Drop-down List Box 
dialog, click the No option in the Sorted property value list box. 

Configuring the Drop-down List 

A drop-down list can have its drop length changed, and can be configured 
to appear as soon as a user selects a combo box. 

NOTE: 
The border, fill, padding and character of a drop-down list are configured 
independently from the rest of the combo box. The properties to do this 
appear with the List property group. 

MORE: 
For details about styling the drop-down list, refer to Working with Form 
Elements. 
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Changing the Drop Length 

By default, the drop length of a drop-down list is eight rows (lines). To 
increase or decrease the drop length, select a combo box, open the List 
property group then type the number of rows in the Drop Rows property 
value edit box you would like it to drop by. 

HTML TIP: 
The drop length of a combo box (select list) that appears within a HTML 
form is determined by the Internet browser it is viewed in. 

NOTE: 
If the number of combo box options is greater than the number of drop 
rows, a scroll bar is provided that is used to display the “hidden” options. 

MORE: 
For details about using scroll bars, refer to Working with Pages > Moving 
About > Using Scroll Bars. 

Displaying When Selected 

By default, the drop-down list is only displayed when users click the 
button of the associated combo box. 

To display the drop-down list as soon as a combo box is selected by a user, 
select a combo box, open the List property group and select the Yes 
option from the Automatic Drop property value list box. 

To display the drop-down list only when a combo box button is clicked or 
the combo box itself is double-clicked by users, select the No option from 
the Automatic Drop property value list box. 

HTML TIP: 
The drop-down list of a combo box (select list) that appears within a HTML 
form is displayed as soon as a user selects it. 

Prompting Users 

It is common for combo boxes to prompt users to select from the list of 
available options. This is normally achieved by adding text such as “Please 
Select…”, or “Choose an Option…” to the area at the top of a combo box 
that is always displayed. 

Select a combo box, open the General property group then type your 
prompt text in the Prompt property value edit box.  

HTML TIP: 
The Prompt property value is used to define the <option selected> 
attribute value for the associated HTML select list tag. An attribute value of 
0 is also applied. 
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Preventing User Entry 

By default, combo boxes allow users to select an option from a list, or type 
their own response within the text box area at the top of the combo box. 

To prevent user entry and only allow users to select an option from the 
list, select a combo box, open the List property group then click the List 
Only option in the Type property value list box. 

To allow user entry, select the Text Box With List option from the Type 
property value list box. 

HTML TIP: 
User entry within a combo box (select list) that appears within a HTML 
form is not permitted. 

Specifying the Input Type 

Combo boxes can be configured to accept the following types of data: 

Input Type Description 

Anything Any character associated with the font being used. 

Number 
0 to 9, period (.) and minus (-). No other characters can be 
typed in the combo box. 

Email Address 

Must contain an ampersand (@) and a period (.), and have the 
following structure: name@domain.xxx. 
If an invalid email address is typed in a combo box, an Input 
Error dialog appears when focus is taken away from it. 

 

Select a combo box, open the General property group then click the 
required option in the Input Format property value list box. 

Configuring the Button 

To allow users to display the drop-down list of options, a button (Fig. 76) is 
provided to the top right of combo boxes.  This button can have its 
position and display preference changed to suit your design 
requirements.  

 

Fig. 76 Combo Box button 

mailto:name@domain.xxx
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NOTE: 
The button is automatically sized to the same height as a combo box 
placeholder. 

NOTE: 
Users can also display the drop-down list by double-clicking the 
associated combo box. If configured, the drop down-list can also be 
displayed as soon as a user selects the associated combo box. 

Changing the Position 

By default, a combo box button is displayed inside a combo box. 

To move the button outside a combo box, select a combo box, open the 
Button property group then click the Outside option in the Position 
property value list box. 

To move the button inside, click the Inside option in the Position property 
value list box. 

Always Displaying 

By default, combo box buttons are only displayed when a user selects a 
combo box.  

To always display the button, select a combo box, open the Button 
property group then click the Yes option in the Always Display property 
value list box.  

To only display the button when a combo box is selected, click the No 
option in the Always Display property value list box. 

Properties 

The Combo Box plug-in has the following properties: 

Name 
+General 

Lock 
Hint 
Default Text 
Input Type 
Prompt 
Read Only 
Publish 

+Button 
Always Display 
Position 

+List 
Default Text 
Items 
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Sorted 
Type 
Drop Rows 
Automatic Drop 
+Border 

Width 
Color 

+Fill 
Color 
Transparent 

+Pad 
Top 
Right 
Bottom 
Left 

+Character 
Font 
Size 
+Style 

Bold 
Italic 
Underlined 
Strikethrough 
Upper Case 

Color 
+Position & Size 

Left 
Top 
Width 
Height 

+Border 
Width 
Color 
Publish 

+Fill 
Color 
Transparent 
Publish 

+Pad 
Top 
Right 
Bottom 
Left 

+Character 
Font 
Size 
+Style 

Bold 
Italic 
Underlined 
Strikethrough 
Upper Case 

Color 
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+Paragraph 
Style 
Horizontal Alignment 
Vertical Alignment 
+Fixed 

Width 
Height 
Horizontal Gap 
Vertical Gap 
+Border 

Width (Pixels) 
Color 
Publish 

+Fill 
Color 
Transparent 
Publish 

+Numerics (Display) 
Decimal Places 
Display Zero 
Separate Thousands 
+Zero Pad 

Pad 
Width 

+Tab On 
Enter Key 
Up & Down Keys 
Maximum Characters 
Decimal Point 

+On Reset Form 
Can Be Reset 
Text On Reset 

+Validation 
Required 
Maximum Characters 
Restrict To 
Minimum Value 
Maximum Value 
Error Messages 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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Date Box 
If your InForm document requires users to enter a date, you can make 
certain it is specified and displayed in a specific format by adding a date 
box (Fig. 78) using the Date Box plug-in (Fig. 77). Alternatively, you can 
display the current system date on your forms as a visual reference for 
users, or as a date stamp to indicate when the InForm document was last 
saved or printed. 

 

Fig. 77 Date Box plug-in button/icon 

 

Fig. 78 Example date box 

HTML TIP: 
Use the HTML Date Box plug-in to add date boxes to an InForm document 
that will be exported to HTML. 

MORE: 
For details about adding, selecting, moving, resizing and styling a date 
box, refer to Working with Form Elements. 

MORE: 
To specify a time, use the Time Box plug-in. 

Specifying Formats 

You can specify an input format and an output format for a date box. This 
means the format of the date displayed can be different to what a user 
must fill in. 

EXAMPLE: 
You could ask users to fill in mm/dd/yy (e.g. 02/01/11) but display it as 
dddd, dd mmmm yyyy (e.g. Tuesday, 01 February 2011). 

Input Format 

The input format determines the date format that must be used when 
filling in a date. 

Select a date box then click the required option in the Input Format 
property value list box, or type your own input format. 

When defining you own input format, any combination of date format 
characters and date separators can be specified. 
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NOTE: 
If an invalid date or a date that does not match the input format is typed 
in a date box, an Input Error dialog appears when focus is taken away from 
it. 

NOTE: 
Leaving the Input Format property value blank will enable users to fill in a 
date using the Windows® Regional and Language short or long date 
format.  

Output Format 

The output format determines the date format that is displayed after a 
date box is filled in by a user. 

Select a date box then click the required option in the Output Format 
property value list box, or type your own output format. 

When defining you own output format, any combination of date format 
characters, date separators and other characters and strings can be 
specified. 

NOTE: 
Leaving the Output Format property value blank will use the Windows® 
Regional and Language long date format. 

Date Format Characters 

Below is a list of available date format characters that can be used with the 
Input Format and Output Format properties, together with an example 
based upon Tuesday 01 February 2011: 

Character(s) Description Example 

d Numeric day of month 1 

dd 
Numeric day of month with leading 
zero 

01 

ddd Day of week - Short Tue 

dddd Day of week - Full Tuesday 

ddddd Short date format* 02/01/2011 (USA) 

dddddd Long date format* 01 February 2011 

m Numeric month 1 

mm Numeric month with leading zero 01 
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mmm Month - Short Feb 

mmmm Month - Full February 

yy Year - Short 11 

yyyy Year - Long 2011 

*NOTE: 
The short date and long date formats used are determined by the 
Windows® Regional and Language short date and long date. 

MORE: 
For details about the Windows® Regional and Language, refer to your 
Windows® documentation or Help. 

Date Separators 

The following characters can be used for separating each part of a date: 

• Space 
• / 
• . 

Additional Characters and Strings 

Additional characters and strings can also be included in the output 
format by enclosing them in single or double quotes within the Output 
Format property value. 

EXAMPLE: 
“The date is” dd/mm/yy 

Is displayed as: 

The date is 01/02/11 

EXAMPLE:  
dd ‘day, ‘ mm ‘month, ‘ yy ‘year’ 

Is displayed as: 

01 day, 02 month, 11 year 

Displaying the Current Date 

To display the current date in an InForm document, select a date box, 
open the General property group then type “now” (without the speech 
marks) into the Default Text property value edit box. 
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Creating a Date Stamp 

To indicate when an InForm document was last saved you can apply a 
date stamp to a date box. 

Select a date box, open the General property group, click the Yes option in 
the Stamp property value list box then specify “now” in the Default Text 
property value edit box. 

If you do not want the date to be modified by users, the time box can be 
made read only. In the General property group, click the Yes option in the 
Read Only property value list box. 

Properties 

The Date Box plug-in has the following properties: 

Name 
Input Format 
Output Format 
+General 

Lock 
Hint 
Default Text 
Stamp 
Read Only 
Publish 

+Position & Size 
Left 
Top 
Width 
Height 

+Border 
Width 
Color 
Publish 

+Fill 
Color 
Transparent 
Publish 

+Pad 
Top 
Right 
Bottom 
Left 

+Character 
Font 
Size 

+Style 
Bold 
Italic 
Underlined 
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Strikethrough 
Upper Case 

Color 
+Paragraph 

Style 
Horizontal Alignment 
Vertical Alignment 
+Fixed 

Width 
Height 
Horizontal Gap 
Vertical Gap 
+Border 

Width (Pixels) 
Color 
Publish 

+Fill 
Color 
Transparent 
Publish 

+Tab On 
Enter Key 
Up & Down Keys 

+On Reset Form 
Can Be Reset 
Text On Reset 

+Validation 
Required  
Error Messages 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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Image 
If you would like to enhance the visual impact of your forms, the Image 
plug-in (Fig. 79) allows you to integrate the content of a supported image 
format. 

 

Fig. 79 Image plug-in button/icon 

  

Fig. 80 Example images 

By using the Image plug-in, you are able to incorporate logos, photos, 
clipart and even entire pages from PDF documents. You can also integrate 
image boxes so users of your forms can add images of their own such as 
their photo or a scan of their signature.  

HTML TIP: 
Use the HTML Image plug-in to add images to an InForm document that 
will be exported to HTML. 

MORE: 
For details about adding, selecting, moving and resizing an image or PDF, 
refer to Working with Form Elements. 

MORE: 
For details about using an image or PDF as a page background, refer to 
Working With Pages > Adding Background Effects > Image and PDF. 

Supported Image Formats 

The following image formats are supported: 

• BMP 
• EMF 
• GIF 
• ICO 
• JPG/JPEG 
• PDF 
• PNG  
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• WMF 

Adding an Image 

To add an image or PDF to a page, double-click an image placeholder. 
Following this, an Image File dialog (Fig. 81) appears where you can select 
a supported file from your file system. 

 

Fig. 81 Image File dialog 

Following selection of a supported file, click the Open button to add the 
content of the file to the image placeholder. 

If a PDF is selected, page one is displayed by default and an associated 
icon appears on the non-visual form element bar if the PDF has not 
previously been included in your InForm document. 

NOTE: 
If a PDF you wish to use has already been included, it can be selected by 
opening the PDF property group then clicking the required PDF name 
from the Link property list box. 

Resizing Within the Entire Placeholder  

By default, images and PDFs are resized in proportion to their original 
shape within an image placeholder. 

To resize the image or PDF so its horizontal and vertical planes are 
stretched to fit within the entire placeholder, select an image placeholder, 
open the general property group then click the No option in the 
Proportional property value list box. 
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To make an image or PDF proportional, click the Yes option in the 
Proportional property value list box.  

Selecting a PDF Page 

By default, page one of a PDF is displayed within an image placeholder. To 
change the page, open the PDF property group and type the required 
page number in the Page property value edit box. If the page is available, 
it is displayed within the image placeholder. 

Creating User Definable Image Areas 

By default, any image placeholder, together with the image it contains, 
cannot be interacted with in Filler mode and InForm Filler. In essence, 
images and PDFs are read only and are intended for visual reference only. 

If you would like users of your forms to add their own images or PDFs, the 
read only status of an image placeholder can be disabled. 

Select an image placeholder, open the General property group then click 
the No option in the Read Only property value list box. 

Users of your InForm document can double-click the image area to specify 
the supported file they would like to add. To prompt users to do this, you 
could add an image that says “Double-click to add image” or similar. 

To make an image or PDF read only, click the Yes option in the Read Only 
property value list box. 

HTML TIP: 
Interaction with images that appear within a HTML form is not permissible 
unless they are configured for use as a form submit button. 

Creating a Web Link 

Images can have a Web link applied to them so when they are clicked in 
Filler mode or InForm Filler, the associated page is opened in the user’s 
default Internet browser. 

EXAMPLE: 
You could add your company’s logo then apply your company’s website 
address to it so when it was clicked your company’s website is opened. 

Select an image placeholder, open the General property group then 
specify the Web link in the Web Link property value edit box. 

EXAMPLE: 
http://www.flysoftware.com 
http://www.flysoftware.com/products/products.asp 
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home.asp (HTML forms only) 
products/products.asp (HTML forms only) 

HTML TIP: 
For images that have been applied to an InForm document using the 
HTML Image plug-in, you can specify the window or frame where the 
page associated with a Web link is opened using the Web Target property. 

Properties 

The Image plug-in has the following properties: 

Name 
Filename 
+PDF 

Link 
Page 

+General 
Lock 
Proportional 
Hint 
Web Link 
Read Only 
Publish 
Display 

+Position & Size 
Left 
Top 
Width 
Height 

+Border 
Width 
Color 
Publish 

+Fill 
Color 
Transparent 
Publish 

+Pad 
Top 
Right 
Bottom 
Left 

+Tab On 
Enter Key 
Up & Down Keys 

+On Reset Form 
Can Be Reset 
File Name 

+PDF 
Link 
Page 
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Publish 
+Validation 

Required  
Error Messages 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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Label 
To enable users of forms you design to identify them, receive instruction 
and know what information needs to be filled in, text labels (Fig. 83) such 
as page titles, headings, captions, and even entire sentences and 
paragraphs can be added using the Label plug-in (Fig. 82). 

 

Fig. 82 Label plug-in button/icon 

 

Fig. 83 Example label 

HTML TIP: 
Use the HTML Label plug-in to add labels to an InForm document that will 
be exported to HTML. 

MORE: 
For details about adding, selecting, moving, resizing and styling a label, 
refer to Working with Form Elements. 

Adding and Modifying Text 

To add text to a label or modify existing label text, double-click its 
placeholder. Following this, a Default text dialog (Fig. 84) is opened where 
the text to be displayed within the placeholder is typed or modified. 

 

Fig. 84 Default Text dialog 

When the required text has been typed or modified, click the OK button to 
close the Default text dialog and display the text in the label placeholder. 

Click the Cancel button to ignore any additions or changes made to text 
within the Default text dialog. 

Alternatively, label text can be added or modified by selecting a label, 
opening the General property group then typing directly into the Default 
Text property value edit box. 
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HTML TIP: 
Labels that appear on a page that will be used to form the content of an 
ASP or PHP submitted page can have the Name property values of other 
form elements applied to them. For details about how to do this, refer to 
Creating HTML forms > Using a Submitted Page > Including the Content 
of HTML Form Elements. 

Creating a Web Link 

Labels can have a Web link applied to them so when they are clicked in 
Filler mode or InForm Filler, the associated page is opened in the user’s 
default Internet browser. 

EXAMPLE: 
You could add your company’s name to a label then apply your 
company’s website address to it so when it was clicked your company’s 
website is opened. 

Select a label, open the General property group then specify the Web link 
in the Web Link property value edit box. 

EXAMPLE: 
http://www.flysoftware.com 
http://www.flysoftware.com/products/products.asp 
home.asp (HTML forms only) 
products/products.asp (HTML forms only) 

HTML TIP: 
For labels that have been applied to a form using the HTML Label plug-in, 
you can specify the window or frame where the page associated with a 
Web link is opened using the Web Target property. 

Using as Design Notes 

By default, labels are always displayed on-screen in Designer mode, Filler 
mode and InForm Filler. However, if you would like to use them for design 
notes they can be configured so they are not displayed in Filler mode and 
InForm Filler.  

Select a label, open the General property group then click the No option 
in the Display property value list box. 

To display a label in Filler mode and InForm Filler, click the Yes option in 
the Display property value list box. 

Properties 

The Label plug-in has the following properties: 
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Name 
General 

Lock 
Default Text 
Web Link 
Publish 
Display 

+Position & Size  
Left 
Top 
Width 
Height 

+Border 
Width 
Color 
Publish 

+Fill 
Color 
Transparent 
Publish 

+Pad 
Top 
Right 
Bottom 
Left 

+Character 
Font 
Size 
+Style 

Bold 
Italic 
Underlined 
Strikethrough 
Upper Case 

Color 
+Paragraph 

Style 
Horizontal Alignment 
Vertical Alignment 
+Fixed 

Width 
Height 
Horizontal Gap 
Vertical Gap 
+Border 

Width 
Color 
Publish 

+Fill 
Color 
Transparent 
Publish 

Word Wrap 
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MORE: 
For a description of each property, refer to Appendix A: Properties. 
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Radio Button 
If your forms require users to select only a single option from a group of 
choices, or specifically answer either yes or no to a question, radio buttons 
(Fig. 86) can be added using the Radio Button plug-in (Fig. 85). Users click 
a radio button to check it (for selected/yes) which automatically unchecks 
another radio button in the same group. 

 

Fig. 85 Radio button/icon 

 

Fig. 86 Example radio buttons 

NOTE:  
The Check Box plug-in should be used if more than one selection is 
acceptable or it does not necessarily need to be selected. 

HTML TIP: 
Use the HTML Radio Button plug-in to add radio buttons to an InForm 
document that will be exported to HTML. 

MORE: 
For details about adding, selecting, moving, resizing and styling a radio 
button, refer to Working with Form Elements. 

Defining Checked and Unchecked States 

Defining checked and unchecked states for radio buttons is the same 
process as defining them for check boxes.  

MORE: 
For details about defining checked and unchecked states for radio 
buttons, refer to Common InForm Plug-ins > Check Box > Defining 
Checked, Unchecked and No Selection States. 

Creating Radio Button Groups 

Groups of radio buttons can be defined so when a user selects (checks) 
one, all others in that group are unchecked. 

Select a radio button then overwrite -1 with another number in the Group 
ID property value edit box. Repeat this process for all radio buttons you 
wish to include in the same group, remembering to specify the same 
Group ID number. 
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To remove a radio button from a group, type -1 in the Group ID property 
value edit box. 

Properties 

The Radio Button plug-in has the following properties: 

Name 
Group ID 
+General 

Lock 
Hint 
Default State 
Submit Value 
Read Only 
Publish 

+Position & Size  
Left 
Top 
Width 
Height 

+Border 
Width 
Color 
Publish 

+Fill 
Color Checked 
Color Unchecked 
Transparent 
Publish 

+Pad 
Top 
Right 
Bottom 
Left 

Character 
+Checked 

Item 
Size 
+Style 

Bold 
Italic 
Underlined 
Strikethrough 

Color 
Custom Text 

+Unchecked 
Item 
Size 
+Style 

Bold 
Italic 
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Underlined 
Strikethrough 

Color 
Custom Text 

+Tab On 
Enter Key 
Up & Down Keys 

+On Reset Form 
Can Be Reset 
State On Reset 

+Validation 
Required  
Must Also Fill 
Error Messages 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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Shape 
If you would like to add impact to your forms, the Shape plug-in (Fig. 87) 
allows you to draw a range of common graphical objects. 

The following objects are available:  

• Rectangle 
• Square 
• Ellipse 
• Circle 
• Horizontal Line 
• Vertical Line 
• Diagonal Line (\) 
• Diagonal Line (/) 

 

Fig. 87 Shape plug-in button/icon 

 

Fig. 88 Example shapes 

NOTE: 
Only basic shapes can be created using the Shape plug-in. If your InForm 
document requires complex shapes, it is advised you design them in an 
image editing application such as Adobe® Photoshop® then import them 
using the Image plug-in. 

HTML TIP: 
Shapes are ignored when and InForm document is exported to HTML. 
Instead, use the HTML Image plug-in to add bitmap images of the shapes 
you require. 

MORE: 
For details about adding, selecting, moving, resizing and styling a shape, 
refer to Working with Form Elements. 

Changing the Shape 

By default, an ellipse is drawn when a shape is added to a page. To change 
it, select the shape then click the required shape option in the Style 
property value list box. 
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Rounding Corners 

By default, square and rectangle shapes have 45° corners but can be 
rounded (Fig. 89) to your requirements. 

 

Fig. 89 Rectangle before and after adding rounded corners 

To specify the amount of curve, select a shape, open the Border property 
group then type a number within the Curve property value edit box.  

To remove rounded corners, specify 0 in the Curve property value edit 
box.  

Adding a Fill 

The rectangle, square, ellipse and circle shapes can all have their fill color 
changed. Unlike most form elements, however, the fill does not determine 
the color of the placeholder, but instead determines the color inside the 
shape. 

MORE: 
For details about changing the fill, refer to Working with Form Elements > 
Adding a Fill. 

Changing the Mode 

In addition to the standard fill, shapes can also have fill modes, that when 
selected, apply special effects to the fill color. 

Select a shape, open the Fill property group then click an option in the 
Mode property value list box. Experiment with the modes to achieve the 
effect you require. 

Properties 

The Label plug-in has the following properties: 

Name 
Style 
+General 

Lock 
Hint 
Publish 

+Position & Size  
Left 
Top 
Width 
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Height 
+Border 

Width 
Color 
Publish 

+Fill 
Color 
Mode 

+Pad 
Top 
Right 
Bottom 
Left 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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Text Box 
The purpose of forms is to retrieve information and data. A simple way to 
accomplish this, and one that is common to most forms, is to include 
boxes where text can be typed or written.  

In InForm Designer these boxes are known as text boxes (Fig. 91), and any 
number can be added to your forms using the Text Box plug-in (Fig. 90). 

 

Fig. 90 Text Box plug-in button/icon 

 

Fig. 91 Example text box 

HTML TIP: 
Use the HTML Text Box, HTML Password Text Box, HTML Email Text Box, 
HTML Numeric Text Box and HTML Text Area plug-ins to add text boxes, 
password text boxes, email text boxes, number text boxes and text areas 
to an InForm document that will be exported to HTML. 

MORE: 
For details about adding, selecting, moving, resizing and styling a text 
box, refer to Working with Form Elements. 

Single or Multiple Lines 

By default, text boxes only allow users to fill in text on a single line – even 
if the height of a text box is sized so it could accommodate text on 
multiple lines. If text needs to be accepted on multiple lines, a text box 
needs to have word wrapping enabled. 

Select a text box, open the Paragraph property group then click the Yes 
option in the Word Wrap property value list box. 

To make the text box only accept single lines of text, click the No option in 
the Word Wrap property value list box. 

HTML TIP: 
The Word Wrap property value determines whether a text box becomes a 
HTML text field (Word Wrap = No) or HTML text area (Word Wrap = Yes). 
However, it is advised you use the HTML Text Area plug-in to create HTML 
text areas. 
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Specifying the Input Type 

Text boxes can be configured to accept the following types of data: 

Input Type Description 

Anything Any characters. 

Number 
0 to 9, period (.) and minus (-). No other characters can be 
typed in the text box. 

Email Address 

Must contain an ampersand (@) and a period (.), and have the 
following structure: name@domain.xxx. 
If an invalid email address is typed in a text box, an Input 
Error dialog appears when focus is taken away from it. 

Password 
Any characters. 
Each character is displayed as an asterisk (*) as it is typed to 
help ensure privacy of the password. 

 

Select a text box, open the General property group then click the required 
option in the Input Format property value list box. 

HTML TIP: 
Use the HTML Text Box to accept any data, the HTML Numeric Text Box to 
only accept numbers, the HTML Email Text Box to only accept email 
addresses, and the HTML Password Text Box to hide password data. 

NOTE: 
If you need a form element to accept a date or time, use the Date Box 
plug-in and the Time Box plug-in. 

Restricting Content 

By default, users can type any character and any number of characters 
within a text box. However, there may be occasions when you want to 
restrict what can be typed to a particular character, combination of 
characters, or quantity of characters. 

By Character 

A text box can be configured so only specified characters can be typed 
within it. 

EXAMPLE: 
If 12A is specified, only 1, 2 and/or A can be typed. 

Select a text box, open the Validation property group then type the 
acceptable characters in the Restrict To property value edit box. 

mailto:name@domain.xxx
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NOTE: 
Characters are case sensitive. 

EXAMPLE: 
If A, B and C are acceptable characters, then a, b and c cannot be typed 
with a text box (unless they are also acceptable characters). 

MORE: 
For details about allowing only numeric values, refer to Working with 
Form Elements > Manipulating Numbers. 

By Character Quantity 

A text box can be configured so only a specified number of characters can 
be typed within it. 

EXAMPLE: 
If 5 characters were specified, only “Hello” of “Hello World” can be typed. 

Select a text box, open the Validation property group then type the 
acceptable quantity of characters in the Maximum Characters property 
value edit box. 

Forcing Text Size 

To improve legibility or allow as much text as possible to fit within a text 
box, users can increase or decrease the size of text as required. However, if 
preferred, the size of text users can type within a text box can be fixed. 

Select a text box, open the Character property group then click the Yes 
option in the Fixed Size property value list box. 

To make the text size variable, click the No option in the Fixed Size 
property value list box. 

HTML TIP: 
The size of text in a text box that appears within a HTML form always 
remains fixed. 

Properties 

The Text Box plug-in has the following properties: 

Name 
+General 

Lock 
Hint 
Default Text 
Input Type 
Publish 
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Read Only 
Display 

+Position & Size 
Left 
Top 
Width 
Height 

+Border 
Width 
Color 
Publish 

+Fill 
Color 
Transparent 
Publish 

+Pad 
Top 
Right 
Bottom 
Left 

+Character 
Font 
Size 
+Style 

Bold 
Italic 
Underlined 
Strikethrough 
Upper Case 

Color 
+Paragraph 

Style 
Horizontal Alignment 
Vertical Alignment 
+Fixed 

Width 
Height 
Horizontal Gap 
Vertical Gap 
+Border 

Width 
Color 
Publish 

+Fill 
Color 
Transparent 
Publish 

Word Wrap 
+Numerics (Display) 

Decimal Places 
Display Zero 
Separate Thousands 
+Zero Pad 
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Pad 
Width 

+Tab On 
Enter Key 
Up & Down Keys 
Maximum Characters 
Decimal Point 

+On Reset Form 
Can Be Reset 
Text On Reset 

+Validation 
Required 
Maximum Characters 
Restrict To 
Minimum Value 
Maximum Value 
Must Also Match 
Must Also Check 
Error Messages 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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Time Box 
If your InForm document requires users to enter a time, you can make 
certain it is specified and displayed in a format you require, by adding a 
time box (Fig. 93) using the Time Box plug-in (Fig. 92). Alternatively, you 
can display the current system time on your forms as a visual reference for 
users or as a time stamp to indicate when the InForm document was last 
saved or printed. 

 

Fig. 92 Time Box plug-in button/icon 

 

Fig. 93 Example time box 

HTML TIP: 
Use the HTML Time Box plug-in to add time boxes to an InForm document 
that will be exported to HTML. 

MORE: 
For details about adding, selecting, moving, resizing and styling a time 
box, refer to Working with Form Elements. 

NOTE: 
To specify a date, use the Date Box plug-in. 

Specifying Formats 

You can specify an input format and an output format for a time box. This 
means the format of the time displayed can be different to what a user 
must fill in. 

EXAMPLE: 
You could ask users to fill in hh:mm (e.g. 17:09) but display it as h:mm:pm 
(e.g. 5:09:pm). 

Input Format 

The input format determines the time format that must be used when 
filling in a time box. 

Select a time box then click the required option in the Input Format 
property value list box, or type your own input format. 

When defining you own input format, any combination of time format 
characters and time separators can be specified. 
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NOTE: 
If an invalid time or a time that does not match the input format is typed 
in a time box, an Input Error dialog appears when focus is taken away from 
it. 

NOTE: 
Leaving the Input Format property value blank will allow users to fill in a 
time using the Windows® Regional and Language short or long time 
format. 

Output Format 

The output format determines the time format that is displayed after a 
time box is filled in by a user. 

Select a time box then click the required option in the Output Format 
property value list box, or type your own output format. 

When defining you own output format, any combination of any 
combination of time format characters, time separators and other 
characters and strings can be specified. 

NOTE: 
Leaving the Output Format property value blank will use the Windows® 
Regional and Language long time format. 

Time Format Characters 

Below is a list of available time format characters together with an 
example based upon 17:09:06: 

Character(s) Description Example 

h Hour 5 or 17 

hh Hour with leading zero 05 or 17 

m Minute 9 

mm Minute with leading zero 09 

s Second 6 

ss Second with leading zero 06 

t Short time format* 17:09 

tt Long time format* 17:09:06 

am/pm 
Uses the 12 hour clock for the 
preceding h or hh character, and 
displays ‘am’ for any hour before 

pm 
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noon, and ‘pm’ for any hour after 
noon. Can use lower, upper or mixed 
case. 
Output Format property only. 

a/p 

Uses the 12 hour clock for the 
preceding h or hh character, and 
displays ‘a’ for any hour before noon, 
and ‘p’ for any hour after noon. Can 
use lower, upper or mixed case. 
Output Format property only. 

p 

*NOTE: 
The short date and long time formats used are determined by the 
Windows® Regional and Language short time and long time formats. 

MORE: 
For details about the Windows® Regional and Language Options, refer to 
your Windows® documentation or Help. 

Time Separators 

The following characters are recommended as time separators for : 

• Colon (:) 
• Period (.) 
• Comma (,) 

EXAMPLE: 
Hh,mm would display 17,09. 

CAUTION: 
Using other characters or strings can result in undesirable results. 

Additional Characters and Strings 

Additional characters and strings can also be displayed alongside a time 
by enclosing them in single or double quotes. 

EXAMPLE: 
“The time is” hh:mm:ss 

Is displayed as: 

The time is 17:09:06 

EXAMPLE:  
hh ‘hours, ‘ mm ‘minutes, ‘ ss ‘seconds’ 

Is displayed as: 
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17 hours, 09 minutes, 06 seconds 

Displaying the Current Time 

To display the current time, select a time box, open the General property 
group then type “now” (without the speech marks) into the Default Text 
property value edit box. 

Creating a Time Stamp 

To indicate when an InForm document was last saved you can apply a 
time stamp to a time box. 

Select a time box, open the General property group and click the Yes 
option in the Stamp property value list box then specify “now” in the 
Default Text property value edit box. 

If you do not want the time to be modified by users, the time box can be 
made read only. In the General property group, click the Yes option in the 
Read Only property value list box.  

Properties 

The Time Box plug-in has the following properties: 

Name 
Input Format 
Output Format 
+General 

Lock 
Hint 
Default Text 
Stamp 
Read Only 
Publish 

+Position & Size 
Left 
Top 
Width 
Height 

+Border 
Width 
Color 
Publish 

+Fill 
Color 
Transparent 
Publish 

+Pad 
Top 
Right 
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Bottom 
Left 

+Character 
Font 
Size 

+Style 
Bold 
Italic 
Underlined 
Strikethrough 
Upper Case 

Color 
+Paragraph 

Style 
Horizontal Alignment 
Vertical Alignment 
+Fixed 

Width 
Height 
Horizontal Gap 
Vertical Gap 
+Border 

Width (Pixels) 
Color 
Publish 

+Fill 
Color 
Transparent 
Publish 

+Tab On 
Enter Key 
Up & Down Keys 

+On Reset Form 
Can Be Reset 
Text On Reset 

+Validation 
Required  
Error Messages 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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HTML InForm Plug-ins 

In this section the following HTML InForm Plug-ins are described: 

• HTML Button 
• HTML Check Box 
• HTML Combo Box 
• HTML Date Box 
• HTML Email Text Box 
• HTML Hidden Field 
• HTML Image 
• HTML Label 
• HTML Numeric Text Box 
• HTML Password Text Box 
• HTML Radio Button 
• HTML Text Area 
• HTML Text Box 
• HTML Time Box 

MORE: 
For details about common InForm Plug-ins, refer to Common InForm 
Plug-ins. 



HTML InForm Plug-ins  

204 InForm Designer User Guide 

HTML Button 
The HTML Button plug-in (Fig. 94) is used to add form submit and reset 
buttons (Fig. 95) to an InForm document that will be exported to HTML. 

 

Fig. 94 HTML Button plug-in button/icon 

 

Fig. 95 Example HTML buttons 

NOTE: 
The common Button plug-in can also be used to create form submit and 
reset buttons for use within a HTML form. However, certain functionality 
available to buttons created this way, such as specifying actions, is 
unsupported by HTML and is ignored. 

MORE: 
For further details about buttons, refer to Common InForm Plug-ins > 
Button. 

MORE: 
For details about adding, selecting, moving, resizing and styling a button, 
refer to Working with Form Elements. 

Specifying a Submit Button 

Submit buttons are used to submit the completed content of HTML forms 
(normally to a submitted page). 

A submit button is specified by selecting the name of a button from the 
Submit Button drop-down list within the HTML Export dialog (Fig. 57). 

NOTE: 
Images created using the HTML Image plug-in and common Image plug-
in, and buttons created using the common Button plug-in, also appear 
within the Submit Button drop-down list and as such can be used as 
submit buttons. 

NOTE: 
Having a submit button on a HTML form is mandatory. Therefore, prior to 
an InForm document being exported to HTML, an Incomplete Settings 
dialog (Fig. 60) appears if a submit button has not been selected. 



HTML InForm Plug-ins  

InForm Designer User Guide 205 

Specifying a Reset Button 

Reset buttons are used to reset HTML forms so the form elements are 
returned to their original state (normally blank/unselected). 

A reset button is specified by selecting the name of a button from the 
Reset Button drop-down list within the HTML Export dialog (Fig. 57).  

NOTE: 
Buttons created using the common Button plug-in also appear within the 
Reset Button drop-down list and as such can be used as reset buttons. 

Licensing 

The HTML Button plug-in is automatically licensed when the common 
Button plug-in is licensed. 

MORE: 
For further details about common and HTML InForm Plug-in associations, 
refer to Introduction > Plug-in Power! > Associated InForm Plug-ins. 

HTML Tag 

A button within a HTML form has the following HTML tag: 

<button></button> 

MORE: 
For further details about HTML tags, refer to Creating HTML Forms > HTML 
Form Elements. 

Properties 

The HTML Button plug-in has the following properties: 

Name 
+General 

Lock 
Hint 
Default Text 
Publish 

+Position & Size 
Left 
Top 
Width 
Height 

+Border 
Width 
Color 
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+Fill 
Color 

+Pad 
Top 
Right 
Bottom 
Left 

+Character 
Font 
Size 
+Style 

Bold 
Italic 
Underlined 
Strikethrough 
Upper Case 

Color 

MORE: 
For a description of each property, refer to Appendix A: Properties. 



HTML InForm Plug-ins  

InForm Designer User Guide 207 

HTML Check Box 
The HTML Check Box plug-in (Fig. 96) is used to add check boxes (Fig. 97) 
to an InForm document that will be exported to HTML. 

 

Fig. 96 HTML Check Box plug-in button/icon 

 

Fig. 97 Example HTML check boxes 

Check boxes allow users of HTML forms to select (tick) or deselect (untick) 
them in order to indicate one or more choices. 

NOTE: 
The common Check Box plug-in can also be used to create check boxes 
for use within a HTML form. However, certain functionality available to 
check boxes created this way, such as specifying the border, colour, and 
the checked and unchecked characters, is unsupported by HTML and is 
ignored. 

NOTE: 
Most Internet browsers tend to display check boxes in a standard/default 
style. For this reason check boxes created using the HTML Check Box plug-
in appear within an InForm document in this standard/default format. 

MORE: 
For further details about check boxes, refer to Common InForm Plug-ins > 
Check Box. 

MORE: 
For details about adding, selecting, moving, resizing and styling a check 
box, refer to Working with Form Elements. 

Specifying a Selected Submit Value 

When a HTML form is submitted, the default value posted for a selected 
(ticked) check box is “on”, and blank for an unselected check box. To 
change the selected (ticked) value, perform the following: 

1. Select the check box. 
2. Open the General property group. 
3. Specify a value in the Submit Value property edit box. 
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EXAMPLE: 
If “Dog” was specified as the Submit Value property value, “Dog” would be 
posted if the check box was selected (ticked) when the HTML form is 
submitted. 

Licensing 

The HTML Check Box plug-in is automatically licensed when the common 
Check Box plug-in is licensed. 

MORE: 
For further details about common and HTML InForm Plug-in associations, 
refer to Introduction > Plug-in Power! > Associated InForm Plug-ins. 

HTML Tag 

A check box within a HTML form has the following HTML tag: 

<input type=”checkbox”>  

MORE: 
For further details about HTML tags, refer to Creating HTML Forms > HTML 
Form Elements. 

Properties 

The HTML Check Box plug-in has the following properties: 

Name 
+General 

Lock 
Hint 
Default State 
Submit Value 
Publish 

+Position & Size  
Left 
Top 
Width 
Height 

+Validation 
Required  
Must Also Fill 
Error Messages 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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HTML Combo Box 
The HTML Combo Box plug-in (Fig. 98) is used to add combo boxes (select 
lists) (Fig. 99) to an InForm document that will be exported to HTML.  

 

Fig. 98 HTML Combo Box plug-in button/icon 

 

Fig. 99 Example HTML combo box 

Combo boxes (select lists) allow users of HTML forms to select one option 
from a list of normally related options. 

NOTE: 
The common Combo Box plug-in can also be used to create combo boxes 
for use within a HTML form. However, much of the functionality available 
to combo boxes created this way, such as having an editable text box and 
determining the number of drop rows, are unsupported by HTML and are 
ignored. 

MORE: 
For further details about combo boxes, refer to Common InForm Plug-ins 
> Combo Box. 

MORE: 
For details about adding, selecting, moving, resizing and styling a combo 
box (select list), refer to Working with Form Elements. 

Licensing 

The HTML Combo Box plug-in is automatically licensed when the 
common Combo Box plug-in is licensed. 

MORE: 
For further details about common and HTML InForm Plug-in associations, 
refer to Introduction > Plug-in Power! > Associated InForm Plug-ins. 

HTML Tag 

A combo box (select list) within a HTML form has the following HTML tag: 
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<select></select> 

MORE: 
For further details about HTML tags, refer to Creating HTML Forms > HTML 
Form Elements. 

Properties 

The HTML Combo Box plug-in has the following properties: 

Name 
+General 

Lock 
Hint 
Prompt 
Publish 

+List 
Items 
Sorted 

+Position & Size 
Left 
Top 
Width 
Height 

+Border 
Width 
Color 

+Fill 
Color 

+Character 
Font 
Size 
+Style 

Bold 
Italic 
Underlined 
Strikethrough 
Upper Case 

Color 
+Validation 

Required 
Error Messages 

MORE: 
For a description of each property, refer to Appendix A: Properties. 



HTML InForm Plug-ins  

InForm Designer User Guide 211 

HTML Date Box 
The HTML Date Box plug-in (Fig. 100) is used to add date boxes (text 
fields) (Fig. 101) to an InForm document that will be exported to HTML.  

 

Fig. 100 HTML Date Box plug-in button/icon 

 

Fig. 101 Example HTML date box 

Date boxes allow users of HTML forms to specify dates that are validated 
when a form is submitted. 

NOTE: 
The common Date Box plug-in can also be used to create date boxes for 
use within a HTML form. However, certain properties are unsupported by 
HTML and are ignored. 

MORE: 
For further details about date boxes, refer to Common InForm Plug-ins > 
Date Box. 

MORE: 
For details about adding, selecting, moving, resizing and styling a date 
box, refer to Working with Form Elements. 

Licensing 

The HTML Date Box plug-in is automatically licensed when the common 
Date Box plug-in is licensed. 

MORE: 
For further details about common and HTML InForm Plug-in associations, 
refer to Introduction > Plug-in Power! > Associated InForm Plug-ins. 

HTML Tag 

HTML does not have a specific HTML tag for a date box. Instead a text field 
tag is used and validation is automatically applied to ensure only a valid 
date is posted when a HTML form is submitted: 

<input type=”text”> 
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MORE: 
For further details about HTML tags, refer to Creating HTML Forms > HTML 
Form Elements. 

Properties 

The HTML Date Box plug-in has the following properties: 

Name 
Input Format 
+General 

Lock 
Hint 
Default Text 
Read Only 
Publish 

+Position & Size 
Left 
Top 
Width 
Height 

+Border 
Width 
Color 

+Fill 
Color 

+Pad 
Top 
Right 
Bottom 
Left 

+Character 
Font 
Size 

+Style 
Bold 
Italic 
Underlined 
Strikethrough 
Upper Case 

Color 
+Paragraph 

Horizontal Alignment 
+Validation 

Required  
Error Messages 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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HTML Email Text Box 
The HTML Email Text Box plug-in (Fig. 102) is used to add email text boxes 
(text fields) (Fig. 103) to an InForm document that will be exported to 
HTML.  

 

Fig. 102 HTML Email Text Box plug-in button/icon 

 

Fig. 103 Example HTML email text box 

Email text boxes allow users of HTML forms to specify email addresses that 
are validated when a form is submitted. 

NOTE: 
The common Text Box plug-in can also be used to create email text boxes 
for use within a HTML form by setting the Input Type property within the 
General property group to Email Address. However, certain common Text 
Box plug-in properties are unsupported by HTML and are ignored. 

MORE: 
For further details about email text boxes, refer to Common InForm Plug-
ins > Text Box. 

MORE: 
For details about adding, selecting, moving, resizing and styling an email 
text box, refer to Working with Form Elements. 

Licensing 

The HTML Email Text Box plug-in is automatically licensed when the 
common Text Box plug-in is licensed. 

MORE: 
For further details about common and HTML InForm Plug-in associations, 
refer to Introduction > Plug-in Power! > Associated InForm Plug-ins. 

HTML Tag 

HTML does not have a specific HTML tag for an email text box. Instead a 
text field tag is used and validation is automatically applied to ensure only 
an email in a valid format is posted when a HTML form is submitted: 

<input type=”text”> 
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MORE: 
For further details about HTML tags, refer to Creating HTML Forms > HTML 
Form Elements. 

Properties 

The HTML Email Text Box plug-in has the following properties: 

Name 
+General 

Lock 
Hint 
Default Text 
Read Only 
Publish 

+Position & Size 
Left 
Top 
Width 
Height 

+Border 
Width 
Color 

+Fill 
Color 

+Pad 
Top 
Right 
Bottom 
Left 

+Character 
Font 
Size 
+Style 

Bold 
Italic 
Underlined 
Strikethrough 
Upper Case 

Color 
+Paragraph 

Horizontal Alignment 
+Validation 

Required 
Maximum Characters 
Must Also Match 
Must Also Check 
Error Messages 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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HTML Hidden Field 
The HTML Hidden Field plug-in (Fig. 104) is used to add hidden fields to an 
InForm document that will be exported to HTML.  

 

Fig. 104 HTML Hidden Field plug-in button/icon 

Hidden fields allow data that a user cannot see or interact with, to be 
posted when a HTML form is submitted. 

EXAMPLE: 
You could add a hidden field to a form that contained the name or ID of 
the form. 

MORE: 
For details about adding and configuring a hidden field, refer to Getting 
Started > Non-Visual Form Elements. 

Licensing 

The HTML Hidden Field plug-in is automatically licensed when any 
common InForm Plug-in is licensed. 

MORE: 
For further details about common and HTML InForm Plug-in associations, 
refer to Introduction > Plug-in Power! > Associated InForm Plug-ins. 

HTML Tag 

A hidden field within a HTML form has the following HTML tag: 

<input type=”hidden”> 

MORE: 
For further details about HTML tags, refer to Creating HTML Forms > HTML 
Form Elements. 

Properties 

The HTML Hidden Field plug-in has the following properties: 

Name 
Value 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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HTML Image 
The HTML Image plug-in (Fig. 105) is used to add images and form submit 
buttons to an InForm document that will be exported to HTML. 

 

Fig. 105 HTML Image plug-in button/icon 

NOTE: 
The common Image plug-in can also be used to create images and form 
submit buttons for use within a HTML form. However, certain properties 
are unsupported by HTML and are ignored. 

MORE: 
For further details about images, refer to Common InForm Plug-ins > 
Image. 

MORE: 
For details about adding, selecting, moving, resizing and styling an image, 
refer to Working with Form Elements. 

Image Considerations 

MORE: 
For details about the recommended image resolution, width, height, 
colour mode and file format, refer to Creating HTML Forms > 
Considerations > Images. 

Specifying a Submit Button 

MORE: 
For details about how to specify an image as a form submit button, refer 
to HTML InForm Plug-ins > HTML Button. 

Licensing 

The HTML Image plug-in is automatically licensed when the common 
Image plug-in is licensed. 

MORE: 
For further details about common and HTML InForm Plug-in associations, 
refer to Introduction > Plug-in Power! > Associated InForm Plug-ins. 

HTML Tag 

An image within a HTML form has the following HTML tag: 
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<img /> 

If the image has been specified as a form submit button, an image within 
a HTML form has the following HTML tag: 

<input type=”image”> 

MORE: 
For further details about HTML tags, refer to Creating HTML Forms > HTML 
Form Elements. 

Properties 

The HTML Image plug-in has the following properties: 

Name 
Filename 
+General 

Lock 
Proportional 
Hint 
Web Link 
Web Target 
Publish 

+Position & Size 
Left 
Top 
Width 
Height 

+Border 
Width 
Color 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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HTML Label 
The HTML Label plug-in (Fig. 106) is used to add non-interactive text 
labels to an InForm document that will be exported to HTML. 

 

Fig. 106 HTML Label plug-in button/icon 

NOTE: 
The common Label plug-in can also be used to create labels for use within 
a HTML form. However, certain properties are unsupported by HTML and 
are ignored. 

MORE: 
For further details about labels, refer to Common InForm Plug-ins > Label. 

MORE: 
For details about adding, selecting, moving, resizing and styling a label, 
refer to Working with Form Elements. 

Licensing 

The HTML Label plug-in is automatically licensed when the common Label 
plug-in licensed. 

MORE: 
For further details about common and HTML InForm Plug-in associations, 
refer to Introduction > Plug-in Power! > Associated InForm Plug-ins. 

HTML Tag 

A label within a HTML form has the following HTML tag: 

<label></label> 

MORE: 
For further details about HTML tags, refer to Creating HTML Forms > HTML 
Form Elements. 

Properties 

The HTML Label plug-in has the following properties: 

Name 
General 

Lock 
Default Text 
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Web Link 
Web Target 
Publish 

+Position & Size  
Left 
Top 
Width 
Height 

+Border 
Width 
Color 

+Fill 
Color 

+Pad 
Top 
Right 
Bottom 
Left 

+Character 
Font 
Size 
+Style 

Bold 
Italic 
Underlined 
Strikethrough 
Upper Case 

Color 
+Paragraph 

Horizontal Alignment 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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HTML Numeric Text Box 
The HTML Numeric Text Box plug-in (Fig. 107) is used to add numeric text 
boxes (text fields) (Fig. 108) to an InForm document that will be exported 
to HTML.  

 

Fig. 107 HTML Numeric Text Box plug-in button/icon 

 

Fig. 108 Example HTML numeric text box 

Numeric text boxes allow users of HTML forms to specify numeric values 
that are validated when a form is submitted. 

NOTE: 
The common Text Box plug-in can also be used to create numeric text 
boxes for use within a HTML form by setting the Input Type property 
within the General property group to Number. However, certain common 
Text Box plug-in properties are unsupported by HTML and are ignored. 

MORE: 
For further details about numeric text boxes, refer to Common InForm 
Plug-ins > Text Box. 

MORE: 
For details about adding, selecting, moving, resizing and styling a numeric 
text box, refer to Working with Form Elements. 

Licensing 

The HTML Numeric Text Box plug-in is automatically licensed when the 
common Text Box plug-in is licensed. 

MORE: 
For further details about common and HTML InForm Plug-in associations, 
refer to Introduction > Plug-in Power! > Associated InForm Plug-ins. 

HTML Tag 

HTML does not have a specific HTML tag for a numeric text box. Instead a 
text field tag is used and validation is automatically applied to ensure only 
an email in a valid format is posted when a HTML form is submitted: 

<input type=”text”> 
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MORE: 
For further details about HTML tags, refer to Creating HTML Forms > HTML 
Form Elements. 

Properties 

The HTML Numeric Text Box plug-in has the following properties: 

Name 
+General 

Lock 
Hint 
Default Text 
Read Only 
Publish 

+Position & Size 
Left 
Top 
Width 
Height 

+Border 
Width 
Color 

+Fill 
Color 

+Pad 
Top 
Right 
Bottom 
Left 

+Character 
Font 
Size 
+Style 

Bold 
Italic 
Underlined 
Strikethrough 
Upper Case 

Color 
+Paragraph 

Horizontal Alignment 
+Validation 

Required 
Maximum Characters 
Minimum Value 
Maximum Value 
Error Messages 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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HTML Password Text Box 
The HTML Password Text Box plug-in (Fig. 109) is used to add password 
text boxes (text fields) (Fig. 110) to an InForm document that will be 
exported to HTML.  

 

Fig. 109 HTML Password Text Box plug-in button/icon 

 

Fig. 110 Example HTML password text box 

Password text boxes allow users of HTML forms to specify passwords, the 
characters of which are hidden from view when typed by the user. 

NOTE: 
The common Text Box plug-in can also be used to create password text 
boxes for use within a HTML form by setting the Input Type property 
within the General property group to Password. However, certain 
common Text Box plug-in properties are unsupported by HTML and are 
ignored. 

MORE: 
For further details about password text boxes, refer to Common InForm 
Plug-ins > Text Box. 

MORE: 
For details about adding, selecting, moving, resizing and styling an email 
text box, refer to Working with Form Elements. 

Comparing Two Passwords 

It is common practice when users of forms are asked to specify a password 
that the password is entered again in another field. This helps to ensure 
the password specified is correct and no misstypes occurred. 

To compare one password with another, perform the following actions: 

1. Select the initial password text box. 
2. Open the Validation property group. 
3. Select the “repeat” password text box from the Must Also Match 

property list box. 

MORE: 
For further details about applying validation, refer to Working with Form 
Elements > Applying Validation. 
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Licensing 

The HTML Password Text Box plug-in is automatically licensed when the 
common Text Box plug-in is licensed. 

MORE: 
For further details about common and HTML InForm Plug-in associations, 
refer to Introduction > Plug-in Power! > Associated InForm Plug-ins. 

HTML Tag 

A password text box within a HTML form has the following HTML tag: 

<input type=”password”> 

MORE: 
For further details about HTML tags, refer to Creating HTML Forms > HTML 
Form Elements. 

Properties 

The HTML Password Text Box plug-in has the following properties: 

Name 
+General 

Lock 
Hint 
Default Text 
Read Only 
Publish 

+Position & Size 
Left 
Top 
Width 
Height 

+Border 
Width 
Color 

+Fill 
Color 

+Pad 
Top 
Right 
Bottom 
Left 

+Character 
Font 
Size 
+Style 

Bold 
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Italic 
Underlined 
Strikethrough 
Upper Case 

Color 
+Paragraph 

Horizontal Alignment 
+Validation 

Required 
Maximum Characters 
Must Also Match 
Must Also Check 
Error Messages 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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HTML Radio Button 
The HTML Radio Button plug-in (Fig. 111) is used to add radio buttons (Fig. 
112) to an InForm document that will be exported to HTML. 

 

Fig. 111 HTML Radio Button plug-in button/icon 

 

Fig. 112 Example HTML radio buttons 

Radio buttons allow users of HTML forms to select or deselect them in 
order to indicate a single choice amongst a group of choices. 

NOTE: 
The common Radio Button plug-in can also be used to create radio 
buttons for use within a HTML form. However, certain functionality 
available to radio buttons created this way, such as specifying the border, 
colour, and the checked and unchecked characters, is unsupported by 
HTML and is ignored. 

NOTE: 
Most Internet browsers tend to display radio buttons in a standard/default 
style. For this reason radio buttons created using the HTML Radio Button 
plug-in appear within an InForm document in this standard/default 
format. 

MORE: 
For further details about radio buttons, refer to Common InForm Plug-ins 
> Radio Button. 

MORE: 
For details about adding, selecting, moving, resizing and styling a radio 
button, refer to Working with Form Elements. 

Specifying a Selected Submit Value 

MORE: 
For details about how to specify a selected submit value for a radio 
button, refer to HTML InForm Plug-ins > HTML Check Box > Specifying a 
Selected Submit Value. 
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Licensing 

The HTML Radio Button plug-in is automatically licensed when the 
common Radio Button plug-in is licensed. 

MORE: 
For further details about common and HTML InForm Plug-in associations, 
refer to Introduction > Plug-in Power! > Associated InForm Plug-ins. 

HTML Tag 

A radio button within a HTML form has the following HTML tag: 

<input type=”radio”> 

MORE: 
For further details about HTML tags, refer to Creating HTML Forms > HTML 
Form Elements. 

Properties 

The HTML Radio Button plug-in has the following properties: 

Name 
Group ID 
+General 

Lock 
Hint 
Default State 
Submit Value 
Publish 

+Position & Size  
Left 
Top 
Width 
Height 

+Validation 
Required  
Must Also Fill 
Error Messages 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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HTML Text Area 
The HTML Text Area plug-in (Fig. 113) is used to add multi-line text areas 
(Fig. 114) to an InForm document that will be exported to HTML.  

 

Fig. 113 HTML Text Area plug-in button/icon 

 

Fig. 114 Example HTML text area 

NOTE: 
The common Text Box plug-in can also be used to create text areas for use 
within a HTML form by setting the Word Wrap property within the 
Paragraph property group to Yes. However, certain common Text Box 
plug-in properties are unsupported by HTML and are ignored. 

MORE: 
For further details about text areas, refer to Common InForm Plug-ins > 
Text Box. 

MORE: 
For details about adding, selecting, moving, resizing and styling a text 
area, refer to Working with Form Elements. 

Licensing 

The HTML Text Area plug-in is automatically licensed when the common 
Text Box plug-in is licensed. 

MORE: 
For further details about common and HTML InForm Plug-in associations, 
refer to Introduction > Plug-in Power! > Associated InForm Plug-ins. 

HTML Tag 

A text area within a HTML form has the following HTML tag: 

<textarea></textarea> 
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MORE: 
For further details about HTML tags, refer to Creating HTML Forms > HTML 
Form Elements. 

Properties 

The HTML Text Area plug-in has the following properties: 

Name 
+General 

Lock 
Hint 
Default Text 
Read Only 
Publish 

+Position & Size 
Left 
Top 
Width 
Height 

+Border 
Width 
Color 

+Fill 
Color 

+Pad 
Top 
Right 
Bottom 
Left 

+Character 
Font 
Size 
+Style 

Bold 
Italic 
Underlined 
Strikethrough 
Upper Case 

Color 
+Paragraph 

Horizontal Alignment 
+Validation 

Required 
Error Messages 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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HTML Text Box 
The HTML Text Box plug-in (Fig. 115) is used to add single-line text boxes 
(text fields) (Fig. 116) to an InForm document that will be exported to 
HTML.  

 

Fig. 115 HTML Text Box plug-in button/icon 

 

Fig. 116 Example HTML text box 

NOTE: 
The common Text Box plug-in can also be used to create text boxes for 
use within a HTML form. However, certain properties are unsupported by 
HTML and are ignored. 

MORE: 
For further details about text boxes, refer to Common InForm Plug-ins > 
Text Box. 

MORE: 
For details about adding, selecting, moving, resizing and styling a text 
box, refer to Working with Form Elements. 

Licensing 

The HTML Text Box plug-in is automatically licensed when the common 
Text Box plug-in is licensed. 

MORE: 
For further details about common and HTML InForm Plug-in associations, 
refer to Introduction > Plug-in Power! > Associated InForm Plug-ins. 

HTML Tag 

A text box (text field) within a HTML form has the following HTML tag: 

<input type=”text”> 

MORE: 
For further details about HTML tags, refer to Creating HTML Forms > HTML 
Form Elements. 
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Properties 

The HTML Text Box plug-in has the following properties: 

Name 
+General 

Lock 
Hint 
Default Text 
Read Only 
Publish 

+Position & Size 
Left 
Top 
Width 
Height 

+Border 
Width 
Color 

+Fill 
Color 

+Pad 
Top 
Right 
Bottom 
Left 

+Character 
Font 
Size 
+Style 

Bold 
Italic 
Underlined 
Strikethrough 
Upper Case 

Color 
+Paragraph 

Horizontal Alignment 
+Validation 

Required 
Maximum Characters 
Must Also Match 
Must Also Check 
Error Messages 

MORE: 
For a description of each property, refer to Appendix A: Properties. 



HTML InForm Plug-ins  

InForm Designer User Guide 231 

HTML Time Box 
The HTML Time Box plug-in (Fig. 117) is used to add time boxes (text 
fields) (Fig. 118) to an InForm document that will be exported to HTML.  

 

Fig. 117 HTML Time Box plug-in button/icon 

 

Fig. 118 Example HTML time box 

Time boxes allow users of HTML forms to specify times that are validated 
when a form is submitted. 

NOTE: 
The common Time Box plug-in can also be used to create time boxes for 
use within a HTML form. However, certain properties are unsupported by 
HTML and are ignored. 

MORE: 
For further details about time boxes, refer to Common InForm Plug-ins > 
Time Box. 

MORE: 
For details about adding, selecting, moving, resizing and styling a time 
box, refer to Working with Form Elements. 

Licensing 

The HTML Time Box plug-in is automatically licensed when the common 
Time Box plug-in licensed. 

MORE: 
For further details about common and HTML InForm Plug-in associations, 
refer to Introduction > Plug-in Power! > Associated InForm Plug-ins. 

HTML Tag 

HTML does not have a specific HTML tag for a time box. Instead a text field 
tag is used and validation is automatically applied to ensure only a valid 
time is posted when a HTML form is submitted: 

<input type=”text”> 
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MORE: 
For further details about HTML tags, refer to Creating HTML Forms > HTML 
Form Elements. 

Properties 

The HTML Time Box plug-in has the following properties: 

Name 
Input Format 
+General 

Lock 
Hint 
Default Text 
Read Only 
Publish 

+Position & Size 
Left 
Top 
Width 
Height 

+Border 
Width 
Color 

+Fill 
Color 

+Pad 
Top 
Right 
Bottom 
Left 

+Character 
Font 
Size 

+Style 
Bold 
Italic 
Underlined 
Strikethrough 
Upper Case 

Color 
+Paragraph 

Horizontal Alignment 
+Validation 

Required  
Error Messages 

MORE: 
For a description of each property, refer to Appendix A: Properties. 
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Technical Support and 
Troubleshooting 

In this section the following information is provided: 

• Staying Up-to-date 
• Finding Answers to Common Questions 
• Requesting Support 
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Staying Up-to-date 
One of the best ways to help ensure your experience with InForm 
Designer is problem-free is to keep your installation up-to-date.  

MORE: 
For further details about updating InForm Designer, refer to Getting 
Started > Updating.  
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Finding Answers to Common Questions 
A Knowledge Base, where answers to common InForm Designer questions 
appear, can be found on the following Fly Software web page: 

http://www.flysoftware.com/support/knowledge_base.asp 

NOTE: 
If you encounter a problem, please refer to the Knowledge Base for a 
solution before requesting support from Fly Software. 

http://www.flysoftware.com/support/knowledge_base.asp
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Requesting Support 
Fly Software operate a support ticket system for anyone who encounters a 
problem using InForm Designer.  

NOTE: 
If you encounter a problem, please consult the Knowledge Base for a 
solution before submitting a support ticket. 

Support tickets can be submitted on the following Fly Software web page: 

http://www.flysoftware.com/user_account/support_form.asp 

NOTE: 
To submit or view support tickets, you must login, or sign-up for a Fly 
Software User Account. 

http://www.flysoftware.com/user_account/support_form.asp
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Appendix A: Properties 

This section describes all properties and associated values that 
dynamically appear in InForm Designer’s Property Inspector. 

Properties are listed alphabetically. Each property table contains available 
values, the unit of measurement, the default value, the property group it is 
contained in, the plug-in(s) that use it and whether it is compatible when 
creating a HTML form. 

NOTE: 
Bracketed text appending a property name appears in order to distinguish 
the property from another property with the same name. 

3D 

Determines whether a 3D bevel effect is applied to a button. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 
General Button No 

Yes n/a  

MORE: 
Common InForm Plug-ins > Button > Applying a 3D Effect. 

Actions 

Determines the action(s) applied to a button. 

Value Unit Default Group Plug-in(s) HTML 

Actions contained in Actions dialog n/a   Button No 

MORE: 
Common InForm Plug-ins > Button > Actions. 

Allow Down 

Determines whether the “push down” animation on a button is used. 
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Value Unit Default Group Plug-in(s) HTML 

No n/a  
General Button No 

Yes n/a / 

MORE: 
Common InForm Plug-ins > Button > Button Animation. 

Allow No Selection 

Determines whether the no selection state of a check box is used. 

Value Unit Default Group Plug-in(s) HTML 

No n/a  
General Check Box No 

Yes n/a / 

MORE: 
Common InForm Plug-ins > Check Box > Disabling No Selection. 

Always Display 

Determines whether a combo box button is continually displayed or only 
when a combo box is selected. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 
Button Combo Box No 

Yes n/a  

MORE: 
Common InForm Plug-ins > Combo Box > Configuring the Button > 
Always Displaying. 

Automatic Drop 

Determines whether a combo box list is displayed as soon as the combo 
box is selected. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 
List Combo Box No 

Yes n/a  
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MORE: 
Common InForm Plug-ins > Combo Box > Configuring the Drop-down List 
> Displaying When Selected. 

Bold 

Determines whether form element text is bold. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 

Style 

Button 
Calculation Box 
Check Box 
Combo Box 
Date Box 
Label 
Radio Button 
Text Box 
Time Box 

Yes 

Yes n/a  

MORE: 
Working With Form Elements > Manipulating Text > Changing the Font, 
Size, Style and Color. 

Bottom (Margins) 

Determines how far from the bottom edge of a page, the bottom plane of 
the margin is positioned. 

Value Unit Default Group Plug-in(s) HTML 

Numeric mm 15 Margins Page No 

MORE: 
Working With Pages > Margins. 

Bottom (Pad) 

Determines how far the content of a form element is positioned from the 
inside bottom edge of its placeholder. 

Value Unit Default Group Plug-in(s) HTML 

Numeric Pixels 0 Pad 
Button 
Calculation 
Box 

Yes 
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Check Box 
Combo Box 
Date Box 
Image 
Label 
Radio Button 
Shape 
Text Box 
Time Box 

MORE: 
Working With Form Elements > Adding a Pad. 

Buttons 

Determines the button(s) used in a button dialog. 

Value Unit Default Group Plug-in(s) HTML 

OK n/a / 

Confirmation Button No OK & Cancel n/a  

Yes & No n/a  

MORE: 
Common InForm Plug-ins > Button > Including a Post-click Dialog > 
Specifying Content. 

Can Be Reset 

Determines whether a form element is reset when a form is reset. 

Value Unit Default Group Plug-in(s) HTML 

No n/a  
On Reset 

Form 

Check Box 
Combo Box 
Date Box 
Radio Button 
Text Box 
Time Box 

No 

Yes n/a / 

MORE: 
Getting Started > Resetting Forms. 
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Color (Border) 

Determines the border color of a form element. 

Value Unit Default Group Plug-in(s) HTML 

Colors 
Name 

or 
#value 

clBlack Border 

Button 
Calculation Box 
Check Box 
Combo Box 
Date Box 
Image 
Label 
Radio Button 
Shape 
Text Box 
Time Box 

Yes 

MORE: 
Working With Form Elements > Adding a Border > Changing the Color. 

Color (Character) 

Determines the color of form element text. 

Value Unit Default Group Plug-in(s) HTML 

Colors 
Name 

or 
#value 

clBlack Character 

Button 
Calculation Box 
Combo Box 
Date Box 
Label 
Text Box 
Time Box 

Yes 

MORE: 
Working With Form Elements > Manipulating Text > Changing the Font, 
Size, Style and Color. 

Color(Checked) 

Determines the color of the “checked” character in a check box or radio 
button. 

Value Unit Default Group Plug-in(s) HTML 

Colors 
Name 

or 
clBlack Checked 

Check Box 
Radio Button 

No 
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#value 

MORE: 
Working With Form Elements > Manipulating Text > Changing the Font, 
Size, Style and Color. 

Color (Fill) 

Determines the fill color of a form element or page. 

Value Unit Default Group Plug-in(s) HTML 

Colors 
Name 

or 
#value 

clNone Fill 

Button 
Calculation Box 
Combo Box 
Date Box 
Label 
Page 
Shape 
Text Box 
Time Box 

Yes 

Color (No Selection) 

Determines the color of the “no selection” character in a check box or 
radio button. 

Value Unit Default Group Plug-in(s) HTML 

Colors 
Name 

or 
#value 

clBlack No Selection 
Check Box 
Radio Button 

No 

MORE: 
Working With Form Elements > Manipulating Text > Changing the Font, 
Size, Style and Color. 

Color (Unchecked) 

Determines the color of the “unchecked” character in a check box or radio 
button. 

Value Unit Default Group Plug-in(s) HTML 
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Colors 
Name 

or 
#value 

clBlack Unchecked 
Check Box 
Radio Button 

No 

MORE: 
Working With Form Elements > Manipulating Text > Changing the Font, 
Size, Style and Color. 

Color Checked 

Determines the “checked” fill color of a check box or radio button. 

Value Unit Default Group Plug-in(s) HTML 

Colors 
Name 

or 
#value 

clBlank Fill 
Check Box 
Radio Button 

No 

MORE: 
Working With Form Elements > Adding a Fill > Changing the Color. 

Color No Selection 

Determines the “no selection” fill color of a check box or radio button. 

Value Unit Default Group Plug-in(s) HTML 

Colors 
Name 

or 
#value 

clBlank Fill Check Box No 

MORE: 
Working With Form Elements > Adding a Fill > Changing the Color. 

Color Unchecked 

Determines the “unchecked” fill color of a check box. 

Value Unit Default Group Plug-in(s) HTML 

Colors 
Name 

or 
#value 

clBlank Fill 
Check Box 
Radio Button 

No 

MORE: 
Working With Form Elements > Adding a Fill > Changing the Color. 
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Confirmation Dialog 

Determines whether a dialog is displayed after clicking a button. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 
Confirmation Button No 

Yes n/a  

MORE: 
Common InForm Plug-ins > Button > Including a Post-click Dialog. 

Curve 

Determines the amount of curve applied to the corners of rectangle and 
square shapes. The higher the number, the larger the curve. 

Value Unit Default Group Plug-in(s) HTML 

Numeric mm 0 Border Shape No 

MORE: 
Common InForm Plug-ins > Shape > Rounding Corners. 

Custom Text (Checked) 

Determines the “checked” text of a check box or radio button when the 
Item property value is Custom. 

Value Unit Default Group Plug-in(s) HTML 

Alphanumeric n/a Blank Checked 
Check Box 
Radio Button 

No 

MORE: 
Common InForm Plug-ins > Check Box > Defining Checked, Unchecked 
and No Selection States > Character Configuration > Custom Characters. 

Custom Text (No Selection) 

Determines the “no selection” text of a check box or radio button when 
the Item property value is Custom. 
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Value Unit Default Group Plug-in(s) HTML 

Alphanumeric n/a Blank No Selection Check Box No 

MORE: 
Common InForm Plug-ins > Check Box > Defining Checked, Unchecked 
and No Selection States > Character Configuration > Custom Characters. 

Custom Text (Unchecked) 

Determines the “unchecked” text of a check box or radio button when the 
Item property value is Custom. 

Value Unit Default Group Plug-in(s) HTML 

Alphanumeric n/a Blank Unchecked 
Check Box 
Radio Button 

No 

 

MORE: 
Common InForm Plug-ins > Check Box > Defining Checked, Unchecked 
and No Selection States > Character Configuration > Custom Characters. 

Decimal Places 

Determines how many decimal places a value in a numeric form element 
should have. 

Value Unit Default Group Plug-in(s) HTML 

Numeric n/a 2 Number 
Calculation Box 
Combo Box 
Text Box 

No 

MORE: 
Working With Form Elements > Manipulating Numbers > Decimal Places. 

Decimal Point 

Determines whether the decimal point (period) (.) key can be used for 
tabbing from one form element to another. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / Tab On Combo Box No 
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Yes n/a  Text Box 

MORE: 
Working With Form Elements > Tabbing > Defining Automated Tabbing 
Rules. 

Default Focus 

Determines which form element is initially focused (selected) when an 
InForm document is opened in Filler mode or InForm Filler. 

Value Unit Default Group Plug-in(s) HTML 

Any interactive form element on a 
page 

n/a Blank n/a Page No 

MORE: 
Working With Form Elements > Tabbing > Defining the Default Focus. 

Default State (Check Box) 

Determines the default state of a check box. 

Value Unit Default Group Plug-in(s) HTML 

Unchecked n/a / 

General Check Box Yes Checked n/a  

No Selection n/a  

Default State (Radio Button) 

Determines the default state of a radio button. 

Value Unit Default Group Plug-in(s) HTML 

Unchecked n/a / 
General Radio Button Yes 

Checked n/a  

Default Text 

Determines the default text of a form element. 
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Value Unit Default Group Plug-in(s) HTML 

Alphanumeric n/a Blank General 

Button 
Combo Box 
Date Box 
Label 
Text Box 
Time Box 

Yes 

MORE: 
Common InForm Plug-ins > Label > Adding and Modifying Text. 

Default View 

Determines the default page view when an InForm document is opened. 

Value Unit Default Group Plug-in(s) HTML 

Current n/a / 

n/a Page No 
Actual Size n/a  

Fit to Width n/a  

Fit to Page n/a  

MORE: 
Working With Pages > Magnifying or Reducing the View > Specifying a 
Default. 

Display  

Determines whether a form element is displayed in either Filler mode or 
InForm Filler. 

Value Unit Default Group Plug-in(s) HTML 

No n/a  

General 

Calculation Box 
Date Box 
Image 
Label 
Text Box 
Time Box 

No 
Yes n/a / 

MORE: 
Common InForm Plug-ins > Label > Using as Design Notes. 
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Display (Background) 

Determines whether a background image or PDF is displayed in either 
Filler mode or InForm Filler. 

Value Unit Default Group Plug-in(s) HTML 

No n/a  
Background Page No 

Yes n/a / 

MORE: 
Working With Pages > Adding Background Effects > Image and PDF > 
Showing and Hiding. 

Display (Margins) 

Determines whether margins are displayed in Designer mode.  

Value Unit Default Group Plug-in(s) HTML 

No n/a  
Margins Page No 

Yes n/a / 

NOTE: 
In Filler mode and InForm Filler margins are never displayed. 

MORE: 
Working With Pages > Margins > Showing and Hiding. 

Display Zero 

Determines whether 0 (or 0.00) or nothing is displayed in a numeric form 
element prior to a value being typed within it. 

Value Unit Default Group Plug-in(s) HTML 

No n/a  
Number 

Calculation Box 
Combo Box 
Text Box 

No 
Yes n/a / 

MORE: 
Working With Form Elements > Manipulating Numbers > Hiding Zero(s). 
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Drop Rows 

Determines the number of rows (option lines) a combo box list drops 
when it is displayed. 

Value Unit Default Group Plug-in(s) HTML 

Numeric n/a 8 List Combo Box No 

MORE: 
Common InForm Plug-ins > Combo Box > Configuring the Drop-down List 
> Changing the Drop Length. 

Error Messages 

Determines the error message associated with each type of validation a 
form element supports. Error messages are displayed in the Validation 
failed dialog (Fig. 23). 

Value Unit Default Group Plug-in(s) HTML 

Failed Validation 
Error Message 

n/a n/a Validation 

Check Box 
Combo Box 
Date Box 
Image 
Radio Button 
Text Box 
Time Box 

Yes 

MORE: 
Working With Form Elements > Applying Validation. 

Enter Key 

Determines whether the Enter key can be used for tabbing from one form 
element to another. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 

Tab On 

Button 
Check Box 
Combo Box 
Date Box 
Image 
Radio Button 
Text Box 
Time Box 

No 

Yes n/a  
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MORE: 
Working With Form Elements > Tabbing > Defining Tabbing Keys. 

Expression 

Determines the math expression used to calculate the value of a 
calculation box. 

Value Unit Default Group Plug-in(s) HTML 

Math expression n/a Blank n/a Calculation Box No 

MORE: 
Common InForm Plug-ins > Calculation Box > Defining Expressions. 

File Name (Image) 

Determines the filename of an image or PDF to be used as a form element. 

Value Unit Default Group Plug-in(s) HTML 

Filename.xxx n/a Blank n/a Image 
Yes 

(images only) 

MORE: 
Common InForm Plug-ins > Image > Adding an Image. 

File Name (Background) 

Determines the filename of an image or PDF to be used as a page 
background. 

Value Unit Default Group Plug-in(s) HTML 

Filename.xxx n/a Blank Background Page No 

MORE: 
Working With Pages > Adding Background Effects > Image and PDF. 

File Name (Button Image) 

Determines the filename of an image to be used for a button. 

Value Unit Default Group Plug-in(s) HTML 

Filename.xxx n/a Blank Image Button Yes 
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MORE: 
Common InForm Plug-ins > Button > Adding an Image. 

Fit To 

Determines how the background image or PDF is resized on a page. 

Value Unit Default Group Plug-in(s) HTML 

Full Page n/a / 
Background Page No 

Page Margins n/a  

MORE: 
Working With Pages > Adding Background Effects > Resizing to the Page 
or Margins. 

Fixed Size 

Determines whether the size of text in a text box can be changed in Filler 
mode or InForm Filler. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 
Character Text Box No 

Yes n/a  

MORE: 
Common InForm Plug-ins > Text Box > Forcing Text Size. 

Font 

Determines the font (typeface) of form element text. 

Value Unit Default Group Plug-in(s) HTML 

Any font installed in Windows® n/a Arial Character 

Button 
Calculation Box 
Combo Box 
Date Box 
Label 
Text Box 
Time Box 

Yes 

MORE: 
Working With Form Elements > Manipulating Text > Changing the Font, 
Size, Style and Color. 
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Group ID 

Determines the Group ID of a group of check boxes or radio buttons so 
they operate as one. 

Value Unit Default Group Plug-in(s) HTML 

Numeric Dec -1 n/a 
Check Box 
Radio Button 

Yes (Radio 
Button only) 

MORE: 
Common InForm Plug-ins > Radio Button > Creating Radio Button Groups. 

Height (Button Image) 

Determines the height of a button image. 

Value Unit Default Group Plug-in(s) HTML 

Numeric Pixels  Image Button Yes 

MORE: 
Common InForm Plug-ins > Button > Adding an Image > Positioning and 
Resizing. 

Height (Fixed Pitch) 

Determines the height of fixed pitch boxes. 

Value Unit Default Group Plug-in(s) HTML 

Numeric mm 5 Fixed 

Calculation 
Box 
Combo Box 
Date Box 
Label 
Text Box 
Time Box 

No 

MORE: 
Working With Form Elements > Adding Fixed Pitch Boxes. 

Height (Paper) 

Determines the height of the paper (page). 
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Value Unit Default Group Plug-in(s) HTML 

Numeric mm * Paper Page Yes 

*NOTE: 
When creating a new InForm document, the default value is determined 
by the corresponding printer driver properties of the selected printer. 

MORE: 
Working With Pages > Changing the Size and Orientation. 

Height (Form Element) 

Determines the height of a form element. 

Value Unit Default Group Plug-in(s) HTML 

Numeric mm 
User 

defined 
Position & 

Size 

Button 
Calculation Box 
Check Box 
Combo Box 
Date Box 
Image 
Label 
Radio Button 
Shape 
Text Box 
Time Box 

Yes 

MORE: 
Working With Form Elements > Resizing > By Changing Properties. 

Hint 

Determines the hint/tooltip displayed when the mouse cursor is 
positioned over a form element. Also determines the title and alt 
attributes of a HTML form element. 

Value Unit Default Group Plug-in(s) HTML 

Alphanumeric n/a Blank General 

Button 
Calculation Box 
Check Box 
Combo Box 
Date Box 
Image 
Label 
Radio Button 

Yes 
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Shape 
Text Box 
Time Box 

MORE: 
Working With Form Elements > Adding a Hint. 

Horizontal Alignment 

Determines the horizontal alignment of text in a form element. 

Value Unit Default Group Plug-in(s) HTML 

Left n/a / 

Paragraph 

Button 
Calculation Box 
Combo Box 
Date Box 
Label 
Text Box 
Time Box 

Yes 
Right n/a 

/ 
Calculation Box 

Center n/a  

MORE: 
Working With Form Elements > Manipulating Text > Changing Horizontal 
and Vertical Alignment. 

Horizontal Gap 

Determines the width of the horizontal gap between multi-row fixed pitch 
boxes. 

Value Unit Default Group Plug-in(s) HTML 

Numeric mm 0 Fixed 

Calculation Box 
Combo Box 
Date Box 
Label 
Text Box 
Time Box 

No 

MORE: 
Working With Form Elements > Adding Fixed Pitch Boxes. 

Icon 

Determines the icon used in a button dialog. 

Value Unit Default Group Plug-in(s) HTML 
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Confirmation n/a / 

Confirmation Button No 
Error n/a  

Information n/a  

Warning n/a  

MORE: 
Common InForm Plug-ins > Button > Including a Post-click Dialog > 
Specifying Content. 

Input Format (Date) 

Determines the format of the date that must be entered into a date box. 

Value Unit Default Group Plug-in(s) HTML 

d 
dd 
ddd 
dddd 
ddddd 
dddddd 
m 
mm 
mmm 
mmmm 
yy 
yyyy 

n/a * n/a Date Box 
Yes but only 
predefined 

formats 

*NOTE: 
The default input format is determined by the Windows® Regional and 
Language short date format. 

MORE: 
Common InForm Plug-ins > Date Box > Specifying Formats. 

Input Format (Time) 

Determines the format of the time that must be entered into a date box. 

Value Unit Default Group Plug-in(s) HTML 

h 
hh 
m 
mm 

n/a * n/a Time Box 
Yes but only 
predefined 

formats 
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s 
ss 
t 
tt 
am/pm 
a/p 

*NOTE: 
The default input format is determined by the Windows® Regional and 
Language short time format. 

MORE: 
Common InForm Plug-ins > Time Box > Specifying Formats. 

Input Type (Combo Box) 

Determines what type of data a combo box accepts. 

Value Unit Default Group Plug-in(s) HTML 

Anything n/a / 

General Combo Box No Number n/a  

Email Address n/a  

MORE: 
Common InForm Plug-ins > Combo Box > Specifying the Input Type. 

Input Type (Text Box) 

Determines what type of data a text box accepts. 

Value Unit Default Group Plug-in(s) HTML 

Anything n/a / 

General Text Box No 
Number n/a  

Email Address n/a  

Password n/a  

MORE: 
Common InForm Plug-ins > Text Box > Specifying the Input Type. 
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Italic 

Determines whether text in a form element is italic. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 

Style 

Button 
Calculation Box 
Check Box 
Combo Box 
Date Box 
Label 
Radio Button 
Text Box 
Time Box 

Yes 

Yes n/a  

MORE: 
Working With Form Elements > Manipulating Text > Changing the Font, 
Size, Style and Color. 

Item (Checked) 

Determines what “checked” character is displayed in a check box or radio 
button. 

Value Unit Default Group Plug-in(s) HTML 

Blank n/a  

Checked 
Check Box 
Radio Button 

No 

Tick n/a 
/ 

Check Box 

Cross n/a  

Circle n/a 
/ 

Radio Button 

Square n/a  

Custom n/a  

MORE: 
Common InForm Plug-ins > Check Box > Defining Checked, Unchecked 
and No Selection States > Character Configuration. 

Item (No Selection) 

Determines what “no selection” character is displayed in a check box. 
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Value Unit Default Group Plug-in(s) HTML 

Blank n/a / 

No Selection Check Box No 

Tick n/a  

Cross n/a  

Circle n/a  

Square n/a  

Custom n/a  

MORE: 
Common InForm Plug-ins > Check Box > Defining Checked, Unchecked 
and No Selection States > Character Configuration. 

Item (Unchecked) 

Determines what “unchecked” character is displayed in a check box or 
radio button. 

Value Unit Default Group Plug-in(s) HTML 

Blank n/a / 

Unchecked 
Check Box 
Radio Button 

No 

Tick n/a  

Cross n/a  

Circle n/a  

Square n/a  

Custom n/a  

MORE: 
Common InForm Plug-ins > Check Box > Defining Checked, Unchecked 
and No Selection States > Character Configuration. 

Items 

Determines the options found in a combo box list. 

Value Unit Default Group Plug-in(s) HTML 

Alphanumeric n/a Blank List Combo Box Yes 
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MORE: 
Common InForm Plug-ins > Combo Box > Adding and Modifying Drop-
down List Options. 

Left (Margins) 

Determines how far from the left edge of a page, the left plane of the 
margin is positioned. 

Value Unit Default Group Plug-in(s) HTML 

Numeric mm 25 Margins Page No 

MORE: 
Working With Pages > Margins. 

Left (Pad) 

Determines how far the content of a form element is positioned from the 
inside bottom edge of its placeholder. 

Value Unit Default Group Plug-in(s) HTML 

Numeric Pixels 0 Pad 

Button 
Calculation Box 
Check Box 
Combo Box 
Date Box 
Image 
Label 
Radio Button 
Shape 
Text Box 
Time Box 

Yes 

MORE: 
Working With Form Elements > Adding a Pad. 

Left (Form Element) 

Determines how far a form element is positioned from the left edge of a 
page. 

Value Unit Default Group Plug-in(s) HTML 
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Numeric mm 
User 

defined 
Position & 

Size 

Button 
Calculation Box 
Check Box 
Combo Box 
Date Box 
Image 
Label 
Radio Button 
Shape 
Text Box 
Time Box 

Yes 

MORE: 
Working With Form Elements > Moving > By Changing Properties. 

Link 

Determines which imported PDF is used as a page background or image. 

Value Unit Default Group Plug-in(s) HTML 

Name of imported PDF n/a Blank PDF 
Image 
Page 

No 

Lock  

Determines whether a form element in Designer mode is locked on a page 
so it cannot be moved or resized using the mouse or keyboard. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 

General 

Button 
Calculation Box 
Check Box 
Combo Box 
Date Box 
Image 
Label 
Radio Button 
Shape 
Text Box 
Time Box 

n/a 

Yes n/a  

MORE: 
Working With Form Elements > Locking. 
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Maximum Characters (Form Element) 

Determines the maximum number of characters that can be typed in a 
form element. 

Value Unit Default Group Plug-in(s) HTML 

Numeric mm 0 Validation 
Combo Box 
Text Box 

Yes 
(Text Box only) 

MORE: 
Common InForm Plug-ins > Text Box > Restricting Content > By Character 
Quantity. 

Maximum Characters (Tab On) 

Determines whether tabbing from one form element to another is 
performed when the maximum characters of a selected form element is 
reached. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 
Tab On 

Combo Box 
Text Box 

No 
Yes n/a  

MORE: 
Working With Form Elements > Tabbing > Defining Automated Tabbing 
Rules. 

Maximum Value 

Determines the maximum value that can be typed within a numeric form 
element. 

Value Unit Default Group Plug-in(s) HTML 

Numeric Dec 0 Validation 
Combo Box 
Text Box 

Yes 

MORE: 
Working With Pages > Manipulating Numbers > Specifying Minimum and 
Maximum Values. 
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Minimum Value 

Determines the minimum value that can be typed within a numeric form 
element. 

Value Unit Default Group Plug-in(s) HTML 

Numeric Dec 0 Validation 
Combo Box 
Text Box 

Yes 

MORE: 
Working With Pages > Manipulating Numbers > Specifying Minimum and 
Maximum Values. 

Mode 

Determines the effect to be applied to the fill of a shape. 

Value Unit Default Group Plug-in(s) HTML 

Always Black n/a  

Fill Shape No 

Always White n/a  

Unchanged n/a  

Inverse Background n/a  

Color n/a / 

Inverse Color n/a  

Merge With Inverse Color n/a  

Mask With Inverse Color n/a  

Inverse Merge With Color n/a  

Inverse Mask With Color n/a  

Merge (Combine Color/Background) n/a  

Inverse Merge n/a  

Mask (Combine Color/Background) n/a  

Inverse Mask n/a  

XOR (Combine Color/Background) n/a  

Inverse XOR n/a  
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MORE: 
Common InForm Plug-ins > Adding a Fill > Changing the Mode. 

Must Also Check 

Determines the name of a check box or radio button that must also be 
checked (selected) when a text box is filled in. 

Value Unit Default Group Plug-in(s) HTML 

Name of check box or radio button n/a n/a Validation Text Box Yes 

Must Also Fill 

Determines the name of a text box, date box or time box that must also be 
filled in when a check box or radio button is checked (selected). 

Value Unit Default Group Plug-in(s) HTML 

Name of text box, date box or time box n/a n/a Validation 
Check Box 
Radio Button 

Yes 

Must Also Match 

Determines the name of a text box, combo box, date box or time box the 
value of a text box must match. 

Value Unit Default Group Plug-in(s) HTML 

Name of text box, combo box, date 
box or time box 

n/a n/a Validation Text Box Yes 

Name (Form Element) 

Determines the name of a form element. 

Value Unit Default Group Plug-in(s) HTML 

Alphanumeric with no spaces n/a * None 

Button 
Calculation Box 
Check Box 
Combo Box 
Date Box 
Image 
Label 
Radio Button 

Yes 
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Shape 
Text Box 
Time Box 

*MORE: 
Working with Form Elements > Naming. 

Name (Non-Visual) 

Determines the name of a non-visual form element. 

Value Unit Default Group Plug-in(s) HTML 

Alphanumeric with no spaces n/a * n/a 
Non-visual PDF 
HTML Hidden Field 

Yes 

*MORE: 
Getting Started > Non-visual Form Elements. 

Numerics Only 

Determines whether a form element only allows numeric values. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 
Validation 

Combo Box 
Text Box 

No* 
Yes n/a  

*HTML TIP: 
Use the HTML Numeric Text Box. 

MORE: 
Working With Pages > Manipulating Numbers > Allowing Only Numbers. 

Orientation 

Determines the orientation of the paper (page). 

Value Unit Default Group Plug-in(s) HTML 

Portrait n/a * 
Paper Page Yes 

Landscape n/a * 



Appendix A: Properties 

InForm Designer User Guide 265 

*NOTE: 
The default value is determined by the corresponding printer driver 
properties of the selected printer. 

MORE: 
Working With Pages > Changing the Size and Orientation. 

Output Format (Date) 

Determines how the date is displayed in a date box. 

Value Unit Default Group Plug-in(s) HTML 

d 
dd 
ddd 
dddd 
ddddd 
dddddd 
m 
mm 
mmm 
mmmm 
yy 
yyyy 

n/a * n/a Date Box No 

*NOTE: 
The default output format is determined by the Windows® Regional and 
Language short date format. 

MORE: 
Common InForm Plug-ins > Date Box > Specifying Formats. 

Output Format (Time) 

Determines how the time is displayed in a time box. 

Value Unit Default Group Plug-in(s) HTML 

h 
hh 
m 
mm 
s 
ss 
t 
tt 
am/pm 
a/p 

n/a * n/a Time Box No 
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*NOTE: 
The default output format is determined by the Windows® Regional and 
Language short time format. 

MORE: 
Common InForm Plug-ins > Time Box > Specifying Formats. 

Pad 

Determines whether and where padding zeros are applied to a numeric 
form element. 

Value Unit Default Group Plug-in(s) HTML 

None n/a / 

Zero Pad 
Calculation Box 
Combo Box 
Text Box 

No Left n/a  

Right n/a  

MORE: 
Working With Form Elements > Manipulating Numbers > Padding With 
Zeros. 

Page 

Determines which page number of an imported PDF is used as a page 
background or image. 

Value Unit Default Group Plug-in(s) HTML 

1 to maximum pages in imported PDF Dec 1 PDF 
Image 
Page 

No 

PDF File Name 

Determines the filename of a selected non-visual PDF. 

Value Unit Default Group Plug-in(s) HTML 

Filename.pdf n/a 
File 

name of 
PDF 

n/a Non-visual PDF No 

MORE: 
Getting Started > Non-visual Form Elements. 
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Position (Combo Box Button) 

Determines the position of a combo box button. 

Value Unit Default Group Plug-in(s) HTML 

Inside n/a / 
Button Combo Box No 

Outside n/a  

MORE: 
Common InForm Plug-ins > Combo Box > Configuring the Button > 
Changing the Position. 

Position (Button Image) 

Determines the position of a button image. 

Value Unit Default Group Plug-in(s) HTML 

Left n/a / 

Image Button No 

Right n/a  

Top n/a  

Bottom n/a  

Background n/a  

MORE: 
Common InForm Plug-ins > Button > Configuring the Button > Changing 
the Position. 

Prompt 

Determines the prompt text displayed in a combo box. 

Value Unit Default Group Plug-in(s) HTML 

Alphanumeric n/a Blank General Combo Box Yes 

MORE: 
Common InForm Plug-ins > Combo Box >  Prompting Users. 

Proportional (Background) 

Determines whether a background image or PDF is resized proportionally. 
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Value Unit Default Group Plug-in(s) HTML 

No n/a  
Background Page Yes 

Yes n/a / 

MORE: 
Working With Pages > Adding Background Effects > Image and PDF. 

Proportional (Image) 

Determines whether an imported image remains proportional to its true 
shape. 

Value Unit Default Group Plug-in(s) HTML 

No n/a  
General Image Yes 

Yes n/a / 

MORE: 
Common InForm Plug-ins > Image > Adding an Image > Resizing Within 
the Entire Placeholder. 

Publish (Background) 

Determines whether a page background image or PDF is printed or 
exported to HTML. 

Value Unit Default Group Plug-in(s) HTML 

No n/a  
Background Page Yes 

Yes n/a / 

MORE: 
Working With Pages > Adding Background Effects > Publishing. 

Publish (Border) 

Determines whether a form element border is printed. 

Value Unit Default Group Plug-in(s) HTML 
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No n/a  

Border 

Calculation Box 
Check Box 
Combo Box 
Date Box 
Image 
Label 
Radio Button 
Shape 
Text Box 
Time Box 

No 

Yes n/a / 

MORE: 
Working with Form Elements > Publishing. 

Publish (Fill) 

Determines whether a form element fill is printed. 

Value Unit Default Group Plug-in(s) HTML 

No n/a  

Fill 

Calculation Box 
Check Box 
Combo Box 
Date Box 
Image 
Label 
Page 
Radio Button 
Shape 
Text Box 
Time Box 

No 

Yes n/a / 

MORE: 
Working with Form Elements > Publishing. 

Publish (Form Element) 

Determines whether a form element is printed or exported to HTML. 

Value Unit Default Group Plug-in(s) HTML 

No n/a 
/ 

(Button) 

General 

Button 
Calculation Box 
Check Box 
Combo Box 
Date Box 
Image 
Label 
Radio Button 

Yes 

Yes n/a / 
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Shape 
Text Box 
Time Box 

MORE: 
Working with Form Elements > Publishing. 

Publish (Page) 

Determines whether a page is printed or exported to HTML. 

Value Unit Default Group Plug-in(s) HTML 

No n/a  
n/a Page Yes 

Yes n/a / 

MORE: 
Working with Pages > Publishing. 

Read Only 

Determines whether a form element is read only (i.e. it cannot be 
interacted with in InForm Filler or Filler mode. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 

General 

Check Box 
Combo Box 
Date Box 
Image 
Radio Button 
Text Box 
Time Box 

No 

Yes n/a  

Required 

Determines whether a form element must be filled. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 

Validation 

Check Box 
Combo Box 
Date Box 
Image 
Radio Button 
Text Box 

Yes 

Yes n/a  



Appendix A: Properties 

InForm Designer User Guide 271 

Time Box 

MORE: 
Working with Form Elements > Forcing User Entry. 

Restrict To 

Determines what characters can be typed in a form element. 

Value Unit Default Group Plug-in(s) HTML 

Any characters n/a Blank Validation 
Text Box 
Combo Box 

No 

MORE: 
Common InForm Plug-ins > Text Box > Restricting Content > By Character. 

Right (Margins) 

Determines how far from the right edge of a page, the right plane of the 
margin is positioned. 

Value Unit Default Group Plug-in(s) HTML 

Numeric mm 15 Margins Page No 

MORE: 
Working With Pages > Margins. 

Right (Pad) 

Determines how far the content of a form element is positioned from the 
inside right edge of its placeholder. 

Value Unit Default Group Plug-in(s) HTML 

Numeric Pixels 0 Pad 

Button 
Calculation Box 
Check Box 
Combo Box 
Date Box 
Image 
Label 
Radio Button 
Shape 
Text Box 
Time Box 

Yes 



Appendix A: Properties  

272 InForm Designer User Guide 

MORE: 
Working With Form Elements > Adding a Pad. 

Separate Thousands 

Determines whether a comma (,) is used to separate the thousands in a 
numerical form element value. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 
Number 

Calculation Box 
Combo Box 
Text Box 

No 
Yes n/a  

MORE: 
Working With Form Elements > Manipulating Numbers > Separating 
Thousands. 

Size (Character) 

Determines the size of form element text. 

Value Unit Default Group Plug-in(s) HTML 

Numeric Points 10 Character 

Button 
Calculation Box 
Combo Box 
Date Box 
Label 
Text Box 
Time Box 

Yes 

MORE: 
Working With Form Elements > Manipulating Text > Changing the Font, 
Size, Style and Color. 

Size (Checked Character) 

Determines the size of the “checked” character in a check box or radio 
button. 

Value Unit Default Group Plug-in(s) HTML 

Numeric Points 12 Checked 
Check Box 
Radio Button 

No 
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MORE: 
Working With Form Elements > Manipulating Text > Changing the Font, 
Size, Style and Color. 

Size (No Selection Character) 

Determines the size of the “no selection” character in a check box or radio 
button. 

Value Unit Default Group Plug-in(s) HTML 

Numeric Points 12 No Selection 
Check Box 
Radio Button 

No 

MORE: 
Working With Form Elements > Manipulating Text > Changing the Font, 
Size, Style and Color. 

Size (Paper) 

Determines the paper (page) size. 

Value Unit Default Group Plug-in(s) HTML 

Standard paper sizes for the selected 
printer (e.g. A4 and Letter) and user 
defined paper size 

n/a * Paper Page Yes 

*NOTE: 
The default value is determined by the corresponding printer driver 
properties of the selected printer. 

MORE: 
Working With Pages > Changing the Size and Orientation. 

Size (Unchecked Character) 

Determines the size of the “unchecked” character in a check box. 

Value Unit Default Group Plug-in(s) HTML 

Numeric Points 12 Unchecked 
Check Box 
Radio Button 

No 

MORE: 
Working With Form Elements > Manipulating Text > Changing the Font, 
Size, Style and Color. 
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Sorted 

Determines whether the options in a combo box list are sorted 
alphanumerically. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 
List Combo Box No 

Yes n/a  

MORE: 
Working With Form Elements > Manipulating Text > Changing the Font, 
Size, Style and Color. 

Stamp 

Determines whether the current time or date is automatically applied to a 
time box or date box when an InForm document is saved. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 
General 

Date Box 
Time Box 

No 
Yes n/a  

MORE: 
Common InForm Plug-ins > Date Box > Displaying the Current Date > 
Creating a Date Stamp. 

State On Reset 

Determines the state of a check box or radio button after a form is reset. 

Value Unit Default Group Plug-in(s) HTML 

Unchecked n/a / 

On Reset Form 
Check Box 
Radio Button 

No Checked n/a  

No Selection n/a  

MORE: 
Working With Form Elements > Resetting. 
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Strikethrough 

Determines whether form element text is strikethrough (i.e. has a 
horizontal line through the middle of it). 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 

Style 

Button 
Calculation Box 
Check Box 
Combo Box 
Date Box 
Label 
Radio Button 
Text Box 
Time Box 

No 

Yes n/a  

MORE: 
Working With Form Elements > Manipulating Text > Changing the Font, 
Size, Style and Color. 

Style (Paragraph) 

Determines how form element text flows. 

Value Unit Default Group Plug-in(s) HTML 

Variable n/a / 

Paragraph 

Calculation Box 
Combo Box 
Date Box 
Label 
Text Box 
Time Box 

No 
Justified n/a  

Fixed n/a  

MORE: 
Working with Form Elements > Working With Text > Changing the 
Justification. 

Style (Shape) 

Determines a shape. 

Value Unit Default Group Plug-in(s) HTML 

Rectangle n/a  
Style Shape No 

Square n/a  
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Ellipse n/a / 

Circle n/a  

Horizontal Line n/a  

Vertical Line n/a  

Diagonal Line (\) n/a  

Diagonal Line (/) n/a  

MORE: 
Common InForm Plug-ins > Shape > Changing the Shape. 

Submit Value 

Determines the value that is posted when a Web form is submitted or an 
InForm document is posted to a URL, if the check box or radio button is 
selected. 

Value Unit Default Group Plug-in(s) HTML 

Alphanumeric n/a n/a General 
Check Box 
Radio Button 

Yes 

MORE: 
HTML InForm Plug-ins > Check Box > Specifying a Selected Submit Value. 

Text 

Determines the text within a button dialog. 

Value Unit Default Group Plug-in(s) HTML 

Alphanumeric n/a n/a Confirmation Button No 

MORE: 
Common InForm Plug-ins > Button > Including a Post-click Dialog > 
Specifying Content. 

Text On Reset 

Determines the text that is displayed within a form element after a form is 
reset. 

Value Unit Default Group Plug-in(s) HTML 
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Alphanumeric n/a n/a On Reset Form 

Combo Box 
Date Box 
Text Box 
Time Box 

No 

MORE: 
Working With Form Elements > Resetting. 

Title 

Determines the title bar text of a button dialog. 

Value Unit Default Group Plug-in(s) HTML 

Alphanumeric n/a  Confirmation Button No 

MORE: 
Common InForm Plug-ins > Button > Including a Post-click Dialog > 
Specifying Content. 

Top (Margins) 

Determines how far from the top edge of a page, the top plane of the 
margin is positioned. 

Value Unit Default Group Plug-in(s) HTML 

Numeric mm 15 Margins Page No 

MORE: 
Working With Pages > Margins. 

Top (Pad) 

Determines how far the content of a form element is positioned from the 
inside top edge of its placeholder. 

Value Unit Default Group Plug-in(s) HTML 

Numeric Pixels 0 Pad 

Button 
Calculation Box 
Check Box 
Combo Box 
Date Box 
Image 
Label 

Yes 
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Radio Button 
Shape 
Text Box 
Time Box 

MORE: 
Working With Form Elements > Adding a Pad. 

Top (Form Element) 

Determines how far a form element is positioned from the top edge of a 
page. 

Value Unit Default Group Plug-in(s) HTML 

Numeric mm 
User 

defined 
Position & Size 

Button 
Calculation Box 
Check Box 
Combo Box 
Date Box 
Image 
Label 
Radio Button 
Shape 
Text Box 
Time Box 

Yes 

MORE: 
Working With Form Elements > Moving > By Changing Properties. 

Transparent 

Determines whether a form element fill is transparent (see-through). 

Value Unit Default Group Plug-in(s) HTML 

No n/a  

Fill 

Button 
Calculation Box 
Check Box 
Combo Box 
Date Box 
Image 
Label 
Radio Button 
Shape 
Text Box 
Time Box 

No 

Yes n/a / 



Appendix A: Properties 

InForm Designer User Guide 279 

MORE: 
Working With Form Elements > Adding a Fill > Changing the 
Transparency. 

Type 

Determines whether a combo box has a useable (editable) text box. 

Value Unit Default Group Plug-in(s) HTML 

Text Box With List n/a / 
List Combo Box No 

List Only n/a  

MORE: 
Common InForm Plug-ins > Combo Box > Preventing User Entry. 

Underlined 

Determines whether form element text is underlined. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 

Style 

Calculation Box 
Check Box 
Combo Box 
Date Box 
Label 
Radio Button 
Text Box 
Time Box 

Yes 

Yes n/a  

MORE: 
Working With Form Elements > Manipulating Text > Changing the Font, 
Size, Style and Color. 

Up & Down Keys 

Determines whether the up and down keys can be used for tabbing from 
one form element to another. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 

Tab On 

Check Box 
Combo Box 
Date Box 
Image 
Radio Button 

No 

Yes n/a  
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Text Box 
Time Box 

MORE: 
Working With Form Elements > Tabbing > Defining Tabbing Keys. 

Upper Case 

Determines whether form element text is upper case. 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 

Style 

Calculation Box 
Check Box 
Combo Box 
Date Box 
Label 
Radio Button 
Text Box 
Time Box 

Yes 

Yes n/a  

MORE: 
Working With Form Elements > Manipulating Text > Changing the Font, 
Size, Style and Color. 

Vertical Gap 

Determines the width of the vertical gap between multi-row fixed pitch 
boxes. 

Value Unit Default Group Plug-in(s) HTML 

Numeric mm 0 Fixed 

Calculation Box 
Combo Box 
Date Box 
Label 
Text Box 
Time Box 

No 

MORE: 
Working With Form Elements > Adding Fixed Pitch Boxes. 

Vertical Alignment 

Determines the horizontal alignment of text in a form element. 

Value Unit Default Group Plug-in(s) HTML 



Appendix A: Properties 

InForm Designer User Guide 281 

Top n/a / 

Paragraph 

Calculation Box 
Combo Box 
Date Box 
Label 
Text Box 
Time Box 

No 
Center n/a  

Bottom n/a  

MORE: 
Working With Form Elements > Manipulating Text > Changing Horizontal 
and Vertical Alignment. 

Web Link  

Determines the URL that is opened in the default Web browser when a 
label or image is clicked. 

Value Unit Default Group Plug-in(s) HTML 

http://www.nameofwebsite.x 
http://www.nameofwebsite.x/nameofpage.x 
nameofpage.x (HTML forms only) 
foldername/nameofpage.x (HTML forms only) 

n/a Blank General 
Image 
Label 

Yes 

MORE: 
Common InForm Plug-ins > Image > Creating a Web Link, and Common 
InForm Plug-ins > Label > Creating a Web Link. 

Web Target  

Determines whether a URL defined by the Web link property is opened in 
a new browser window (_blank), the parent frameset (_parent), the same 
frame as it was clicked (_self) or in the full body of the current browser 
window (_top). 

Value Unit Default Group Plug-in(s) HTML 

_blank n/a / 

General 
HTML Image 
HTML Label 

Yes 
_parent n/a  

_self n/a  

_top n/a  

MORE: 
Common InForm Plug-ins > Image > Creating a Web Link, and Common 
InForm Plug-ins > Label > Creating a Web Link. 
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Width (Border) 

Determines the width (weight) of a form element border. 

Value Unit Default Group Plug-in(s) HTML 

Numeric Pixels 

0 
1 for 
fixed 
pitch 
boxes 

Border 

Button 
Calculation Box 
Check Box 
Combo Box 
Date Box 
Image 
Label 
Radio Button 
Shape 
Text Box 
Time Box 

Yes 

MORE: 
Working With Form Elements > Adding a Border > Changing the Line 
Width. 

Width (Button Image) 

Determines the width of a button image. 

Value Unit Default Group Plug-in(s) HTML 

Numeric Pixels  Image Button No 

MORE: 
Common InForm Plug-ins > Button > Adding an Image > Positioning and 
Resizing. 

Width (Fixed Pitch) 

Determines the width of fixed pitch boxes. 

Value Unit Default Group Plug-in(s) HTML 

Numeric mm 5 Fixed 

Calculation Box 
Combo Box 
Date Box 
Label 
Text Box 
Time Box 

No 
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MORE: 
Working With Form Elements > Adding Fixed Pitch Boxes. 

Width (Paper) 

Determines the width of the paper (page). 

Value Unit Default Group Plug-in(s) HTML 

Numeric mm * Paper Page Yes 

*NOTE: 
The default value is determined by the corresponding printer driver 
properties of the selected printer. 

MORE: 
Working With Pages > Changing the Size and Orientation. 

Width (Form Element) 

Determines the width of a form element. 

Value Unit Default Group Plug-in(s) HTML  

Numeric mm 
User 

defined 
Position & Size 

Button 
Calculation Box 
Check Box 
Combo Box 
Date Box 
Image 
Label 
Radio Button 
Shape 
Text Box 
Time Box 

Yes 

MORE: 
Working With Form Elements > Resizing > By Changing Properties. 

Width (Zero Pad) 

Determines the number of padding zeros (minus existing numbers and a 
decimal place) that are applied to a numeric form element. 

Value Unit Default Group Plug-in(s) HTML 

Numeric n/a 0 Zero Pad 
Calculation Box 
Combo Box 

No 
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Text Box 

MORE: 
Working With Form Elements > Manipulating Numbers > Padding With 
Zeros. 

Word Wrap 

Determines whether a form element has a single line (No) or multiple lines 
(Yes) of text. Also determines whether a text box becomes a single-line 
text box (No) or a multi-line text area (Yes) when a HTML form is created.* 

Value Unit Default Group Plug-in(s) HTML 

No n/a / 
Paragraph 

Label 
Text Box 

Yes 
Yes n/a  

*HTML TIP: 
The HTML Text Area plug-in should be used for creating multi-line text 
areas. 

MORE: 
Common InForm Plug-ins > Text Box > Single or Multiple Lines. 
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Appendix B: Colors 

The color of page backgrounds, and form element fills and borders, is 
applied using InForm Designer’s Color property values or the Windows® 
Color palette. 

Color Property Values 

Color property values are selected using the Color property value list box 
associated with the selected form element. 

Windows® Color Palette 

To open the Windows® Color palette (Fig. 119), double-click any Color 
property value edit/list box.  

 

Fig. 119 Windows® Color palette 

To open the right-hand side of the Windows® Color palette, click the 
Define Custom Colors button. 

MORE: 
For Further details about selecting and defining colors, refer to your 
Windows® documentation or Help. 
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Glossary 

A 

Anchor Point 
The point on a form element that remains stationery when you stretch or 
scale it. Anchor points correspond to the eight handles displayed around 
form elements when selected.  

Application Icon 
The graphical image displayed in Windows® that is used for representing a 
software application. When it is clicked or double-clicked, it normally 
launches (opens) the associated application.  

Application Menu 
A menu, common to most Windows® applications, that is normally 
displayed near the top-left of the application window. In InForm Designer, 
application menus include File, Edit, View, Page, Element and Help.  

MORE: 
Getting Started > Application Menus and Toolbars 

Application Toolbar 
A group of normally related graphical images that can be used for 
performing common actions in an application. The content of a toolbar 
normally reflects an associated application menu. In InForm Designer, 
application toolbars include File, Edit, View, Page, Element and Help. 

MORE: 
Getting Started > Application Menus and Toolbars 

Application Window 
The viewable area of an application. Contains the workspace where 
components such as menus, toolbars and the status bar are displayed.  

Arrow Keys 
Up, down, left and right direction keys found on the keyboard. In InForm 
Designer they can be used for positioning the text cursor when editing 
text, and moving from one form element to another.  
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B 

Base Color 
The color of a form element that appears under another form element 
with a transparency applied. The base color and the transparent color 
combine to produce different color effects.  

Bitmap 
An image such as a BMP or JPEG, composed of rows and columns of pixels, 
each of which can be a different color or shade of grey.  

BMP 
A bitmap file format. Can be imported using InForm Designer and used as 
a page background or a form element. Can also be imported using InForm 
Filler if an image is requested when filling in an InForm document.  

Bleed 
The part of a page that extends beyond the required printed portion of 
the page. It is commonly used when printing documents commercially to 
ensure the page image goes right to the edge of the paper after trimming.  

C 

Character 
Any letter, number, punctuation mark or other symbol. Also an InForm 
Designer property group heading for form elements such as text boxes, 
radio buttons and combo boxes.  

Check Box 
A form element, that when clicked, adds or removes a symbol such as a 
tick or cross. Commonly used on a form for indicating something is 
selected or answered positively. In InForm Designer check boxes are 
added to an InForm document using the Check Box plug-in.  

Click/Clicking 
Press the primary mouse button.  

Clipart 
Common term for graphical images such as a BMP, JPEG or EMF that can 
be imported into forms and used as page backgrounds and form 
elements.  

Clipboard 
A Windows® facility used to temporarily store information cut or copied 
from any application. Information is stored until other information is cut or 
copied to the clipboard.  
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Combo Box 
A form element that combines a list box and a single-line text box; 
allowing the user to either: 1) type a value directly into the control; or 2) 
choose from a list of existing options. In InForm Designer combo boxes 
are added to an InForm document using the Combo Box plug-in.  

MORE: 
Refer to Filling in Forms > Using Form Elements > Selecting Options from 
a Combo Box 

Context Menu 
A menu displayed alongside the mouse cursor when a form element or an 
area of the application is right-clicked.  

MORE: 
Getting Started > Context Menus 

D 

Dithering 
A process used to simulate colors in an on-screen image, icon, or 
document, when only a limited number of colors are available. For 
example, if a true-color image was displayed on a monitor with only 256 
colors, it is likely to become dithered.  

Dock 
A panel, such as InForm Designer’s Property Inspector and Plug-in Palette, 
is referred to as being docked when it is attached to the left or right hand 
side of the application window.  

Double-click/Double-clicking 
Press the primary mouse button twice.  

DPI (Dots Per Inch)  
The resolution in dots per inch of a printer, scanner or bitmap. The higher 
the dpi, the smoother and cleaner a printed or scanned document or 
image is.  

Driver 
Software that allows a computer to communicate with hardware or other 
devices. Without device drivers, the hardware you connect to your 
computer - for example, a printer or fax - will not work properly.  

E 

e-Form 
An electronic form such as an InForm document that can be viewed and 
filled in using a computer application such as InForm Filler. 
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EMF 
A vector file format. Can be imported using InForm Designer and used as a 
page background or a form element. Can also be imported using InForm 
Filler if an image is requested when filling in an InForm document.  

F 

Fill 
The color applied to the internal area of a form element. Also an InForm 
Designer property group heading for form elements such as text boxes, 
shapes and combo boxes.  

Font 
A set of letters, numbers, punctuation marks and symbols.   

Form Element 
An element found in a form that provides a visual reference point, 
instruction or facility for performing a form-based task. Examples include 
text boxes, labels, check boxes, radio buttons, combo boxes, images and 
shapes.  

Form 
An electronic or printed document that requests information from a user. 
Forms that can be used with InForm Filler and InForm Designer are called 
InForm documents and have an ifd file name extension. InForm Designer 
can also be used to create HTML forms which can be viewed and filled in 
using an Internet browser. 

G 

Grab Handle 
The area of a docked panel such as InForm Designer’s Property Inspector 
or Plug-in Palette, that can be clicked, held and dragged, to move the 
panel. Grab handles are normally indicated by two horizontal lines.  

H 

HTML 
HyperText Markup Language (HTML) is a computer "language" used to 
define the appearance and functions of websites and their pages. InForm 
Designer contains a HTML Export facility that creates HTML forms and 
associated files from InForm documents. 

HTML Tag 
A command that tells an Internet browser what to do. Each tag must be 
opened and closed and will contain attributes that determine specific 
functionality. 
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I 

ifd (InForm Document)  
The file name extension used to identify an InForm document that can be 
opened using InForm Filler and InForm Designer.  

InForm Designer 
A Windows® application developed by Fly Software for designing paper 
forms, e-forms and HTML forms. Creates InForm documents (ifds).  

Find out more from the following Fly Software web page: 

http://www.flysoftware.com/products/inform_designer/overview.asp 

InForm Filler 
A Windows® application developed by Fly Software for viewing, filling in, 
printing and exporting InForm documents (ifds).  

Find out more from the following Fly Software web page: 

http://www.flysoftware.com/products/inform_filler/overview.asp 

InForm Plug-in 
Form design tools found within InForm Designer that can be optionally 
licensed. A comprehensive range of InForm Plug-ins is available to satisfy 
many common form design requirements such as creating text boxes, 
labels and check boxes. 

Find out more from the following Fly Software web page: 

http://www.flysoftware.com/products/inform_plug-ins.asp 

Import 
To insert data, an image, PDF or other document within an InForm 
document.  

Installation Wizard 
A software mechanism for installing applications on a computer.  The 
process guides the user through procedures such as selecting the 
installation path, accepting terms and conditions, and creating Windows® 
Start menu and desktop icons.  

MORE: 
Getting Started > Installing 

http://www.flysoftware.com/products/iform_designer/overview.asp
http://www.flysoftware.com/products/iform_filler/overview.asp
http://www.flysoftware.com/products/iform_plug-ins.asp
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J 

JPEG (JPG) (Joint Photographic Experts Group)  
A common image format that uses compression to keep the size of the file 
to a minimum. Can be imported using InForm Designer and used as a 
page background or a form element. Can also be imported using InForm 
Filler if an image is requested when filling in an InForm document.  

L 

Label 
A text-based form element used to provide instruction and identify other 
form elements. In InForm Designer labels are added to forms using the 
Label plug-in.  

Left Click/Left Clicking 
Press the primary mouse button.  

List Box 
Refer to Combo Box.  

M 

Menu 
An element found within most applications that is used to display related 
and selectable options. Application menus and context menus are both 
found in InForm Designer.  

Mouse Pointer 
Indicates the position of the mouse on screen and used to select 
application components and form elements. Represented in InForm 
Designer by an arrow.  

Multiple Select 
To select multiple form elements.  

N 

Nudge 
To move a form element in one pixel increments. See also Super Nudge. 

P 

Pad 
An indent that can be applied in InForm Designer to the inside left, right, 
top and bottom sides of many types of form element.  
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Page 
The bordered area of an InForm document where form elements are 
displayed.  

MORE: 
Getting Started > Workspace Overview 

Page Menu 
An application menu that contains options for performing actions within 
InForm Designer such as displaying the page properties and inserting and 
deleting a page. 

MORE: 
Refer to Application Menus and Toolbars > Page.  

Page Bar 
Displays the page buttons used to change the page being viewed within 
an open InForm document.  

MORE: 
Getting Started > Workspace Overview, and Viewing Forms > Changing 
Pages 

Pica 
Printer’s unit of measurement commonly used in typesetting and graphic 
design. One pica equals approximately 1/6 of an inch.  

Pixel 
A colored dot that makes up the smallest part of a bitmap. Also one of 
several units of measurement used in InForm Designer.  

Placeholder 
The area indicated by a dotted line where a form element is displayed. A 
selected placeholder contains resize handles used for resizing form 
elements. 

Placeholders are normally green, but when locked they are red. 

NOTE: 
Placeholders are not displayed in Filler mode or InForm Filler. 

Point 
A unit of measurement normally used to define type sizes. There are 
approximately 72 points in an inch and 12 points to a pica.  

Publish 
The inclusion of form elements when performing an action such as 
printing or exporting to HTML. 
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R 

Radio Button 
A form element that, when clicked, adds a symbol such as a dot while 
simultaneously removing the symbol of another radio button in the same 
group. Commonly used on a form to indicate an exclusive yes or no 
choice. In InForm Designer radio buttons are added to an InForm 
document using the Radio Box plug-in.  

Resize Handle 
A set of eight black dots that surround all selected form elements. They 
appear in each corner, and middle horizontal and vertical plane of a form 
element’s placeholder. Each is used to resize the associated form element.  

Resolution 
Refers to the number of pixels per inch (ppi) or dots per inch (dpi), 
contained in a bitmap or the viewable area of a monitor. Low resolutions 
can result in a grainy or jagged image and larger screen objects; high 
resolutions can produce smoother and clearer images and smaller screen 
objects.  

Right-click/Right-clicking 
Press the secondary mouse button.  

S 

Scroll Bar 
An application component used to move the viewable area of a page, or 
to scroll vertically through a list of options in a combo box. 

MORE: 
Getting Started > Workspace Overview, and Viewing Forms > Moving 
About a Page > Using Scroll Bars.  

Selection Box 
A rectangular object with a black dotted border that appears when the 
mouse button is clicked, held and the mouse pointer moved across a 
page. Any form elements that encompass a selection box are selected 
when the mouse button is released.  

Shape 
A vector image such as a rectangle, ellipse or line. In InForm Designer 
shapes are added to an InForm document using the Shape plug-in. 

Shortcut Key 
Key or key combination used to perform an action or a command found 
on a menu. For example: Ctrl+A = press the Ctrl and A keys together.  
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Status Bar 
The horizontal bar found at the bottom of most applications. In InForm 
Designer it is used for displaying information about the selected form 
element.  

MORE: 
Getting Started > Workspace Overview 

Super Nudge 
To move a form element in eight pixel increments. See also Nudge.  

Support Ticket 
The online mechanism for reporting any problem encountered when 
using InForm Filler or InForm Designer. Requires a Fly Software User 
Account.  

T 

Text Box 
Normally a rectangular form element that can be used for typing or 
writing text-based information. In InForm Designer text boxes are added 
to an InForm document using the Text Box plug-in.  

Title Bar 
The horizontal bar found at the top of most applications. Used for 
displaying the application icon, application name, filename of the open 
document, and minimize, maximize/restore down and close (exit) buttons.  

MORE: 
Getting Started > Workspace Overview 

Toolbar 
Refer to Application Toolbar.  

U 

URL (Uniform Resource Locator)  
A unique address to indicate where a Web page is found on the Internet. 

EXAMPLE:  
The URL of the site map page on the Fly Software website is: 

http://www.flysoftware.com/site_map.asp 

http://www.flysoftware.com/site_map.asp
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W 

Watermark 
The flysoftware.com image displayed at 45° across all pages of forms that 
contain form elements created using one or more unlicensed InForm 
Plug-ins. When all used InForm plug-ins are licensed, the watermark is 
removed from all pages.  

MORE: 
Getting Started > The Fly Software Watermark. 

Workspace 
The area within an application window where application components, 
are contained.  

MORE: 
Getting Started > Workspace Overview 

Z 

Zoom 
To reduce or magnify the view of a page. Zoom in to see the page detail 
more closely; zoom out to take a broader view. 

MORE: 
Working With Pages > Magnifying or Reducing the View.  
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